
9.x User Guide
Using Jive Community



Notices
For details, see the following topics:

• Notices

• Third-party acknowledgments

Notices
Copyright © 2000–2021. Aurea Software, Inc. (“Aurea”). All Rights Reserved. These
materials and all Aurea products are copyrighted and all r ights are reserved by Aurea.

This document is proprietary and confidential to Aurea and is available only under
a valid non-disclosure agreement. No part of this document may be disclosed in
any manner to a third par ty without the prior written consent of Aurea. The information
in these materials is for informational purposes only and Aurea assumes no respon-
sibility for any errors that may appear therein. Aurea reserves the right to revise
this information and to make changes from time to time to the content hereof without
obligation of Aurea to notify any person of such revisions or changes.

You are hereby placed on notice that the software, its related technology and services
may be covered by one or more United States (“US”) and non-US patents. A listing
that associates patented and patent-pending products included in the software,
software updates, their related technology and services with one or more patent
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the products. Likewise, the patents or pending patents may also be associated with
unlisted products. You agree to regularly review the products-to-patent number(s)
association at the Patent Notice to check for updates.

Aurea and Aurea Software are registered trademarks of Aurea Software, Inc. in the
United States and/or other countries. Additional Aurea trademarks, including regis-
tered trademarks, are available at: https://www.aurea.com/legal/trademarks/. Jive
is a registered trademark of Jive Software, Inc. in the United States and/or other
countries. Additional Jive trademarks, including registered trademarks, are available
at: https://www.jivesoftware.com/legal/.
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Third-party acknowledgments
The following third-party trademarks may appear in one or more Jive guides:

• Amazon is a registered trademark of Amazon Technologies, Inc.

• Apache and Derby is a trademark of Apache Software Foundation.

• Chrome is a trademark of Google Inc.

• Eclipse is a registered trademark of the Eclipse Foundation, Inc.

• HP-UX is a registered trademark of Hewlett-Packard Development Company, L.P.

• IBM, AIX, DB2, and WebSphere are registered trademarks of International Business
Machines Corporation.

• Intel and Pentium are registered trademarks of Intel Corporation in the U.S. and/or
other countries.

• JBoss is a registered trademark, and CentOS is a trademark, of Red Hat, Inc. in
the U.S. and other countries.

• Linux is a registered trademark of Linus Torvalds.

• Microsoft, Active Directory, Internet Explorer, SharePoint, SQL Server, Visual
Studio, and Windows are registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

• Mozilla and Firefox are registered trademarks of the Mozilla Foundation.

• Oracle and Java are registered trademarks of Oracle and/or its affiliates.

• Progress and OpenEdge are registered trademarks of Progress Software
Corporation or one of its subsidiaries or affiliates in the U.S. and other countries.

• Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat, Inc.
in the U.S. and other countries.

• SAP and SAP NetWeaver are registered trademarks of SAP SE in Germany and
in several other countries.

• SUSE is a registered trademark of SUSE, LLC.

• Ubuntu is a registered trademark of Canonical Limited in the United States and/or
other countries.

• UNIX is a registered trademark of The Open Group in the United States and other
countries.

All other marks contained herein are for informational purposes only and may be
trademarks of their respective owners.
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Aurea global support
If you encounter a problem while using an Aurea product or require assistance with downloading
the software or upgrading a product release, please, try to:

• Search the articles on the Aurea Knowledge Base for solutions to your issues.

• Search the product documentation and other product-related information that are also available
on Support Central.

If you still cannot find a solution, open a ticket on Aurea Support Central. Information about the
support organization is available on Support Portal as well.

You can also find the setup files on Support Portal.

For information about purchasing an upgrade or professional services, contact your account
executive. If you do not know who your account executive is, or for other queries, contact us
through our website.
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1
Overview

Supported languages

For a list of languages supported in the Jive user interface, see Supported languages
on page 11.

Release notes

To learn more about changes in Jive with each release, including the release notes,
see the Jive Hosted and On-Prem space  on Worx.

Previous help versions

If you want to see previous versions of the documentation, take a look at the following
help from previous cloud releases:

• Jive 8.0 User Help

• Archived Documentation

Beta features

Any feature labeled in this Jive Cloud Documentation as a "Beta Feature" is provided
to you for non-production, evaluation, and testing purposes only. Beta features are
provided "AS-IS," "AS AVAILABLE," AND WITHOUT WARRANTY OF ANY KIND,
AND ARE EXCLUDED FROM ANY APPLICABLE SLAS AND SUPPORT SERVICES.
Beta features may be subject to different security and privacy commitments. Beta
features may or may not become GA features, and their implementation may change
in backward-incompatible ways. We may change or discontinue beta features at any
time and without notice. If you do not agree to these terms, do not enable any beta
features.

Jive is a social business software that integrates the most powerful
capabilities of collaboration, community, and social networking software.

We hope you find this documentation useful as you set up, configure, and use your
new Jive community. Thank you for choosing Jive!
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For details, see the following topics:

• Supported languages

• What's New in Jive 9?

• System requirements

Supported languages
The main application has been translated into a number of languages.
Users with one of these languages set as their browser version
automatically see the translated application. Users can also override

their browser setting in their user preferences.

Supported languages

The main application supports the following languages:

• Chinese—Simplified

• Chinese—Traditional

• Czech

• Danish

• Dutch

• English

• Finnish

• French

• German

• Greek

• Hungarian

• Italian

• Japanese

• Korean

• Norwegian

• Polish

• Portuguese—Brazilian

• Russian

• Spanish (Latin American, Neutral, International, Castilian)

• Swedish

• Thai

11AUREA CONFIDENTIAL
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What's New in Jive 9?
The latest Jive 9 release includes significant new fixes and enhancements.

Release Notes – Jive Hosted on Premise

You can check the Jive Hosted and On-Prem space on Worx for details.

Upgrading to Jive 9

If you're upgrading, see Step 2: Learn What's Changed from Jive 7 & 8 to Jive 9 on
Worx for a more detailed look at what's changed between Jive 7 & 8 to 9. You need
to join the Jive 9 Upgrade Planning group to use this resource.

Changes in Jive 9

You can now make bulk changes to content items with the Bulk
Manage Content feature. For more information on how to use this

Bulk content
management

feature and what it offers, see Making bulk changes to content
in places on page 63.

Jive Daily Hosted is now available for hosted and on-premise
communities and compatible with Jive 9. For more information

Jive Daily
Hosted
improvements about changes to the app, see Release Notes – Jive Daily Hosted

on Worx. For more information on how to use Jive Daily Hosted,
see the Jive Daily Help.

Documents now have a Copy Document action that creates a new
piece of content from an existing document. It copies the title,

Copy document

body, and publishing information (place, category, tags) from the
original document. Documents can be copied as a new document,
discussion, or blog post. This is a great way to make templates
for others to use.

For more on this feature, see Copying content on page 104.

New tiles are introduced in your community. Some are only
available in narrow tiles and some are only in custom pages.

New tiles

• Hero

• Banner

• Super List

• Latest blog post

• HTML

• Category

• Tagged Content

For more information, see Tile reference on page 201.

News is the central place for you to see what's happening in the
community. For more information about News, see Using News

News
enhancements

on page 17. For more information about creating News streams,
see Customizing News page on page 161.
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Browser support:System
requirements

• We now support Mobile Safari on iPhone and iPad for iOS 8
and 9, and no longer support 7

• We now support Apple Safari 8 and 9 (on Macs only), and no
longer support 7

• We no longer support Internet Explorer 8 and Internet Explorer
in Compatibility mode

For a list of the browsers we support, see #unique_15.

Jive Daily Hosted:

• We now support a minimum of iOS 8.x and higher

• We now support a minimum of Android 4.4 (KitKat) and higher

End of Life and deprecation

We no longer support Internet Explorer 8 and Safari 7. For the list
of the browsers we support, see #unique_15.

Browsers

We are removing the ability for customers to download Apps via
the Apps Market in Jive 9.0.0. Apps will continue to function and

Apps Market
EOL

be available for download via the Add-ons page. No functionality
will be lost. During the upgrade process all downloaded apps will
be converted to Add-ons. The Apps menu item will still be
displayed and Apps will continue to function should customers
have dependencies on those Apps. For more information, see
Apps market EOL in Jive 9 on Worx.

We are deprecating the Deal Room add-on as of July 2017. Please
use the Salesforce Chatter add-on to enrich your Jive Activity
stream with content from Salesforce.

Deal Room
add-on

System requirements
Learn about the required and supported system elements for the application. The
system requirements listed here should be met before using the application.

This section describes what you need to run Jive.

Supported browsers
Jive works with most current web browsers. Note that if you need to use Content
Editor features, such as cut and paste, script access to the clipboard must be
enabled.

• Microsoft Edge* (Chromium-based).

• Apple Safari 8 and 9 (on Macs only).

• Mobile Safari on iPhone and iPad for iOS 8 and 9 and later. (For a
browser-independent native iOS phone app, be sure to look for the Jive Daily
Hosted app, if your community uses it, in the App Store.)

13AUREA CONFIDENTIAL
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• Mobile Chrome on Android devices for Android 4.4 and later. (For a
browser-independent native Android phone app, be sure to look for the Jive Daily
Hosted app, if your community uses it, in Google Play.)

• Mozilla Firefox*.

• Google Chrome*.

* Google Chrome, Mozilla Firefox, and Microsoft Edge browsers are released fre-
quently. Jive Software makes every effor t to test and support the latest version.

Note: The recommended minimum screen resolution for desktop devices is 1024
x 768. Results may vary if you use zoom to adjust your view to levels other than
100%.

Important notes and restrictions

• Beta versions of web browsers are not supported, but they are quickly added to
the supported list after they're formally released.

• Apps are not supported on mobile devices. These features may not work correctly
on mobile devices.

14AUREA CONFIDENTIAL
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2
Using a Jive community
Here you can find information about navigating and using your community.

For details, see the following topics:

• Using community from mobile browsers

• Using News

• Creating custom streams

• Using Your View

• Finding people, places, and content

• Using social groups

• Using content

• Using projects and tasks

• Public and private communications

• Using Jive Apps

• Using external groups

Using community from mobile browsers
When accessing a Jive community from a mobile device, the mobile browser features
simple navigation with large buttons that are better suited for touch screens. Note
that options that are too complex or too large for narrow screens are not displayed.

To visit your community from a mobile browser, enter your community's URL into
the browser of your mobile device and log in. Likewise, you can see the same narrow
interface on the desktop version by making your desktop browser smaller.

The following options are available from a mobile browser:

Note:  Some content and functionality only make sense in the wider desktop view,
so you won't see some things cluttering up the smaller space. However, iPads always
benefit from the full functionality of a wide-screen view.

You can browse through and interact with your streams,
and read and respond to your Inbox items.

Read and interact
with your streams and
Inbox
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Create different content from your mobile device, for
example, ideas, blog posts, and documents.

Create most content
types

Tap the magnifying glass, enter your search term, and then
click the down-arrow to filter by content, people, or places,
and the time period of the last modification.

Search and filter

Follow, join, or leave places from the mobile browser. You
can also see a place activity, content, people, and any

Access and use
places

subspaces, projects, and custom pages the place may
have. To sor t the content in a place, click Content and
then an icon: documents, discussions, blogs, or polls. If
you're looking for the tiles on a group's activity page, be
sure to scroll down to see them.

Known issues

• The mobile browser does not work on Blackberry devices.

• Older Android browsers struggle with content creation. You can resolve this by
upgrading your Android operating system and using Chrome to browse your
community.

Quick tour from a mobile browser
Here's a quick visual tour of navigating your community from the built-in browser
on your mobile device (or a narrow desktop screen).

If you're totally new to Jive, refer to Getting star ted for a walk through the key tasks,
such as posting a status update, connecting with colleagues, and joining a group.
Otherwise, from your mobile device, enter the URL of your community into the built-
in browser.

See what's new

When you first log in using a mobile browser, you see the latest posting from News,
as you see to the right. To see your streams, tap the down-arrow. You can go to
any of them by tapping one.

Check out your Inbox

If you see a blue aler t next to the person icon, you have something unread in your
Inbox. You could also go to Your Content and Your Places from here. You could
also log out from the community if required.

Create content
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You can create all kinds of content right from the mobile browser. You can publish
it for specific people, in a place, or the entire community.

Find what you're looking for

You can search from your mobile browser by tapping the magnifying glass in the
upper right corner. After you enter your search terms, click the down-arrow to filter
by Content, People, or Places, and the time period of the last modification. Note
that we decided that a narrow-screen search should be just about search, so you
won't see Bookmarks or Recently Viewed Content taking up precious real estate
here.

Using News
The News page gives you an account of what is going on in your community. It
features a variety of streams and tiles designed to bring you the latest news and
information.

Overview of News
The News page is the central place for you to see what's happening in
the community. The News page features a variety of streams designed

to direct you to content, people, and places that per tain directly to you. You can
also see your Following stream, any custom streams you have created, and the All
Activity streams, which show recent activity from all over the community that you
have permission to see.

You can see these streams individually by clicking the link to a stream in the stream
menu at the top of the page and scrolling down the page, or you can use the main
News page to overview the latest items in each stream in a combined block view.
Each block has a header that shows what stream the item came from.

Note: The News page responds to browser width by adjusting to fit all your streams
so your main navigation menu may differ slightly from browser to browser or from
screenshots in this Help. For example, you may see your News subscription streams
listed individually or collapsed into a drop-down menu.

You can pin any of the streams listed on your News page to either the News or
Home button in the main menu, depending on how your community manager has
set up the main navigation menu in your community. Just click the pin icon from the
desired stream's page, and when you click Home or News from anywhere in the
application, you are taken to the page you pinned. For more information, see Pinning
pages for quick access.

The News page also features a variety of tiles to help you find important people,
places, and content quickly. The Trending Content and Trending People tiles are
included by default but may be removed by your community manager.

Here's an overview of what you can see on the News page. For a quick visual tour
of the News interface, see News page interface on page 18.
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The News view aggregates and displays content posted in your
News and Following streams. However, unlike your streams, the

News
(top-level
view) News page does not show content updates and comments in a

stream view. Content that gets updated or interacted with is not
moved to the top of the News view: this view shows only new
things.

Content is pulled in and displayed in the News view in the order
in which your streams are displayed to the right of News in the
stream menu. Duplicated content is removed if it's already being
pulled in from a higher-order stream. The content you've read (by
clicking through to it either from your desktop or a mobile version
of Jive) stays in News for two days before going away. The content
you haven't yet read stays for ten days. Because the News streams
are designed just for you, you won't see the same content pulled
into the News view that other users see.

These are the streams you see listed when you expand the menu
under News. These streams are created and managed by your

News streams

community manager or people with Manage News Streams
permissions. Because these streams are designed just for you,
you may not see the same News streams or the same content in
them that others see. For more information, see Overview of News
streams on page 19

This stream shows you the trending content in your community to
get you a feel for what's happening right now.

All Activity:
Top &
Trending
stream

This stream shows you all community updates that you have
permission to see as they are posted in real time. Scrolling through

All Activity:
Most Recent
stream this stream can be useful for adding new people and content to

your Following or custom streams.

When you star t following people, places, and content items, they
are automatically added to this stream. Use this stream if you want

Following

to check in throughout the day but not create a lot of custom
streams. This stream is included for you by default, and you can
add to or delete content, people, and places from it.

If you've created any custom streams, you can see those listed to
the right of Following. Custom streams can be a great way to keep

Your custom
streams

up with the content, people, and places that matter most to you in
your community. For some examples of custom streams which you
might want to create for yourself, see Examples of custom streams
on page 22.

News page interface
Here you can find the visual overview of a News page.
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1. Listed first are any streams your community manager has curated for you.

2. The All Activity stream is a great way to see what's happening right now.

3. Activity indicator dots appear next to streams that have a new activity in them
since you last checked.

4. Also listed here are streams that you create yourself to focus on the things you
want to see.

5. Banner images might be pictures, or they might link to helpful places.

6. Top & Trending shows you the activity getting a lot of attention right now.

7. See how many likes and comments have been given to something right from the
card view.

8. Following shows you the content generated by people, places, and content you
are following. You can add to or remove items from this stream.

Overview of News streams
News streams that are displayed on the News page are configured for you by your
community manager and are designed to bring you the latest news from your
organization, department, team, or product. Additionally, you can create your own
custom streams to tailor the news.

Click News to find your News streams if they've been set up.

Because they are designed just for you, you may not see the same News streams
or the same content in them that others see. For example, everyone in your commu-
nity may see the CEO's Blog stream that shows the latest blog posts from your or-
ganization's CEO. However, only people in the Marketing department may have a
stream called Marketing News that shows activity from the Marketing space.

Also, you might have a News stream based on your role in the community. For ex-
ample, let's say everyone has a stream called What’s New, but what is displayed
there differs depending on the user's role. Or customers might see content pulled
from the Special Promotions blog in their What's New stream, but vendors might
see content pulled from the New Solutions group.

For more information about streams and how they work, see Overview of streams
on page 20.
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Creating custom streams
You can create your own custom streams to help you keep up with the content,
people, and places that matter most to you in your community.

Overview of streams
A stream shows you real-time updates of activity as people interact with content,
people, and places in the community.

You can see streams on the News page and the Activity page of any place. Streams
are updated when someone creates a document, replies to a blog post, posts a
status update, and so on.

Examples of activities which update streams

Here are some examples of activities that trigger new stream items for people,
places, and content that you're following in a stream:

• Content: Someone modifies the content item, for example, edits, comments on,
or replies to it.

• People: Someone posts a status update, creates a content item, or comments on
a content item.

• Places: Someone updates content in the place, for example, publishes a new
document, edits a blog post, shares content with a place, or comments on a
document that lives in the place.

• Tags: Someone creates or modifies an item with a tag you're following in the
stream, or adds the tag to a content item.

Tracking new activity in streams

Here are some ways you can track new activity in your streams:

When there is new activity in your streams, such as likes, comments,
edits, or new content, you can see an indicator dot next to the stream

Activity
indicators

name on your News page. If you hover over the indicator, you can
see the count of new activity for that stream since you last viewed
it.

When you select a stream, you are viewing all activity, with the Most
Recent content listed first. If you want to view only the content you

Stream
views

are following in that stream, you should select Top & Trending to
sor t activity by the most active content since you last viewed the
stream.
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As you are scrolling through your stream, you can see the End of
New Updates line, so you know when you've seen all the new activity

Update lines

for that stream. If you continue scrolling, you can see the End of
Previous Updates line that shows you the updates from last time
you checked.

Streams to follow

Here are some streams you can view to follow activity in your community:

You can see all public activity that you have permission to
see in this stream.

All Activity: Most
Recent stream

You can create your own custom streams that show only
the people, places, and content items you select.

For more information, see Creating custom streams on page
22.

Custom streams

Each person and place in the community has an activity
stream. You can see yours under your profile, and places
have a place-specific stream that shows up on place pages.

People and Place
activity streams

News streams are those listed to the left of your custom
streams. They were created by your community manager to

News streams

help you see important content. For more information about
how these streams work, see Overview of News on page 17
and Overview of News streams on page 19.

Notifications about streams

You can also select your notification preferences by clicking Your avatar > Prefer-
ences .

Custom streams interface
Here you can find the News page details.
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Creating custom streams
You can create your own customized streams if available in your community.

To create a custom stream:

1. On the News or Home page, click  to the right of the streams.

You can see a two-column layout with suggested stream content on the right.

2. In Stream name, enter a name for this stream, for example, Water Cooler, New
Products, or Team Activity.

3. Drag and drop items from the Suggested People, Places, and Tags in the right
column to the left column, or use the Search box to find specific items you want
to follow in this stream. For more information about how to find and follow useful
things, see Tips for finding things to follow on page 25 or Following tags on page
48.

4. If you want to receive a notification every time there is a new item in this stream,
select Mobile or Email (or both) under Updates at the top of the page.

• The option to change your email notifications preferences may be unavailable
in your community. For more information, see Choosing between email and
stream notifications on page 29.

• We strongly recommend leaving Email cleared, which is the default; otherwise,
your email notifications could get overwhelming pretty quickly.

• Mobile notifications go to the Jive Daily Hosted app if you have it installed on
your Android or iOS device. If you don't have one of these apps, mobile
notifications don't have any effect.

5. To save this new stream, click Done.

You can add to, edit, or delete this stream any time you want. For more information,
see Updating custom streams on page 26 and Editing custom streams on page 27.

Examples of custom streams
Here are some examples of custom streams you might create, depending on your
role in the organization or how you want to check in on community activity throughout
the day.

Strategies for creating streams

You should consider creating and organizing your custom streams based on the
following strategies. You can try using a combination of these to develop the best
approach for your unique needs.

Create a stream where you follow yourself. This can help you get
to your most-used items quickly.

My stream
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You can create streams for immediate, soon, and later items. You
could check Immediate often and Soon occasionally. In Immediate,

Priority
streams

follow your high-priority people, places, and content items. In Soon,
follow your less urgent people, places, and content items. This
kind of organization can be good if you like to read some things
later, but don't want to miss your high-priority things as they are
posted.

You can create an Blog stream where you follow the blogs of the
CEO, CTO, and VP of your department. For more information, see
Creating custom blog stream on page 99.

Content
streams

This stream can be convenient if you're in and out of the community
a lot, and especially if you're out of the office for a few days. Add

Can't miss

to this stream only critical items that you can't miss. Then, make
sure to select Email or Mobile from Updates so that you receive
notifications when activity happens in this stream.

Note: The option to change your email notifications preferences
may be unavailable in your community.

To these streams you can add the people you work with, the content
you all are working on, and the places where your team most

Team and
Product
streams frequently posts. Or, create one good Team and Product stream

to check throughout the day for updates from your team and the
product you're working on.

When you star t following people, places, and content items, they
are automatically added to this stream. You can use this stream

Following
stream

if you want to check in throughout the day but not create a lot of
custom streams. This stream is included for you by default, and
you can add to or delete content, people, and places from it.

When you follow tags, you follow updates of the content which is
marked with this tag. You can create an entire stream for one tag,

Tag streams

or add tags to optimize your existing streams. If you're a QA
Engineer, you might add the #test tag to your stream that already
follows the QA Group.

Examples for creating custom streams

Here are more specific streams that you might create, depending on your role in
the organization.
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If you work in the Engineering department, you can create the following new streams:

• Email Watches: Follow critical items here and select Email or Mobile from Updates
so that you receive notifications when activity happens in this stream. Use this
stream wisely so that you don't create an email nightmare for yourself.

Note: The option to change your email notifications preferences may be greyed-
out and unavailable in your community.

Note: You can also select your notification preferences by clicking your avatar
> Preferences .

• Product A: Follow everything related to one of the products you're working on.

• Product B: Follow everything related to another product you're working on.

• Team: Follow everyone on your team so that you stay current with their activities.

• Research: Follow things related to your next big product idea.

• Awesome Blogs: Follow blogs that you like.

• Water Cooler: Follow fun people, content items that are amusing, and community
places where people organize social events.

If you work in the Accounting department, you can create these streams:

• Customer Account A: Follow everything related to one of the customer accounts
you're working on.

• Customer Account B: Follow everything related to another customer account
you're working on.

• Team: Follow everyone on your team so that you stay current with their activities.

• Sarbanes-Oxley: Follow people, places, and content items in your community re-
lated to Sarbanes-Oxley, so that you don't miss important new regulations or
processes.

• Latest Wins: Follow the place where your latest wins are reported. You might also
follow the VP of Sales and the blogs of Sales team members here.

• Email Watches: Follow critical items here and select Email or Mobile from Updates
so that you receive notifications when activity happens in this stream. Use this
stream wisely so that you don't create an email nightmare for yourself.

Note: The option to change your email notifications preferences may be greyed-
out and unavailable in your community.

Note: You can also select your notification preferences by clicking your avatar
> Preferences .
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If you work in the Sales department, you can create these streams:

• My Region: Follow everyone working in your region, plus all of the places you
and they post most often.

• Marketing for Product A: Follow the people, places, and content related to the
marketing of Product A.

• Customer Account B: Follow the people, places, and content related to the mar-
keting of Product B.

• Exec Blogs: Follow the blogs of the CEO, CMO, SVP of Sales, and other leaders
who matter most to you.

• Can't Miss: Follow critical items here and then make sure to select Email or Mobile
from Updates so that you receive notifications when activity happens in this
stream.

Note: The option to change your email notifications preferences may be greyed-
out and unavailable in your community.

Note: You can also select your notification preferences by clicking your avatar
> Preferences .

• Comic Relief: Follow enter taining people and places where people post funny
stories and videos.

Tips for finding things to follow
Here are some tips for finding useful activity to follow in your community.

• Browse the content, people, or places that your co-worker or someone with similar
interests follows by clicking Places or People on their profile page. This way you
can quickly find things and people you should also follow.

It can also be helpful to look at their bookmarks. For more information about
bookmarks, see Using bookmarks on page 49.

• Read the All Activity: Top & Trending stream on the News page to see what other
people are excited about.

• Browse for items using the People browse in the main navigation menu or Your
Content or Your Places in your user profile menu in the upper right.

Once you're browsing, type keywords into the filter box to narrow your results.
For more information about filtering, see Browse and filter content, people, and
places on page 44.

• Use Search to find things that interest you. To learn how search works, see Using
Spotlight search on page 40.

• Try following a tag. Note that this can be tricky because people from all over the
community assign tags, so you may not know how other people are tagging content,
places, and people. For more information, see Following tags on page 48.

25AUREA CONFIDENTIAL

Creating custom streams



Following people, places, and content
There are several ways to star t following a piece of content, a person, or a place
in the community. Here you can find how to star t and stop following items.

Starting following people, places, or pieces of content

To star t following people, places, or pieces of content:

• Use people hover cards. From any stream you're reading, hover your mouse over
a person's name or avatar, or the name of a place, and click Follow. You can
then select the stream in which you want to follow the person or place.

• Use the Browse menus. Click People from the main navigation menu (may also
be nested under the Browse button), or click Your Content or Your Places from
the menu under your avatar, then browse for things to follow. You can also check
the Recommended tab to see recommendations based on your individual activity
and connections in the community. When you see an item you want to follow,
click on its gear icon, and then Follow. Then select the stream in which you want
to follow the content item, person, or place.

• Use the Search feature. Search for keywords of things that might interest you.
When you find something you want to follow, click on the item. From there, click
Actions > Follow . Then select the stream in which you want to follow the content
item, person, or place.

Stopping following people, places, or pieces of content

To stop following something, do one of the following:

• Go to the item, then click Actions and clear the Following check box. You can
also clear check boxes for the streams from which you want to stop following the
person, place, or content item. You will no longer see updates for that person,
place, or content item in those streams. Those updates can still appear in the
Most Recent stream, however, because that stream shows all public activity in
the community.

• Go to the stream and click the edit icon above the stream. From here, click 
next to the items in the left column that you want to remove from your stream.

Updating custom streams
Quickly add content, people, and places to any of your custom streams and your
Following stream using any of these methods.

Tip:  If you are already following something in a stream, you can see the notation
Following in. If you're not following it, it shows Follow.
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Starting following people, places, or pieces of content

To star t following people, places, or pieces of content:

• Use people hover cards. From any stream you're reading, hover your mouse over
a person's name or avatar, or the name of a place, and click Follow. You can
then select the stream in which you want to follow the person or place.

• Use the Browse menus. Click People from the main navigation menu (may also
be nested under the Browse button), or click Your Content or Your Places from
the menu under your avatar, then browse for things to follow. You can also check
the Recommended tab to see recommendations based on your individual activity
and connections in the community. When you see an item you want to follow,
click on its gear icon, and then Follow. Then select the stream in which you want
to follow the content item, person, or place.

• Use the Search feature. Search for keywords of things that might interest you.
When you find something you want to follow, click on the item. From there, click
Actions > Follow . Then select the stream in which you want to follow the content
item, person, or place.

Editing custom streams
As your projects and interests change over time, so should your custom streams.
Edit them to match what you need from the community at any given time. You can
also delete a custom stream.

Your streams should change over time as you add and remove people, places, and
content from them, depending on what you're working on and how your team,
products, and tasks change over time. From any of your streams, you can hover
over a place name or person's name and select Following > Stop Following  or
select the streams you want to follow it in. For content items, click the name of the
item, and then select Actions > Follow  and select or unselect the streams you'll
see it in.

To edit a stream:

1. Select the stream and click .

2. Drag and drop items into the stream to follow them.

3. Click  to remove items from the stream.

4. When you're finished, click Done.
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To delete a stream:

• Select the stream, then click  and confirm deletion.

Items that appear in streams
You can review your stream content and understand why you are seeing something
in a stream with these checks.

Here are some examples of activities that trigger new stream items for people,
places, and content that you're following in a stream:

• Content: Someone modifies the content item, for example, edits, comments on,
or replies to it.

• People: Someone posts a status update, creates a content item, or comments on
a content item.

• Places: Someone updates content in the place, for example, publishes a new
document, edits a blog post, shares content with a place, or comments on a
document that lives in the place.

• Tags: Someone creates or modifies an item with a tag you're following in the
stream, or adds the tag to a content item.

If you are seeing something in your stream that you don't think you are following,
you should check if you follow:

• The person who posted the item?

• The place where the item was posted?

• This content item?

If you discover that you are following the person, place, or content item in your
Following stream or any of your custom streams, but you don't want to, go to or
hover over the person, place, or content and click Stop Following.

Your News streams (those listed when you click News) were created by other people,
so you have to ask them about any unexpected content you see in your News
streams.

A common question is why you're getting email notifications on activity you're not
interested in. Note that each of your custom streams (those listed to the right of
Following) has a configuration setting to enable or disable email notifications. For
more information, see Choosing between email and stream notifications on page
29.
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Choosing between email and stream notifications
You can receive notifications in Inbox and on email. Here you can find details about
choosing when and how you want to be notified about new activity in your streams
and when you don't.

Stream and Inbox notifications

You can keep track of activity in your community without ever leaving the community
page through notifications in your Inbox and through streams.

When you collaborate on content in your community, you're
automatically notified in your Inbox when updates are made to
that content.

Inbox
notifications

If there is content that you want to watch but have not directly
collaborated on, you can follow it in a stream. When there is new

Stream
notifications

activity in your streams, such as likes, comments, edits or new
content, you can see an indicator dot next to the stream name on
your News or Home page. If you hover over the indicator, you can
see a count of new activity for that stream since you last viewed
it.

Tip:  Relying on these notifications can save you time and cut down on your emails.

Email notifications

If you want to receive email notifications, do so prudently. You may find that you
rapidly accumulate hundreds of email messages in a busy community, since you
may get an email every time that stream is updated.

To receive emails in addition to Inbox and stream notifications,

1. Go to your avatar > Preferences .

2. Select Yes for Receive email or mobile notifications when there is activity in
the community?.

3. Select Email next to your Inbox or streams.

Note: The option to change your email notification preferences may be unavailable
in your community.

Examples of email notification strategies

Here are some email notification strategies:
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Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.

• Not receive any email notifications: You won't receive notifications on email. All
update notifications you will receive in the community.

• On your Preferences page, select No in Receive email or mobile notifications
when there is activity in the community?.

• Receive emails for the News Digest only. You can change the frequency that you
receive this digest from the drop-down list. For more information, see News Digest
on page 244.

• On your Preferences page, select Yes in Receive notifications?, and select
Email for News Digest.

• Create an Email Watches stream and follow only critical items. This stream can
be helpful when you're away from the community for a few days or if you want to
watch something that you haven't directly collaborated on. For more information,
see Creating custom streams on page 22.

• On your Preferences page, select Yes in Receive email or mobile
notifications when there is activity in the community? and select Email for
that stream.

• Change the frequency of your email notifications. Instead of receiving an email
for every update, you can receive a digest of updates.

• On your Preferences page, select Yes in Receive email or mobile
notifications when there is activity in the community? and select one of
the summary options from the list next to your Inbox and streams.

Customizing notifications
You can set notifications for your Inbox and any of your streams so that you receive
an email or mobile app notification each time a person, place, or item posts an
update or you have Inbox activity.

There are a few ways to set your notifications.

Remember: You can choose the frequency of these notifications from the drop-down
list next to each Inbox or stream.

When you're viewing or editing a stream

1. On the News (or Home) page, select the stream and click .

2. Select Mobile, or Email, or both from Updates at the top of the page.

3. Click Done.
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Note:  Mobile notifications appear in the Jive Daily Hosted app if you have it installed
on your Android or iOS device. If you don't have one of these apps, mobile
notifications don't have any effect.

From the unsubscribe link in the email

You can click the unsubscribe link in an email so you will no longer receive notifi-
cations. It switches the Receive notifications? option to No on your Preferences
page.

From your Preferences page

1. Go to Your avatar > Preferences .

2. Select Yes in Receive email or mobile notifications when there is activity in
the community?.

3. Select Email or Mobile notifications for each stream and your Inbox, and select
the frequency of notifications for each from the list.

4. Click Save when you're done.

Caution: When you select All Activity, you get an email every time that stream or
Inbox is updated. We recommend leaving Email cleared or choosing one of the
summary options; otherwise, your email notifications could get overwhelming.

For more information about notification settings, see Notification Preferences refer-
ence on page 31.

Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.

Notification Preferences reference
Here you can find the description of preferences related to notifications about
activities.

Fastpath: You avatar > Preferences > General Preferences

Notification Preferences

If you want your email notifications to include the full text of the item you're being
notified about, select Include body of content in email.

Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.
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When you select EmailNotification for Inbox ac-
tivity

Receive notifications on email.Receive notifications?

Receive a notification when a new activity is posted in
custom streams created for you by your community
administrators (if any).

Custom streams created for
you by community adminis-
trators

Receive a separate email each time someone posts an
update to an item you've selected to follow in your In-
box.

Inbox

Receive a notification when someone @mentions you,
shares content with you, or sends you a message in
the community. For more information about mentions,
see Aler ts for people, places, and content items.

Inbox: Direct Social Ac-
tions

Receive a notification when you have a new task, a
new follower, or a new skills endorsement.

Inbox: Alerts

Receive a notification when you have content to mod-
erate. This option is available if you're a content mod-
erator.

Inbox: Moderation

Receive a notification when a followed person, place,
or item posts an update.

Following

Receive a notification when a new activity is posted in
custom streams you created for yourself (if any).

Custom streams

Receive a summary of community news. For more in-
formation about the digest, see News Digest on page
244.

Community Digest

You can select whether or not you'd like your email
notifications to include the full text of the community
item you're being notified about.

Include body of content in
email

Using Your View
Your View lets you customize a page just for yourself, so that you can get to your
most used items quickly.

You can change what you see from Your View whenever you want. For example,
you might want to update Your View when you change projects or teams, or when
you want to watch new things in your community.

• To go to Your View, click the  icon in the main navigation menu, and then click
Your View in the left sidebar.

Note: You won't see Your View if your community manager has not enabled the
feature.
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Setting up Your View
Your View is pre-populated with a few tiles to get you star ted, but you can edit these
or remove them altogether. You can also add new tiles that you select and configure
to suit your specific needs.

Your View is your own page which you design and change for yourself, however
and whenever you like.

• To go to Your View, click the  icon in the main navigation menu, and then click
Your View in the left sidebar.

You can customize the Your View page with tiles. By default, you can see the fol-
lowing tiles in Your View:

• Frequently Viewed

• Latest Blog Posts (if blogs are enabled in your community)

• Trending Content

• Key Content and Places

To edit Your View:

1. Click Edit page at the upper right corner of the page to open it for editing.

2. To configure a tile, click the gear icon on them and change the tiles settings.

3. To move the tiles up and down on the page, click the up and down arrows on
tiles.

To pin Your View to the  button:

• Click  next to Your View in the left sidebar.

Now, when you click the  button in the main navigation menu, you go right to Your
View. This can be helpful if you design Your View with links to your most visited
items.

Adding tiles to Your View
You can add new tiles to Your View in a few steps.

Your View can contain tiles of several types. For more information on the tiles which
you can use on here, see Your View tile reference on page 35.

To add tiles to the Your View page:

1. Click the  icon in the main navigation menu.

2. Click Your View in the left sidebar to open the Your View page.

3. Click Edit page in the upper right corner to open the Your View page for editing.

4. Click Add a tile.
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5. In the dialog box, select a category on the left, and select the tile that you want
to add on the right.

Note:  Note that the list of tiles that appears for selection is different for wide and
narrow columns respectively. Once added, these tiles can be moved ver tically
within the same column or removed within the layout as required.

6. If required, configure the tile by clicking the gear icon at the upper right corner
of the tile and adjusting the tile parameters, and then click Apply.

The tile is added to the page.

7. If required, adjust the tile position in the layout column by using the arrows in the
upper right corner of the tile.

8. Click Save to save the page changes.

With the changes saved, Your View displays the information you want to have on
hand.

For more information about tiles, see Using tiles on page 191.
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Your View tile reference
Here's a list of the tiles available on a Your View page.

Tiles are split by category, similar to tiles arrangement in the UI. Some tiles can be
available in more than one category.

Note: This page is not supported by Jive Daily Hosted.

Collaboration tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Content added
manually

Shows a full pre-
view of a document
you choose to dis-
play

Document
Viewer

 Content added
manually

Builds a list of key
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs

Helpful Links

 Content added
manually

Shows selected
dates for your team

Key Dates
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Graphic Elements tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

 Set manuallyShows status on a
gauge

Gauge

  Content added
manually

Shows a manually
selected video from
an external, non-
community source

Video (Exter-
nal)

Custom List tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Content added
manually

Shows links to com-
munity content un-
der collapsible
headings

Expandable
Sections

 Content added
manually

Builds a list of im-
portant people for
your place

Featured
People

 Content added
manually

Builds a list of key
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs

Helpful Links

 Content added
manually

Displays a list of
content and places
that you can edit
and manage your-
self

Key Content
and Places
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Dynamic List tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Relies on an algo-
rithm

Shows the people,
places, and content
you visit most

Frequently
Viewed

  Content added
manually. Blogs
must be enabled

Shows the newest
blog posts in your
community

Latest Blog
Posts

  Relies on an algo-
rithm

Shows the people,
places, and content
you viewed recently

Recently
Viewed

 Relies on content
being tagged

Shows places with
the same tags

Similar
Places

  Relies on a query:
click Use this view
in a tile at the bot-
tom of any People,
Places, or Content
browsing result

Shows an updated,
filtered view of con-
tent, people, or
places

Super List

 Relies on content
being tagged

Displays content
that matches specif-
ic tags

Tagged Con-
tent

  Relies on an algo-
rithm

Shows content
that's attracting
views and interac-
tions

Trending
Content
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Support tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

 Content added
manually

Build a list of useful
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs.

Helpful Links

  Relies on a query:
click Use this view
in a tile at the bot-
tom of any People,
Places, or Content
browsing result

Shows an updated,
filtered view of con-
tent, people, or
places

Super List

Finding people, places, and content
Jive includes several search features to help you quickly find what you're looking
for, or just to browse through content, people, and places. You can use the topic in
this section to understand which feature best suits your searching goal.

Search and browse features
Here is an overview of Jive search and browse features. Note that as you interact
in the community, Jive keeps track of your interests and connections and
recommends relevant content, people, and places.

Clicking the search icon opens the Spotlight
search. For information on using it, see Using
Spotlight search on page 40.

Search for something specific by
using keywords in the Spotlight
Search
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View your History and
Recently Viewed items

• To see your Jive browsing history, click the search
icon, and then select History.

• To see your recently viewed items, click Show all
my recently viewed content.

If you know something is saved in a specific place, you
can limit your spotlight search to just that place. First, go

Search for something
within a place

to the place. Then, type your keyword into the search box
and select Show: Only for [this Place].

If you know someone authored a document or participated in
a discussion but you can't remember any keywords from the

Search for
someone's content

discussion, go to the person profile and click Content. From
there, browse through their recent content creations and
updates, to find what you're looking for.

To find places marked with cer tain place categories, click
your avatar > Your Places > All , and then click Add Filter
and select a predefined place category in the All list.

This works only if your community manager set up place cat-
egories.

Find places by
categories

Click People in the top main navigation menu (it may be
nested under the Browse button), or in the menu under your
avatar click Your Content or Your Places. On the opened
page, use the left navigation pane to refine the results by
how they relate to you. For more information on filtering, see
Browse and filter content, people, and places on page 44.

Browse and filter
content, people, and
places

You can bookmark any piece of content, and then look at
your most recent bookmarks later by clicking the Spotlight

Bookmark useful
content and use your
bookmarks search at the upper right corner, and then clicking

Bookmarks. To browse through all of your bookmarks, click
Show all my bookmarks. From there, you can see the
bookmarks of others by clicking All in the left sidebar.

You can assign tags that act as keywords to existing or
new content to describe it for people who might search

Tag content to make it
easier to find later

for it later. You can also assign tags to a status update.
For more information about tagging, see Using tags on
page 47.

Jive includes a powerful "genius" feature that analyzes your
business relationships, expertise, and areas of interest based

Use
recommendations

on your behavior in the community. It then uses that data to

39AUREA CONFIDENTIAL

Finding people, places, and content



recommend relevant content, people, and places that you have
not yet seen in the community. There are several places in the
interface where you see your recommendations, but a quick
way to see them is to navigate to People (in the main navigation
menu) or to Your Places or Your Content (from the menu under
your avatar). Then click Recommended in the left sidebar. For
more information about using recommendations, see Using your
recommendations on page 44.

Searches are performed across all supported languages of the
Jive platform. When you search for something, however, the
search engine first searches for results that match the language
you have set in your Preferences on your profile page (click on
your avatar and go to Preferences). If you do not have a language
set there, the search engine uses the locale setting of your
browser.

Search in your
language

Using Spotlight search
The Spotlight search is an easy way to find almost anything that exists in your
community. It also displays your activity history and bookmarked items. It can be

quickly accessed by using  from the main navigation menu.

Before you enter a keyword to search, it already displays some smart suggestions
based on your recent activity. Just star t typing your keywords and Jive lists the
matched content.

To narrow your search results by time and content type, you can also use the
available filters.

If the Spotlight search does not return the results you need, you can press Enter
to see all matching results on the advanced search page. This page provides more
filtering options to perform a more complex and refined search. For more information,
see Search overview on page 41.

Tip: You can disable your History and Bookmarks from being displayed in the search
by using the Don't show history or bookmarks in search option on the
Preferences page.
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Search overview
You can use this search reference to get the most out of the search feature in Jive.
These rules apply to all word search features in the application.

Search for specific words

This is the most basic search mode and is also the default. Enter your search terms
to see the most relevant content, people, or places for those specified words in any
order.

Search for someone's name

Searching for people is similar to searching for specific words. Note that you can't
use phrase searching, wild cards, or field- and date-specific searching to find the
names of people in the community.

Search for phrases

If you enclose a phrase in quotes, your search returns only content where the words
in quotes occur next to each other and in the same order. For instance, specifying
black cat returns text where this phrase appears exactly as quoted, such as our
black cat brings us luck, but does not return the cat was hiding in the black
box.

Note:  Content searches are case-insensitive. For example, entering any of Jive,
jive, or JIVE returns content with any of the words jive, JIVE, or jIVe. For both
regular and phrase searches, we also match words that are very similar, but not
identical.

Search for content with words containing certain letter sequences

The wildcard character * matches any number of non-whitespace characters when
it is placed at the end of a word or within a word in the query.

You can use the following examples to search for multiplication or concatenation.
Note that Spotlight searches automatically use wildcards, even if you do not type *
in the string.

Matches content containing the words multiplication, multiple,
multimodal, multitude

mult*

Matches content containing the words contagion and concatena-
tion

con*ion

Note:  A wildcard cannot be used at the beginning of a word, and it can't be used
as a standalone word.
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Limitations in searches for certain letter sequences

The search engine splits words into subwords and performs optional transformations
on subword groups. Words are split into subwords with the following rules:

• Split on intra-word delimiters (by default, all non-alpha-numeric characters), for
example, Wi-Fi   Wi, Fi

• Split on case transitions: PowerShot   Power, Shot

• Split on letter-number transitions: SD500   SD, 500

• Leading and trailing intra-word delimiters on each subword are ignored: //hello-
--there, dude   hello, there, dude

• Trailing 's are removed for each subword: O’Neil’s   O, Neil

Based on these rules, sometimes you may not get the results you are looking for.
For example:

• If the name of an idea is Ideatest, this idea is not returned when you search for
test.

• If the name of a document is Summer0718photos, this document is returned when
you search for 0718 or photos. But it is not returned if you search for 07, or 18,
or phot.

Synonym searching

Your community may or may not support synonym searches, depending on whether
your community administrator has enabled this feature. Ask your community admin-
istrator whether synonym searches are supported in your community.

If synonym searches are enabled, your searches return results for synonyms. For
example, if you searched for search tips, the search engine would return any found
results for search tips AND find tips because search and find are synonyms.

Restrict to certain date ranges

If you press Enter after entering your search terms into the search box, you can
see the advanced search page. From there, you can restrict your search by selecting
last modified date ranges, such as All time, 1 day, 7 days, 30 days, 90 days, and 1
year. The default is All time, which does not put any date range restriction on your
search.

Compound expressions by using Boolean operators

The special keywords AND, OR and NOT let you create logical expressions in your
searches. When you search, you need to use these terms in capital letters to distin-
guish them from normal words. For instance, the word And in a search is interpreted
as the word and, not the special operator AND.
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The AND operator says that the search should return content containing both the
search terms before and after the AND operator. The OR operator returns content
if either one of the terms matches. The NOT operator excludes documents that
contain (in the fields searched for) the search term after the NOT. You can't star t
a search with the NOT operator. You can also use these operators with sub-queries
enclosed in parentheses to create more complex expressions as shown in the fol-
lowing examples.

Matches text containing the exact phrase quick brown fox
or the word rabbit.

"quick brown fox" OR
rabbit

Matches content containing the words quick, brown, and
fox in any order. Search implicitly assumes the AND
operator when an operator is not specified.

quick brown fox

Matches content containing both quick and brown in any
order, plus either fox or rabbit, but not containing the word

(quick brown) AND
(fox OR rabbit) AND
NOT forest forest. This example shows how you can use parentheses

to group more than one word together as a regular
(non-phrase) search and to specify the order of operations.

Note:  Note that the NOT operator can only be applied to simple terms, not compound
sub-queries, and it cannot be used inside a sub-query.

Special characters and operator words

The following characters and operator words are treated specially in the search
syntax (separated by a single space):

You can't search for these characters and operators, because the
application uses them for special search syntax. If you use these

* ( ) " AND OR
NOT

words in search text in a way that doesn't make sense to the
application, the search engine ignores them. For example, an odd
number of quote characters is ignored, and multiple asterisks next
to each other are interpreted as a single wildcard.

Multi-language searching

Searches are performed across all supported languages of the Jive platform. When
you search for something, however, the search engine first searches for results that
match the language you have set in your Preferences on your profile page (click on
your avatar and go to Preferences). If you do not have a language set there, the
search engine uses the locale setting of your browser.

Promoted search results

You may see some results marked as Promoted when you search. These results
have been selected by an administrator to ensure that cer tain content is always
associated with one or more search keywords, even if the keyword isn't actually in
the content. For example, your site administrator may want users who type Benefits
to always see the Human Resources page as the first result, even if there are many
other pages with titles containing the word Benefits. If a result has been promoted,
you may see it again far ther down the results page.
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Using your recommendations
You can use the Jive recommendation features to find content, people, and places
you might like to follow in your streams.

Jive includes a powerful "genius" feature that analyzes your business relationships,
expertise, and areas of interest based on your behavior in the community. It then
uses that data to recommend relevant content, people, and places that you have
not yet seen in the community. The more you and others interact in the community,
the better the recommendations you receive.

Depending on how your community manager has set things up, you may see some
of these helpful tiles when cruising through your News streams:

• Recommended Content

• Recommended People

• Trending Content

• Trending People

You can also click on any of the browse menus (People, Your Places, and Your
Content), and then click the Recommended tab on the left.

Recommendations limitations

Jive recommendations obey all content permissions and do not recommend content
that you don't have permission to view. Therefore, you may not see the same
Trending Content or Trending People as others, depending on your content viewing
permissions, when you logged in, and when the last data collection occurred.

Your Recommended Content, Recommended People, Trending Content, and
Trending People all change based on your shifting interests, affinities, and even
changes in the org chart.

Browse and filter content, people, and places
You can find the information you need by filtering as you browse content, people,
or places.

The People link is in the main navigation menu only, but content or places you can
star t browsing by selecting Your Content or Your Places in the menu under your
avatar.

Using the filter keyword search

• Star t by typing a keyword in the text box and waiting for the results to refresh.

Note that every browse page includes a set of filtering tabs on the left and across
the top which let you refine your search criteria. For example, when you browse
content, you can choose whether to browse everything or only content you authored
or par ticipated in as you can see in the following screenshot.
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The icons at the top of each browse page let you filter by content type.

Refining your filter results by type

You can limit your view by selecting cer tain types of information. For example, you
can limit content to discussions by clicking Discussions next to All Content. You
can even filter by actions or outcomes marked on content. For instance, you can
filter to see only content marked Official.

Similarly, place browsing can be narrowed to spaces, social groups, or projects.

You can use the keyword, tag, and filter options to refine your search even fur ther.
Note that tag filtering only works if the content is tagged.

For example, here are two ways you might look for last April's East Coast sales re-
port:

• Select Your Content from the menu under your avatar, change the filter to All,
and type Sales Report in the Type to filter by text box. Then click the arrow
under "Sort by latest activity" and select Sort by date created (newest or oldest).
By default, the most recent results are shown first.

• Click People from the top navigation bar and type the Sales Director's name in
the Type to filter by text box. If you don't know her name, try typing in "Sales
Director." After you have located the person, click her name and go to the Content
tab. From there, select Authored from the left-hand menu and Documents from
the top menu to show only the documents she wrote. You can filter these fur ther
by keyword or tag if she's an especially productive content creator.
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Making things easier to find
You can rely on these best practices to make things easier to find for yourself and
others.

To help yourself and other people find the content that you create, try the following:

• Put the content in a place where it's likely to be discovered. For example, put it
in a group that's open-access and of interest to your audience to attract the notice
of community members who follow that group. Before you publish new content in
a place, you can see how many people are following the place, and (if it's a group)
how many are members.

• Bookmark content so that you and others can find it by browsing bookmarked
items. For more information, see Using bookmarks on page 49.

• Apply tags to the content or add them in the body of the content by using the #,
which is a hash or pound sign, and following it with the tag phrase, such as
#tagging_this. Tags give other people a way to find things based on the ways
your community thinks about them. You can follow tags in your streams. For more
information about tags, see Using tags on page 47 and Following tags on page
48.

• As you collaborate on content, make sure you mark it appropriately. For example,
if someone answers your question, mark the answer as Correct. If a document
reaches a final state, mark it Final or Official. Other people can see these
outcomes and use them to filter results when searching and browsing.

• You can make yourself easier to find by adding information to your profile that
other people might be interested in. You can add your experiences to your
expertise list. For more information about profiles, see Setting up your profile on
page 79.

Labeling people to manage them around community
You can name and color code groups of people to make them easier to find when
you browse or communicate with people as a group.

You can create labels to group your friends or connections, the people you follow.
You might use this to group people from a cer tain location together. For example,
if you have a New York office in your company, you can create a New York label.
This helps you find people fast when you have a lot of connections. When you apply
a label to multiple friends or connections, the label becomes a way to show only
those with cer tain labels. Additionally, you can type the label name in when you're
creating a direct message or adding collaborators on a document to automatically
include all the people with that label.

To create a label:

1. Browse your friends or connections by clicking People  and selecting Following
on the left.
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Note: You can only group and label people you're following.

2. Click Create Label  in the left pane.

3. Select a color, type the name for the label.

4. Click Save .

5. Add someone to that new label group by clicking the gear icon on their profile
card, and then clicking Label People.

6. Select the label that you want to apply to the person.

You can remove the label by clicking it again to deselect it.

7. If you want to delete a label group later, click Browse > Following , and then
click the Delete label icon that shows up when you hover the mouse over the
label.

Role badges
If your community administrator has activated role badges, then you can see small
icons next to cer tain community user names.

A role badge is an icon used to indicate the roles or responsibilities of community
users. You might use this to find someone who can answer a question or identify
people whose answers you can count on. Hover your mouse over the icon to see
the name of the role.

Here's a list of possible roles for the badges:

• Administrator

• Champion

• Employee

• Expert

• Moderator

• Support

Using tags
Tags are keywords that you and others assign to content. Assigning tags to your
content makes it easier for you and others to find later.

You can assign tags to new or existing content.

Tagging a status update

• To tag a status update, type # followed by your tag.

For example, a status update of "Really enjoying that amazing #presentation about
#XYZ customer" shows up in search results for "presentation" and "XYZ."
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Tagging content

You can add tags when you create content: Enter tags
into Tags before you Post or Update.

Adding tags when
creating or editing
content

To add tags to existing content, click Edit Tags at the
bottom of the content editor and add your tags. Then
click anywhere outside of the field to save.

Adding tags to
published content

You can also add tags on-the-fly as you're editing
content. To do this, type # (or click # Tag) followed by
your tag phrase into the content editor.

Adding tags in the
content editor

For example, if you're writing about your competitor's
new corporate branding, you could say, "Company X is
resorting to Comic Sans. #jumpingtheshark."

Tips for tagging

• Consider using any existing tags that appear in the suggestion box. Existing tags
are often assigned to related content, so it's good practice to use them.

• Use an underscore between words, such as sales_report or employee_benefits.

Note:  If you are tagging content that is being moderated by an admin, your tags
may not show up right away because content updates may need to be approved.

Following tags
You can follow tags to discover new areas where you can become involved and stay
informed.

Tags can generate more participation and collaboration by helping people find your
content. Create custom streams that include people, places, and tags so you can
fine-tune the stream's content. Following tags in custom streams helps bring you
relevant information from uncommon sources.

For example, if you're in the accounting department, you can add the VP of Finance
and the Accounting Group to your Accounting stream. But also think about adding
tags like #money, #pay, #taxes to direct content into your stream that you don't
normally come across. For more information, see Creating custom streams on page
22 and Examples of custom streams on page 22.

To follow a tag:

1. Create a custom stream.

2. Search for relevant terms.

3. Click Tags to see all tags that relate to that search term.

4. Click Add to include tags in your stream.

Note: When you follow a tag, only content that's been tagged with that tag sometime
in the previous 180 days shows up in your custom stream.
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Using bookmarks
Bookmarks help you keep track of your favorite content over long periods of time.
You can bookmark content inside or outside of your community.

You can bookmark any content in the community, and sites outside of the community.
When you want to look at that content again later, you can go to it quickly by clicking
in the search box at the top of any page and selecting Bookmarked. You can see
a list of your recent bookmarks. Clicking Show all bookmarks at the bottom of the
list lets you toggle between a complete list of Your bookmarks and All, which shows
public bookmarks from everyone in the community.

You won't see bookmarks created for content that you can't access, such as docu-
ments in a private group.

Note: To enable external bookmarks, you need to file a support ticket with Support.
For more information, see Getting star ted with the new Jive Support Portal on Worx.

Bookmarking content inside your community

To bookmark content stored inside your community:

• Go to the content item, and then click Bookmark in the right menu.

Created bookmarks have corresponding titles to easily be located for later use.

Bookmarking sites outside of your community (external bookmarks)

To bookmark sites outside of your community, you need to add the bookmarklet tool
to your web browser. The bookmarklet tool allows you to bookmark external sites
and bring them inside your community.

To install the bookmarklet tool:

1. Click Spotlight search, and then select Bookmarked > Show all bookmarks >
Click to install  in the left pane.

2. Drag the Add Site button onto your browser's toolbar.

To bookmark a site outside the community:

• Click Add site to community in your browser's toolbar and then add your notes
and tags.

You can use the bookmarklet link to bookmark any content as you browse the Web.
In other words, you don't need to be using Jive to save and share bookmarks in
your Jive community.

You might also be interested in learning about Jive Anywhere, which allows you to
socialize things in your Jive community that you've found on the Web or even in
other applications. Your community may not include this additional module by default.
For more information, see the Jive Anywhere Help.
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Using History and Suggestions features
Click the Spotlight search to see pages you've recently or frequently viewed in the
community.

The History and Suggestions tabs in the Spotlight search area show the content,
people, and places you have recently visited (History) or frequently visited (Sug-
gestions) in your community. For a more detailed listing of items in your history,
click Show all my recently viewed content. From there, you can sor t your items
by date or use a keyword search to filter them.

Can't remember people, place, or title?
Sometimes you can't remember the title, people, or place of something you know
you saw. In that case, try this search method.

For example, you remember par ticipating in a discussion during the last three months
about how to increase customer survey participation, but you can't remember the
discussion title, which space the discussion occurred in, or the other par ticipants.
Use the Spotlight search at the top right and type in keywords such as customer
survey. Click View all Results and then click Discussions in the top menu because
you don't need to see results from blogs, documents, or polls.

Tip:  If you still can't find the discussion, it is possible that it wasn't a discussion
that you remember. You might try looking in the comments of documents or blogs.

Using social groups
Social groups help you bring people together around shared interests, ideas, and
projects. Here you can find how to create and manage social groups in Jive.

Groups, or social groups, are isolated containers within a community; they have no
ties to other places and cannot have sub-groups. Permissions are managed on a
per-group basis by the original group creator or the admins selected for the group,
or both. Groups can also house any type of content unless one or more is turned
off by community administrators. Because they are a freely created containers,
groups get used most often for topic-specific collaboration, rather than something
general to a team. They also get used for collaboration between specific teams or
different departments that often work together closely and rely on each other.
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Creating groups
Creating a group enables you to set up an area where like-minded people can put
their heads together and share information on the group subject. You must have
special permissions to create a group, which are set by your community administrator.

Before you create a group, you may want to consider the purpose of the group, what
kind of information needs to be included, who will par ticipate, and how people who
need to know about it will find it. The way you name the group and the tags you
assign to it are different ways you can make it available to people who might be in-
terested in the group. For more information, see Group creation options on page
52.

Important: You can change the group URL when you are creating a group. You
won't be able to change the URL after you create the group.

By default, groups use Activity pages with tiles as landing pages.

To create a group:

1. Click  > Group  in the main navigation menu.

This opens the Create Group dialog box.

2. In Name, enter the name of the group.

The group name must be unique within the community. This name shows up at
the top of the group page and at the end of the URL that links to the group. Also,
it should be identifying the group within the community.

3. If required, in URL, change the group URL.

You can use this option to make a short URL for your group. The group URL must
be unique within the community.

4. In Description, enter a brief description to appear in the group's main page.

You should add information on what the group is about in a way that attracts other
people who might be interested in the group. For example, your RFP Collaboration
group could say "Look for the latest RFP templates and materials here."

Note: This information is displayed behind the information icon  and on the
Overview page if the group uses one.

5. Under Group Type, choose a group type.

You can granularly restrict access for viewing and editing content. For more
information, see Types of groups on page 57.

6. In Tags, enter tags that can be used to find this group. To enter multiple tags,
press Enter after each word or phrase.
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Tags are words or short phrases that help other people find your group. For
example, a Sales group might use the following tags: RFPs, sales_videos, and
wins.

7. In Categories, select the place categories to associate with the place.

The place categories are used to identify places while browsing. They are used
to classify places and differ from content categories. This option is available if
place categories are configured in your community.

8. If required, click Advanced options to expose more options and specify the
following:

• Overview page: Specify whether you want to use a widget-based Overview
page. This option may be not available in your community. For more information,
see Adding Overview page on page 56.

Important: We do not recommend that you use widgets and widgetized
Overview pages in your community. For more information, see Understanding
pages in places.

• Locale: Select your default language for the group. The group also uses the
time zone and date format commonly used in this region.

By default, your place uses an Activity page as its main page, with the option to
add more custom pages. We recommend using an Activity page because it can
be displayed on mobile devices and because it's more friendly to streaming
content. If widgets are enabled in your community (not common), you may want
to include an Overview page with widgets.

9. Click Create Group.

10.If required, in the Invite People to Join dialog box, add users who you want to
invite to the group, and then click Send Invitation.

You only see this option for Private and secret (Private: Unlisted) groups.

The group is created, and the main page opens for your view. Now you can customize
the group, as described in Customizing your group on page 54.

Group creation options
Creating a group always star ts with clicking Group in the Create menu, but it helps
to understand the options that can help your group do what you want it to.

Group landing page

The main group page is defined by the types of pages enabled for the group.
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Landing pageEnabled pages

The leftmost page in the group navigation menu.Activity + Pages

Overview pageOverview only

Defined during community setup (under Advanced options in
the Create Group or Edit Group dialog box)

Activity +
Overview

Advanced group creation options

In the following table, the asterisks (*) note when this advanced option for place
navigation might be unavailable. For more information on differences between Ac-
tivity and Overview pages, see Understanding pages in places.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

Can I change this later?I should. . .I want to. . .

Yes. Note that changing
this setting changes the
visibility setting for all the
group's content.

Choose a Private or Secret
(also known as Private: Un-
listed) group type during the
initial setup. You can change
this setting later. For more
information, see Types of
groups on page 57.

Collaborate in private by
limiting who can see
what's in my group, or
even who can see that
my group exists.

Yes.Create a group, then for the
Activity page choose and
configure a Place Template
customized for the kind of
work you want to do. For
more information, see Design-
ing activity and custom
pages for places on page 172.
Place Templates only apply
to Activity pages.

Design a landing page
that's optimized for a
specific work purpose.

Yes.Select Overview or Activity
+ Overview under the Ad-
vanced options during set-
up, and fill out a widget lay-
out under Manage >
Overview page  from the
group page. For more infor-
mation, see Designing
Overview pages for places
on page 223.

Design a landing page
with widgets*

Yes.Create the group, and then
add the pages to your place
afterward. See Adding cus-
tom pages to places on page
173.

Make more custom pages
in the place for displaying
information, not just a
landing page.
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Can I change this later?I should. . .I want to. . .

Yes, but keep in mind that
some external stream
types cannot be disconnect-
ed from the group except
via a case with Support.

Create the group, then click
Add a stream integration
when configuring the Activity
page. For more information,
see Adding tiles with external
stream integrations to Activi-
ty page on page 176.

Integrate external
streams from Facebook,
Chatter, or any other
apps your community ad-
min has enabled.*

Yes.During place setup, after you
preview the group, edit the
Activity page.

Limit the kinds of content
that can be included in
this place.

Yes, but if the place is lat-
er disconnected from exter-
nal storage, users will see
references to documents
that they can't access from
Jive anymore.

During place setup, after you
preview the topic, edit the
Activity page. External file
storage is available if at least
one storage provider has
been set up by community
administrators. For more in-
formation, see Using external
file storage  on page 64.

Store the place binary
documents outside Jive,
for example, in Box or
SharePoint.

Yes. Changing the External-
ly Accessible setting will
remove access by non-
members, but their contri-
butions will stay in the
group.

Make the group Private or
Secret, and select External-
ly Accessible. For more in-
formation, see External
groups overview on page 140

Make this group a place
for collaborating with
people who aren't mem-
bers of the community.

Yes. Just remove or re-
place the tags or place
categories.

Add tags and place cate-
gories to your place in the
place settings.

Make sure people can
find the place.

Customizing your group
After you create a group, you can change it to suit your requirements.

• You can apply a place template to quickly populate the tiles on the Activity page
of your group. The default template is Team Collaboration. For more information,
see Applying place templates on page 174 and General place template reference
on page 180.

• You can change the place image or the banner to configure the visual presentation
of your place. For the detailed procedure, see Customizing the group landing
page on page 55.

• To enable features, click Manage > Configure activity page . Click the Edit icon
for the Enabled Features and Content Type tile. When it opens, you can select
the types of content that your group will use. This list also controls what shows
in the Content tab of the group, as well as what content types you can use to filter
the Content tab.
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• To set up external storage, click Manage > Configure activity page , and then
click External Stream Integration. When it opens, you can select where the files
in this group will be stored.

If your administrator has enabled a connection with an external storage provider
such as Box, Dropbox, SharePoint, or Google Drive, you can set your group to
synchronize document storage to that provider. Files that are uploaded to the
group will be stored in external storage, rather than in Jive, and files can be
added, deleted, or modified from either side.

Note:  For Box users: Although you can connect an open group to a Box folder,
only community members who have joined the group can see Box documents and
have their comments reflected on the Box side. Because of this limitation, it's
recommended to use the Box external storage only with Members Only (Public:
Restricted), Private, or Secret (Private: Unlisted) Groups.

Customizing the group landing page
If you're a group owner or administrator, you can customize your group's landing
page so that it displays the information and images that you want visitors to see.

Adding a banner and logo

To add a group logo and change the group banner to help brand your group's landing
page:

1. Go to the landing page for your place and click the Manage > Settings .

Note: The group activity page opens for editing. You can make changes to this
information now if you want, but it's not required right now.

2. Click Banner Design to customize the header.

3. Click Place Image to select a new image to the header.

4. Click Save.

Adding tiles or widgets to customize the page layout

• If you chose an Activity page, add tiles and external stream integrations, as
described in Adding tiles with external stream integrations to Activity page on
page 176.

Tip: To make it even easier, assign a place template to get an Activity page with
pre-configured tiles and layout, as described in Applying place templates on page
174.

• If you chose an Overview page, change the layout of your widgets, as described
in Setting up Overview page on page 225.
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Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in
places.

Further customizing your landing page and making it express your group's
purpose

• If you chose a tile-based Activity page, see Designing activity and custom pages
for places on page 172 for more details about how to use it effectively.

• If you chose a widget-based Overview page, see Designing Overview pages for
places on page 223 for more information.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in
places.

Adding Overview page
When widgets are enabled in your community, you can add an Overview page to a
place.

Overview pages are based on widgets while other pages, such as Activity and custom
pages are based on tiles. Please note that tiles provide a better user experience
and perform better, especially on mobile devices.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

If you want a place to have an Overview page, you can add either an Overview page
or both Activity and Overview pages. You can't enable Overview and Custom Tile
pages for a place at the same time.

Tip:  If you use the checkpoint and status functionality for tracking project tasks,
you may want to stick with the old-style Overview page rather than updating to the
Place Template format. The widgets in the Overview page more effectively support
Projects at this time.

For more information about Overview pages, see Designing Overview pages for
places on page 223.

Adding an Overview Page to a place

To use an Overview page in your place:

1. Go to the landing page for your place and click the Manage > Settings > About
. The Edit Group page opens.

2. Click Advanced Options .

3. Select Overview or Activity + Overview.
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4. If prompted, select the landing page, that is, determine which page must open
when a user opens the place.

5. Click OK.

6. Click Save at the bottom of the page.

The Overview page is added to your place and becomes visible to other users.

Types of groups
A group's type determines who can join, see content, par ticipate, and invite new
members.

Unlike spaces, which use permissions to determine access, social groups rely pri-
marily on membership to determine access. Because groups do not exist inside
spaces, they do not inherit any space permissions. Note that group owners and
community managers can change the settings for a group after it is created.

Use the following tables to help you understand the different types of groups that
can be created in the community. Most communities use the group scheme in the
first table: if your community has enabled Group Membership Evolution, you'll see
Public and Private as the main group types and should use the second table.

If you have Members Only and Secret Groups

OpenMembers OnlyPrivateSecret

All (no member-
ship)

AllGroup name
only

NoneWhat is visible
to non-mem-
bers?

AnyoneAnyoneMemberMemberWho can see
content?

AnyoneAnyone can in-
teract with con-
tent and create
discussions and
questions. Only
members can
create other
content types

MemberMemberWho can partici-
pate?

AnyoneMember or ad-
ministrator

Member or ad-
ministrator

Member or ad-
ministrator

Who can invite
new members?

No membershipNo membershipAdministratorAdministratorWho can ap-
prove new
members?
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If you have Public and Private Unlisted groups

PublicPublic Restrict-
ed

PrivatePrivate Unlist-
ed

All (no member-
ship)

AllGroup name
only

NoneWhat is visible
to non-mem-
bers?

AnyoneAnyoneMemberMemberWho can see
content?

AnyoneAnyone can in-
teract with con-
tent and create
discussions and
questions. Only
members can
create other
content types

MemberMemberWho can partici-
pate?

AnyoneMember or ad-
ministrator

Member or ad-
ministrator

Member or ad-
ministrator

Who can invite
new members?

No membershipNo membershipAdministratorAdministratorWho can ap-
prove new
members?

Inviting people to join groups
As a group administrator or member, you can invite people to join the group. Note
that if you're using Jive as an internal corporate community, people from outside
the community might not be able to join your group.

You can find out about group members as follows:

Click About on the group's landing page.Count of members (and follow-
ers)

Click on the Followers and Members links to
be directed to the group's People page.

Who are members (or followers)

Any group member can invite any other user to join a group. If the group is public,
then you can share the group with non-members. If the group is private or secret
(also known as Private: Unlisted), the invited user must accept the invitation. A
group administrator must then approve the request to join the group. If it was a
group administrator who originally sent the invitation to the private or secret group,
the approval is automatic. For more information on how a group's type affects the
content visibility, par ticipation, and invitation permissions for group members, see
Types of Groups.

To invite people to join your group:

1. Go to your group and select Actions > Invite members .

2. In the Invite People dialog box, enter the Jive user names or email addresses
of people you want to invite. If you can't remember them, you can do two types
of searches:
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• To invite several people from your email address book, browse your contacts
by clicking the browse icon. Select the people you want to invite, and then click
Add selected people.

Note: You can also paste in a comma-, space-, or semicolon-separated list of
addresses exported from your email application.

• To invite only those with cer tain skills, click Search by skill to browse people
by their skills. Type in the skill you are looking for, or select a popular one.
Select the people you want to invite, and then click Add selected people.

3. Under Include a personal note, edit the message you want potential group
members to see with their invitation.

4. Click Send Invitation .

The invitations are sent to the persons you specified.

Managing pending invitations
As a group administrator, you can delete or resend invitations while managing group
membership. This can be useful if you've got a lot of outstanding unanswered
invitations.

To resend or delete invitations to the group:

1. Go to your group and select Manage > Members .

2. On the Manage group members page, click Open Invitations to view the pending
invitations.

3. To delete pending invitations, select the invitations, and then click Delete
Invitation in the tab menu.

4. To send invitations one more time, select the invitations, and then click Resend
Invitation in the tab menu.

Posting status update in groups
There may be times you want to limit your status update to only a specific group in
your community. When you post a status update to a group, only members and
people following the group see the update in their attention streams.

The status updates are displayed in Trending content tiles. If your group has an
Overview page that includes the Recent Activity tile, the status update is displayed
there as well.

To post a status update for a group:

1. You can create a group update from either the News page or the group's Activity
page.

Note:  Some groups do not use Activity pages.
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• Activity Page: Go to the Activity page for the group where you want the status
update to display.

• News: Under All Activity, click Change next to your community name, and
then select or type the name of the group from the group picker.

2. Type your status update in the What's going on? box next to your avatar.

3. Click Post.

Enabling non-member content sharing
Private group owners can configure their private group so that group members can
share specific documents and discussions with non-group members. This allows
non-group members to help review or edit private group content but does not allow
them to see any other content items that live in the group.

To enable this feature, your community manager first needs to enable non-member
content editing for private groups in your community. For more information, see
Managing external groups in the Community Administrator Guide.

You must be the group owner or administrator to enable non-member content editing.

To enable non-member content editing in a private group:

1. Go to the private group, and then click gear icon > Settings .

2. Click the pencil icon next to the group's name in the header.

3. Under Group Type, make sure that group type is set to Private.

4. Select the Content Editing by Non-Members check box.

If you don't see this option, you need to ask your community manager to enable
non-member content editing in private groups.

5. Click OK, and then Save your changes.

Documents, discussions, questions, and uploaded files in a private group can be
shared with the users who are not members of the group. For more information, see
Sharing content with non-group members  on page 60.

Sharing content with non-group members
Documents, discussions, questions, and uploaded files in a private group can be
shared with the users who are not members of the group. This is useful if you need
a non-group member to help you review and edit a document or discussion.

Content sharing options
Non-member content sharing must be allowed for the group. The group owner or
community administrator may need to enable this feature for you, depending on how
your community is set up. For more information, see Enabling non-member content
sharing.

With the feature enabled, you can share documents, discussions, questions, and
uploaded files (when they are stored within the group). Besides, you can choose
both community members and people outside of the community as recipients.
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A content item can be shared as follows:

• PDF export: The selected content item is converted to PDF with comments included
and sent by email.

• Co-authoring: The selected content item is made accessible to a community user
for viewing and editing. The user effectively becomes a co-author of the content
item.

Note: You can't share files that are stored in external storage, such as Google
Drive.

How you can share a content item depends on whether you can edit this item or
not.

And the recipient is...

If you are... not a community
member

a community mem-
ber but not a

group member

• PDF export• PDF export
Group member and cannot edit the con-
tent item

• PDF export• PDF export

• Co-authoring

Group member and can edit the content
item

• PDF export• PDF export
Group owner and cannot edit the content
item

• PDF export• PDF export

• Co-authoring

Group owner and can edit the content
item

• PDF export• PDF export
Community administrator with the Man-
age Social Group permissions

• PDF export• PDF export

• Co-authoring

Community administrator with the Full
Access permissions

Note that in groups, documents and files can be co-authored by all group members,
and both methods can be used for sharing. But questions and discussions can be
co-authored only by their authors, other group members can share them only as
PDFs.
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Sharing with non-group members
To share a document or discussion with a non-group member:

1. Go to the content item that you want to share.

2. Click Share in the menu.

3. Enter the name or email of the person with whom you want to share the item.

The user is added in a red box under the search box, and a notification with the
sharing details is displayed.

4. If you have a choice for sharing, select one of the following and then click OK.

• Grant this user access to this content only: Grants the selected user access
for viewing and editing to the selected content item. The user becomes a
co-author of the content item.

• Email this user a PDF of this content: Converts the content item with
comments to PDF and sends it to the selected user.

5. Under Message, type a note for the person.

6. Click Share.

You can see a green bar at the bottom of the screen letting you know the share was
successful. You can also see an orange icon at the top that lets you know the item
is visible to non-group members. You can click the provided link to see which non-
group members the content item has been shared with.

Sharing content with other places
To make using the community easier for people who tend to focus on cer tain groups,
spaces, or projects, you can share your content with their place even if you initially
post it in another place. When you share content with a place, it shows

up in that place's activity stream. Anyone following the place where the
content is shared receives a notification in the stream.

People who don't have access to the original content can not have access to the
shared one either. For example, you post a Contact List document in the Human
Resources group, and some Engineering managers have access to the Human Re-
sources group, but they spend most of their time in their Engineering group. You
could share the document with the Engineering group, which is open, and know that
only the managers can search for and view the Contacts List document.

This feature is turned on by default in internal-facing communities.

To share content with multiple places:

1. Go to the piece of content you want to share, such as a document, blog post, or
discussion.

2. Click Share in the menu.

3. Enter the name of the place you want to share the item with, or use the place
picker to navigate to and select the place.
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4. If required, add more places.

5. Type a note about the share in the Message box.

6. Click Share.

To let you know that the share was successful, you can see a green bar at the
bottom of the screen. At the top, you can see the places it has been shared with so
you can keep track. You can click the x other places link to see which other places
the item has been shared with.

Making bulk changes to content in places
You can make bulk changes to content items stored in a place, including applying
tags, categories, and outcomes. Also, you can move or delete a list of items. This
can be a quick and easy way to organize the content in a place better so that you
and others can find it faster later.

You need to be the place owner or have the Manage Community permissions to
make bulk changes in the place.

To make changes to content in bulk:

1. Go to the place you own and click the Manage > Bulk manage content .

2. On the Bulk manage content, select the content items to which you want to apply
the changes.

3. Click an action icon in the menu above the item list. You can do one of the
following:

DescriptionOptions

Applies the same tags to all of the selected items.Add tags

Applies the same categories to all of the selected
items. You won't be able to select this if categories
are not set up in your community.

Add categories

Applies the same outcomes, such as Outdated or
Final, to all of the selected items.

Set outcomes

Moves all of the selected items to the new place you
choose.

Move

Deletes all of the selected items.Delete

4. In the dialog box, review the list of items. If necessary, click Remove next to an
item to remove the item from the list.

5. Click Continue. You may need to click another Continue depending on the option
you selected.

6. Depending on the selected action, specify the settings or once again review the
issue list.
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7. Click Continue.

The selected action is performed, and the results are displayed in the dialog box.

8. Click Close to close the dialog box.

Using external file storage
Jive can integrate with a number of external storage solutions on a licensing basis
to store and organize big files and then synchronize them in a Jive group or space.

By default, Jive uses an external binary storage repository or its own database to
store uploaded files. But Jive has the capability to connect to different storage
providers, so you can store and organize large files in your storage provider and
then socialize them in a Jive place.

When you create a group, you may have the option to connect it to a different storage
provider than the default configured when your community was set up. Using external
file storage means that when a user uploads a document, it's stored with a third-
party file storage service instead of directly in Jive. Files can then be automatically
synchronized in both directions, which means you can add or update them from either
side. If the storage provider has comment functionality, comments are also synchro-
nized with comments in the group.

Note:  Attachments to Jive are not stored in external storage.

Supported external file storage systems

Jive currently provides the following configurations as add-ons.

For more information, see the Jive for SharePoint 2010 Help or
the Jive for SharePoint 2013/2016 (v5) Help depending on
SharePoint installation type.

SharePoint

For more information, see Box.com Integration in the More
Integrations Guide.

Box.com

For more information, see Google Drive Integration in the More
Integrations Guide.

Google Drive

Note:  One more option for integration with Google allows users
to works with Google documents directly from Jive. For more
information, see the Google Drive Files and Docs Help.

For more information, see Dropbox Integration in the More
Integrations Guide.

Dropbox

These connectors provide two-way synchronization between files uploaded to the
storage provider and a place in Jive where these files are socialized. For more in-
formation, see the More Integrations Help.
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Groups with Box Storage
If your administrator has connected your community with a Box.com file store, you
can take advantage of file storage and synchronization with Box for groups where
this is enabled.

When a user uploads a document, it's stored in Box instead of the regularly config-
ured binary storage location. Files are automatically synchronized in both directions,
and so are comments and replies, so that users can interact from either the Jive
side or the Box side.

Attention:  Attachments are not stored in Box.

To take full advantage of the linkage, users should join the Box-linked group. This
allows users to interact with Box-linked content under their own user accounts and
synchronize comments correctly to the Box side. Otherwise, their interactions will
be posted by a system user called the Jive Integration User, and their comments
will not be visible on the Box side.

Note:  Although you can connect an open group to a Box folder, only community
members who have joined the group are able to see Box documents and have their
comments reflected on the Box side. Because of this limitation, it's recommended
to use the Box external storage only with Members Only (also known as Public:
Restricted), Private, or Secret (also known as Private: Unlisted) Groups.

For more information, see Box.com Integration in the More Integrations Guide.

Modifying files in Box

Files can be modified on the Box side by any user who has a Jive account and rights
to the group-linked folder in Box. In addition, file comments made in Box are syn-
chronized and displayed in the Jive group.

Note: There is a known limitation for files that have been deleted from Box, and
then restored on the Box side. Restored files are not synchronized to Jive when
they are restored. However, uploading a new version of the file to the Box side
re-adds the restored version and adds the new version at the same time, resulting
in two added files. Re-adding the file from the Jive side initially return a generic
error, but the second upload attempt succeeds.
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Groups with SharePoint storage
If your administrator has connected your community with a SharePoint storage site,
you can take advantage of file storage and synchronization with SharePoint for
groups where this is enabled.

When a user uploads a document, it's stored in a SharePoint site instead of the
regularly configured binary storage location. Files are automatically synchronized
in both directions, as well as comments and replies, so that users can interact from
either the Jive side or the SharePoint side. Users can also search inside the
SharePoint site without leaving Jive.

For more information, see the Jive for SharePoint 2010 Help or the Jive for Share-
Point 2013/2016 (v5) Help depending on SharePoint installation type.

Groups with Google Drive storage
If your administrator has connected your community to a Google Drive storage site,
you can take advantage of file storage and synchronization with Drive for groups
where this is enabled.

When a user uploads a document, it's stored in Google Drive instead of the regularly
configured binary storage location. Files are automatically synchronized in both di-
rections.

For more information, see Google Drive Integration in the More Integrations Guide.

Note:  One more option for integration with Google allows users to works with Google
documents directly from Jive. For more information, see the Google Drive Files and
Docs Help.

Using content
Content takes up the major par t of Jive, so learning to create, promote, and manage
it effectively is a cornerstone of Jive collaboration.

Creating content
You can create items of the types available in your community. You should choose
a content type based on your collaborative goals.

To create a content item:

• Click , and then select the content type of the item.
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For example, you can draft a discussion, question, document, or blog post.

Note: You may not see the Create menu ( ) if your community manager disabled
the feature.

Most collaborative activities occur in discussions, questions, and documents. Blog
posts are typically used for viewpoint essays and other long-form communications
that don't invite collaboration. For a more detailed analysis of the differences between
these types of content, see Differences between documents, blog posts, and discus-
sions on page 74.

Private and public content

By default, the content you create is public in the community and searchable. The
power of a community is that everyone in the community can benefit from shared
content. However, in some cases, you may want to limit who sees content and who
can collaborate on it with you. For more information about deciding who can see
and collaborate on your documents, see Using documents on page 84. For more
information about private discussions, see Using discussions and questions on page
81. You can also choose to publish your content in a private social group that limits
content to approved members.

For more information about private and public content, see Public and private
communications on page 131.

Monitoring your content

You automatically follow all content that you create, so you receive an update noti-
fication in your Inbox whenever anyone responds to your content or changes it. This
notification is updated whenever you or another user edit or comment on the content,
or make another notable action. Note that if it is you who made the action, the noti-
fication is marked as read. And if the item has been updated by another user the
notification is marked as unread, to attract your attention. If you have the Unread
Only option selected, you will see only notifications about actions of other users.
And if you do not want to receive notifications about this content item, click Hide
new activity in the lower pane.

Note that you can delete any comments on your content if required.

For more information about Inbox, see Tips for using Inbox.

Updating or deleting your content

You can update any content item you created, as well as delete the content entirely.

Content in moderation

Jive supports content moderation when the new content items and updates in existing
items are reviewed by moderators before becoming available for users. Moderation
can be enabled for places within the community and for documents.
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When you try to publish to a moderated place, you will see a warning that content
is in moderation. If the moderator who reviews your content has any remarks, you
would be able to correct them and resubmit the content item. And once the moder-
ator approves the item, it is immediately published.

Note:  Older versions of content items are not accessible when the latest version
is pending moderation.

For more information about moderation, see Document approval on page 148 in this
guide or Moderation in the Jive 9.x Community Manager Help.

Using content editor
When you create or edit content, such as writing and formatting text, creating tables,
embedding images and videos, and inserting links, you use the content editor built
into Jive.

The editor includes many of the standard features of other word processing programs.
You can access them by using either the icons in the interface or keyboard shortcuts.

Here are some features of the content editor you may want to explore.

In-line @mentioning

To @mention someone while you are typing in the content editor:

1. Type the @ symbol (or click the @ button if it is available). A search dialog opens
and suggests possible matches.

2. To narrow matches, use an underscore (_) as a space. For example, @Mike_D
would match the Mikes whose last name begins with D.

3. Select the correct match from the list and note the new link in the content editor.

For more information about @mentioning, see Aler ts for people, places, and content
items.

Adding table of contents

The content editor includes a feature that automatically generates a hierarchical
table of contents based on the headings in your content. When you insert the table
of contents, the editor looks at the headings your content uses, including their levels
(such as Heading 2 or Heading 3). Based on the heading levels, the editor creates
links to the headings, indenting the links at similar levels.

• To insert the table of contents, click  > Table of Contents .

While you're editing the content, the table of contents appears as an icon, as dis-
played in the screenshot below.

In the saved or published version of the content, the icon is replaced with a hierar-
chical list of links to headings in your content.
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Working with tables

The content editor table feature allows you to create and manipulate tables.

• To create a new table, click the table icon and select the number of rows and
columns you want.

• To add, remove, or duplicate rows and columns, use  on them.

• To move around rows and columns, mouse over  and drag them as required.

• To merge cells, click in the cell you want to merge, then click  and select Edit:
Merge Cells. In the dialog box, specify the cell range to be merged. The cells
are merged as you finish selecting.

• To delete a table, click in a cell, then click  and select Edit: Delete. The table
is deleted.

• To format individual cells, rows, or columns, click in a cell, then click  and
select the item you want to format (a cell, row, column, table). In the dialog box,
make the necessary tables.

You can designate and format headers, change the color of text, lines, and back-
ground, and customize many other settings. Note that when you change the header
setting while making changes in a column, only the header for that column changes,
not all of the headers.

In addition, changing the color of text using  changes the default text color setting
for the selected cell, row, or column. To make text color changes that you don't want
to apply as a default to the cell, row, or column, use the text color icon in the editor's
toolbar.

When you are finished formatting your table, click away from it and continue editing
your document.

Using the spellchecker

The content editor includes a spellchecker that you turn on when you want to check

the spelling. When you're ready to check the spelling in your document, click .
Misspelled words are underlined in red. You should click a misspelled word to view
suggested alternate spellings and scroll down to select the best match.
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Note that the spellchecker does not check spelling as you type. You must turn it on
or off by clicking the spellchecker button. After you have made corrections, click
the button again to recheck spelling.

Also, you can change the language used for spell checking by clicking the down

arrow at the right side of .

Viewing code source for content

The content editor's Source Code feature allows you to edit your document in HTML.
Click the <HTML> link in the editor's toolbar when you want to write directly in HTML.
When you're finished, you can toggle back to the default editor view by clicking OK.
Clicking Cancel returns you to the content editor without making changes.

Note: When pasting internal URL in the default content editor, it gets automatically
titled. To include URL without having it automatically titled, use the Insert URL
option.

Some kinds of HTML markup can cause the site to be less secure. For this reason,
cer tain HTML tags aren't supported by default. When you use these tags, Jive re-
moves them before displaying the content. You can include them, and they are
saved, but they don't render when someone views your content. Here's a list of
what's not supported:

Tags: <embed>, <html>, <head>, <iframe>, <link>, <meta>, <object>, <script>,
<style>

Attributes: action, class, method, on* (such as onClick), *src*

Using code syntax highlighter

The content editor's Syntax Highlighter feature allows you to mark text as code and
specify the language so that it renders correctly in the saved and published versions
of your document, blog post, or other content. This is useful to show code examples
in your documentation. Supported code styles are SQL, XML, Java, JavaScript,
Plain text, C++, C#, CSS, PHP, Ruby, and Python.

• To apply the code formatting, select the block of text you want to format, then
click the  > Syntax Highlighter  and select the language-specific formatting
you want.

Here are a few code examples.
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Working with links

Use  icon on the toolbar to inser t a link. You can also paste the link in the editor
directly.

When you paste an internal link, the editor automatically generates a title for the
link. For custom titles, use the toolbar option.

Repurposing content items
If you want to use an existing document or another item as the base for a new one,
the HTML editor can help.

In Jive, you can copy existing documents or create templates for them. For more
information, see Copying content on page 104 and Creating templates on page 105.

But if you need more flexibility, you can create a new content item and use the HTML
code from an existing item as the base for a new one. For more information about
working with source code in the content editor, see Using content editor on page
68.

To star t a new document using an old one as the base:

1. Go to the document you want to star t with, and click Edit in the Actions menu.

2. On the editor menu, click <HTML>.

This switches the document editor into HTML mode and exposes the HTML code.

3. In a different browser tab, star t creating a new document.

4. Click <HTML> to switch the new document into HTML mode.

5. Select all the HTML in the base document and copy it, then paste it into the new
document.

6. Switch the new document back to the full editor and edit the document before
saving.

Earning status points
When you create or respond to content in Jive, you earn status points in the
community.

The success of the community depends on your contributions, so you are rewarded
with points for getting involved. Over time, you develop a reputation for reliability
and authority in your favorite areas. The more people par ticipate, the more informa-
tion that is available for the community as a whole. You can become a top participant
in your community by earning status points.
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Checking your points

To find out how many points you have:

Hover over your name from anywhere in the interface. In the profile
hover card, you can see your points and level listing, as well as any
badges you have earned. For a more detailed view, click your name
to go to your user profile.

Or go to a Latest Acclaim notification in your Inbox. Scroll down
through the notification to see your points and how you rank in a list
with other community users.

Quick view

Go to your user profile by clicking your avatar > View Profile  or
your name anywhere in the interface, and then click Rewards. There
you can see a full listing of the badges you've earned, quests you've
completed, your points total, and how many points you need to get
to the next level.

Detailed
view

Note:  In places, the Your Progress or Top Participants tile (which one you see by
default depends on how your community is set up) shows your status points for your
activity in that place only. You may notice that this tile shows different point levels
depending on what place in the community you are looking at.

Earning points

Because each community can be set up differently, you should ask your community
administrator for details about status points. What activity is rewarded, status levels,
badges, and points awarded may vary. Depending on how your community is set
up, you may earn points and badges when you involve yourself in the following types
of activity:

• Post a discussion or question, or respond to one

• Correctly answer a question

• Provide helpful information in the replies or comments of documents, discussions,
and blog posts

• Create new documents

• Create new blog posts

• Complete new tasks in a project

• Create a new status update

• When someone likes your status update

• When someone shares your status update

Note: When content is deleted, status points are also deleted.
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Sharing content with other places
To make using the community easier for people who tend to focus on cer tain groups,
spaces, or projects, you can share your content with their place even if you initially
post it in another place. When you share content with a place, it shows

up in that place's activity stream. Anyone following the place where the
content is shared receives a notification in the stream.

People who don't have access to the original content can not have access to the
shared one either. For example, you post a Contact List document in the Human
Resources group, and some Engineering managers have access to the Human Re-
sources group, but they spend most of their time in their Engineering group. You
could share the document with the Engineering group, which is open, and know that
only the managers can search for and view the Contacts List document.

This feature is turned on by default in internal-facing communities.

To share content with multiple places:

1. Go to the piece of content you want to share, such as a document, blog post, or
discussion.

2. Click Share in the menu.

3. Enter the name of the place you want to share the item with, or use the place
picker to navigate to and select the place.

4. If required, add more places.

5. Type a note about the share in the Message box.

6. Click Share.

To let you know that the share was successful, you can see a green bar at the
bottom of the screen. At the top, you can see the places it has been shared with so
you can keep track. You can click the x other places link to see which other places
the item has been shared with.

Who can see my content
In Jive, people post content in places. This means that all content (such as
discussions, documents, and blog posts) are published in a containing place (space,
sub-space, group, or project). All places have visibility permissions (set by the place
owners) that determine who can see the content posted in that place.

For more details on content visibility, see Public and private communications on
page 131 and Content visibility options on page 134.

Creating hidden content

In addition, each user has their own personal container. Content that you set as
Hidden before you publish it is stored in your personal container and is private to
you. When you publish Hidden content, only you can see it as a content update in
your streams; other users do not. For more information, see Creating documents
for yourself on page 78.
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Limiting content to a few people

Alternatively, you can publish something in your personal container and select to
show it only to Specific People whom you designate before you publish. In that
case, only you and those other people can see the content and only those people
can see it as a content update in their streams.

Limiting content to multiple places

You can also publish in one place and share it with other places. As long as people
have access to view the original content, they are also able to access it from the
place you share it with. They can find it in the Content tab for that place.

Limiting discussions and questions to a few people

Similar to other content types, you can publish discussions and questions so that
only a few people can see them. For more information, see Creating direct messages
and private discussions on page 136.

Saving a document or blog post as a draft

Another handy feature is Save As Draft which allows you to share a draft of a docu-
ment or blog post with other users before you publish it. This is helpful for working
together on a document or blog post before you publish it for a larger audience.
Drafts are not visible in any streams. For more information, see Saving drafts on
page 78.

Differences between documents, blog posts, and
discussions
Documents, blog posts, questions, and discussions have different purposes and
rewards. Here you find suggests ways to think about these content types.

Documents

Collaborate with others on a single document; capture
information that should be available for a while; create a report,

Purpose

agenda, or meeting notes. For more information, see Using
documents on page 84.

Most of the content is in the document itself; comments by
readers and authors are appended.

Format

Somewhat formal, often in the third person.Style

Whenever the document is edited (and Minor Update is not
selected), and whenever comments are added.

Stream updates

Blog posts

Express a point of view; call something to the attention of other
users; make a proposal to get feedback from others; ponder
an idea. For more information, see Using blogs on page 97.

Purpose
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Most of the content is usually in the initial post, with reader
comments appended.

Format

Informal, usually in the first person.Style

Whenever comments are added. Edits to a blog don't tr igger
an update.

Stream updates

Discussions

Make a short observation or assertion to get feedback; report
a problem. For more information, see Using discussions and
questions on page 81.

Purpose

Most of the content is in the form of replies to the initial
assertion.

Format

Informal, usually in the first person.Style

Whenever replies are added, and whenever a reply is marked
as Correct or Helpful.

Stream updates

Status update tips and tricks
Status updates let you interact with others in the community. You can also delete
your own updates, see who liked them, see other people's updates, and several
other activities.

Comment on, share, follow, or repost a status update by
clicking any of these commands in the footer of yours or
other user's update.

Interacting with others
from status updates

Share your update with only a specific group by clicking
Change beneath the status box, and then selecting the

Limiting your status
update to specific
groups group before you post. When you post a status update to

a group, only members and followers of that group can
see the update in their attention streams. If the Activity
page of the group includes Recent Activity tile, the status
update is displayed there as well.

Delete your own update by going to your Inbox and
clicking on the time stamp in the update (for example,

Deleting your status
update

"posted 2 hours ago"). From the permalink page, click
Delete.

Alternatively, you can delete an update by going to your
user profile and clicking Activity > Status Updates .
From there, click the update's time stamp, and then
Delete.

Click the number next to Like in your status update to see
the people who liked it.

Seeing who liked your
status update

Inser t one or more tags in your update by preceding
keywords with a hash or pound sign (#) so that you and

Using tags in your
status updates
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others can find the update more easily later. For more
information, see Using tags on page 47.

Filter any of your attention streams by selecting Filter >
Status Updates .

Filtering by status
updates

Click a person's avatar or name from any of your attention
streams, or search for the person from the People finder

Seeing someone else
status updates

or Spotlight search. Click on the person's name to go to
their profile page, and then click Activity > Status
Updates .

Categories of content
Content categories associate content with keywords for easier searching later.

Content categories are words or phrases predefined by administrators within a
particular place, such as a space or social group. If there are categories available
in the place, it usually means that the place administrator has given thought to how
that place content should be grouped. An administrator who creates a category can
optionally associate cer tain tags with it.

Note:  Content categories are used only inside a single place and are different from
the place categories that are used to tag and find groups, spaces, and projects.

Applying categories

To apply a category to a content item:

1. Open the content item for editing and scroll to the bottom.

Under Categories, you can see the list of categories that have been defined for
the place of the content item.

2. Select the categories in which your content item seems to belong.

3. Click Publish to publish the content item and assign the selected categories.

Creating polls
You can use polls to get instant feedback on a question. A poll is a fast way to ask
a multiple-choice question in the community.

When you create a poll, you define the question and the possible answers. For ex-
ample, you could create a poll asking the community if your team should change a
workflow process. A poll appears on the home page of the place in which it is created.
As people respond to the poll, results are displayed graphically as colored bars. A
person can vote only once in the poll.
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To create a poll:

1. Click  > Poll .

2. In Poll Title, enter a title for your poll.

The title appears above the list of options in the published poll, so you should
use it as the poll question. For example, "Where should we have the holiday
party?"

3. Add a description to provide more information about the poll.

The description is displayed below the title, and above the options or the results,
depending on whether the poll is completed.

4. In Choice 1 and Choice 2, enter answer options.

For example, choices for the holiday party poll might be, "In the office," "In a
restaurant," "At someone's house," and so on. You can also add choices.

5. If required, add more choices by clicking Add a Choice and filling in a description
for each choice.

6. Select where you want to publish the poll. To get wider par ticipation, publish your
poll to the entire community and then share it with people and groups who might
be interested.

7. Under Tags, add tags to the poll for it to appear in searches.

8. If your poll will be published in a space, optionally select the categories to which
this poll belongs.

9. To change the publish and end dates of the poll, do the following:

a. Under Advanced Options, select Change voting options.

b. Set the dates when you want to publish the poll (immediately or a specific date)
and when you want voting to end (on a specific date, in a specified amount of
days, or manually).

The created poll appears in the place you have chosen.

10.Click Create.

Events
Events allow you to schedule, discover, and RSVP to events from your Jive
community or privately manage your own schedule. Events can be created in spaces,
groups, projects, or your own personal container, like other content types.

For more information about events, see the Jive Events Help.
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Creating documents for yourself
You can create a Hidden document to keep it private. Later, you can change the
visibility to include other people if you need to.

If you don't want others to see your content, you can keep private documents, events,
tasks, bookmarks, ideas, and uploaded files. You can either publish items as hidden
or save as draft to ensure no one else can see it. For more information on which
content types can be hidden, limited to specific people, or public, see Content visi-
bility options on page 134.

To create a document that is visible only to you:

1. Click  > Document  or another content type.

2. When you finish editing, under Publish Location, select Hidden before you
publish or save as a draft.

Similarly to documents, you can create other private content items.

To see your hidden content:

• Go to Your Avatar > Your Content  in the main navigation menu, and then click
Authored in the left sidebar.

From there, you can edit your content items and keep them hidden, or you could
make it visible to other users by changing the visibility options before publishing.
You can also filter content by type.

Saving drafts
You can use the Save As Draft feature to quickly jot down and save your thoughts
in documents or blog posts. Then, you can come back later to edit and publish your
content. You can also collaborate with others on saved drafts before publishing
them.

You can save blog posts and documents as drafts. This can be useful if you need
time to finalize your thoughts before publishing something. Additionally, drafts are
not visible in any streams.

Creating and editing drafts

To save a blog post or a document as a draft:

1. Create and fill in a document or blog post.

2. Click Save Draft.

The document is saved as a draft and is not visible to anyone. You can find it on
the Drafts tab of Your Content.
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To edit a draft:

1. Go to Your Avatar > Your Content  in the main navigation menu, and then click
Drafts in the left sidebar to see your drafts.

2. If required, filter your Drafts results by documents or blog posts.

3. Click on the draft to edit the content.

4. Click Publish to save and publish the draft.

You can edit the content and save it again as a draft, or publish it.

Collaborating on drafts

You can collaborate on drafts of blog posts or documents before you publish them
or share an existing draft with other users.

To get people to collaborate on an existing draft:

1. Open the draft.

2. Click Share in the upper right corner of the page.

3. In the Share dialog box, select the people you want to share the post with and
include a message for them.

4. Click Share.

The recipients are able to edit the draft and either save it as a draft or publish it.

Using user profiles
Use your profile to express who you are to your community. If you have something
you want the community to know about you, add it to one of the cards that can be
found here.

Your profile also shows everyone what you've been working on, who you're connected
to, the recognition you've been getting, and the groups you've most recently visited.

Setting up your profile
Setting up your profile is the first step to par ticipating in the community.

Your user profile provides community members with an easy way to learn about
your skills and interests. Your profile shows up in search results when community
members search for keywords contained in your profile. You can update your infor-
mation at any time.

To set up your profile:

1. Go to Your Avatar > Edit profile  in the upper right corner.

2. On the Profile Details tab, fill in as much profile information as you like.

Note that your profile can found when people search, so if you have professional
roles or interests that would be useful for others to know about, you should include
them. You may not be able to edit cer tain fields, such as username. Usually, the
community manager sets up these fields for you.

3. Click Save to save the settings.
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4. On the Privacy tab, edit your privacy settings.

These control how different types of users see your profile. For more information
on privacy settings, see Setting up content visibility options on page 80.

5. Click Save to save the settings.

6. On the Avatar & Photos tab, change your avatar and manage your photos.

Your avatar and other photos let people see and recognize you in person. Your
avatar lets community members quickly associate your comments and status
updates with a simple visual cue.

7. Click Finished to return to viewing your details.

Adding and endorsing skills
You feature skills on your profile by adding them, and you endorse other user's
skills by going to their profiles.

Skills not only provide more information about others in your community, but they
also tag people with those skills, so when you search the community for users, you
can filter by skills.

To add skills to your own profile:

1. Go to Your Avatar > View Profile  to view your profile.

2. Under Skills and Expertise, click New skill and type your skills.

Select a tag, or create a new one — just type a word or phrase and press Enter
to turn it into a tag.

3. Click Add to save your skills.

To endorse the skills of another user:

1. Go to their profile.

2. Under Skills, click Endorse and type their skills.

3. Click Endorse to save the skills.

Community users need to accept new endorsements via an Inbox notification before
they show up in their profile. You can see new skill aler ts in your activity once
community users approve endorsements. To back up an existing endorsement, click
the plus sign next to the skill listed in their Skills card.

Setting up content visibility options
If you're concerned about privacy, you can limit who sees different par ts of your
profile by editing your privacy settings.

To limit profile visibility:

1. Go to Your avatar > Edit Profile .

2. Go to the Privacy tab.
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3. For each profile field, select who can view it.

If you select everyone, then all users can see the contents of that field. Your
community administrator may control who sees cer tain fields, such as those
without a Visible to option.

4. Take a look at how others can see your profile by using the Preview your profile
tool in the upper right corner of the page.

5. Click Save to save the changes.

Using discussions and questions
Use questions and discussions to ask questions or introduce new ideas to the
community.

Discussions are a quick way to get an answer to a question or feedback on an idea.
You can attach a file or inser t an image, video, or code example into a discussion
to better explain your question or idea.

A questions or a discussion?

Here's the difference between these two content types:

A discussion can help you get feedback on your latest idea or
assertion, for example, "The Accounting team needs feedback on the

Discussions

new expense reporting process" or "To fix or not to fix the old copier
on the third floor..." These kinds of open-ended questions or ideas
can encourage a good discussion in the comments. You or other users
can mark any of the replies as the Decision, a Success, or for Action.
For more information, see Using Marking feature on page 106.

A question can help you get a quick answer to a burning question, for
example, "Have you seen my red stapler?" or "How many pieces of

Questions

flair are required on our uniforms?" Anyone can jump right in to answer
your question in the comments. To post a question, you mark a newly
created discussion as question.

Creating questions and discussions

• To star t a new discussion, click  > Discussion .

Note: You may not see this option depending on how your community is set up.

• To convert a discussion to a question, select the Mark this discussion as a
question check box while editing the discussions.

If you don't initially mark the discussion as a question, you'll have 15 minutes to
change your mind after you post (the default is 15 minutes; your community ad-
ministrator may change that setting). Within that time, you'll see a link to change
your mind in the discussion post.
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For either a question or discussion, you can attach a file or inser t an image, video,
or code example to explain your question or idea to the community better.

Later, if you want to transform a question or discussion into a document, you can
save it as a document. For more information, see Converting discussion threads to
documents on page 150.

Tips and tricks

• If you want to keep track of unanswered questions in a place, use the Unanswered
Questions tile on the place's Activity page. For more information, see Adding tiles
to Activity page on page 174.

• If someone replies to your question or discussion with useful information, it's good
practice to mark their reply as either Helpful (discussions and questions) or Correct
(questions only). That way, others who have the same question or thought can
quickly see which replies are the most useful. A Helpful reply is on the right track,
while a Correct reply answered the question. Correct and Helpful answers earn
status points for their creators. Note that only system administrators, place owners,
and question authors can see the Correct Answer option. For more information
about status points, see Earning status points on page 71.

• Tag discussions and questions, so that others can search for and benefit from
them later.

• You can set discussion replies and content comments to be displayed all on one
level (flat) or indented hierarchically (threaded). For more information, see Flat
and threaded views in discussions and questions on page 82.

Choosing where to publish discussions and questions

When you're ready to post the question or discussion, you need to decide how and
where to make it visible. Carefully choosing a space or social group makes the
question or discussion more visible to people who follow the place where you publish
it. For example, publishing a question about technical support in the IT group can
ensure the question is displayed in a stream for users who follow or belong to that
group.

Your discussion or question also inherits the permissions of the place where you
publish it. Therefore, publishing in a members-only group limits par ticipation to
people who are members of the group. If you want community users to be able to
search for and stumble across your question, don't publish it in a private group.

On the other hand, if you need a question or discussion to be confidential, you could
publish in a private group. You can also choose to publish your question or discussion
only to specific people.

Flat and threaded views in discussions and questions
You can set discussion replies and content comments to be displayed all on one
level (flat) or indented hierarchically (threaded).

Note:  Replies to questions are shown in a unique order: the Correct Answer is
always shown at the top, followed by replies with the most Helpful marks.
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Discussion views

The flat and threaded views look like this.

In flat view, you can see comments and replies chronologically in the order
they were received, and there is no indentation between responses. This view

Flat
view

can be helpful if you like to see comments in the order they were made.
However, it can become difficult to follow conversations between people when
a discussion is longer than a few comments.

In a threaded view, you can see which post a person is responding to because
comments and replies appear indented beneath the post to indicate embedded

Threaded
view

replies or comments. This can help you follow conversations because responses
remain associated together visually.
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Setting up discussion view

To set up your view style preferences:

1. Go to Your Avatar > Preferences  in the upper right corner.

2. On the General Preferences tab, select your Discussion View Style and
Comment View Style.

3. Click Save to save and apply the changes.

Using documents
Jive is a powerful tool for creating and uploading documents, collaborating on them
with others, and managing versions.

You can create documents in Jive or upload documents from outside of Jive, such
as Microsoft Office documents or Adobe PDFs. Documents can be available for
viewing or editing only by you, a group of people you designate, or the entire com-
munity. For more information about uploading external files to the community, see
Uploading files to Jive on page 85.
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You can also view and manage the changes between versions of a document, in-
cluding restoring a previous version so that it is the current version.

• To create a document, click  > Document  and star t writing.

Choosing where to publish a document

When you're ready to save the document, you can decide how and where to make
it visible.

Choosing a place, such as a space or social group, makes the document more visible
to group members who follow the place where you publish it. For example, publishing
your schedule document in the Sales Kickoff Planning group highlights your planning
for anyone who's following that group in a stream.

Your document also inherits the permissions of the place where you publish it.
Publishing in a private group, for example, limits the viewers of your document to
the people who are members of the group. If you want community users to be able
to search for and stumble across your document, don't publish it in a private group.
On the other hand, if you need a document to be confidential, a private group could
be the right place.

Controlling who edits documents

Even when you publish your document in a public place, you can still control who
can edit it. After you add the text for your document, scroll down the page and use
the Collaboration Options to set the editing and commenting permissions. You can
also specify that another user must approve the document before it is published.
For more information, see Document approval on page 148.

If you want to be the only one who can see your document, select Hidden. You can
add more people as viewers or collaborators later if you change your mind.

Managing versions

When a document has been edited and published multiple times, you can view and
manage the differences between versions and delete specific versions, or restore
a previous version so that it is the current version.

To manage a document's versions,

• Click Version to view a particular version, compare changes between versions,
or restore a par ticular version.

• Click Manage versions  to view the version history, restore a version to be the
current version, or delete a version.

Uploading files to Jive
You can upload a variety of files to the community to collaborate on them with others.

Depending on how your community manager has set up your community, you can
upload a variety of external file types such as Microsoft Word documents and Adobe
PDFs. After you have uploaded a Microsoft Word, Excel, PowerPoint or PDF external
file, you can view and navigate through a preview view of its pages.
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Note:  If you have Jive for Office, you can manage and sync the document with the
community while working within Office (Windows only). For more information about
this, see Working with shared office documents on page 88.

Uploading a file is a great way to include an externally-authored document or track
its progress. For example, you can upload a Word document, then add collaborators
so that it gets reviewed in Jive by other team members.

Uploading a single file

To upload an external file to Jive:

• Click  > Files , then click to select the file you want or drag and drop it into
the interface.

If your community manager has enabled the antivirus feature, there may be a slight
delay while the file is being scanned for viruses. For more on where to publish, and
controlling who edits, see Using documents on page 84.

Uploading multiple files

You can use the same procedure to upload up to 50 files simultaneously. (Some
communities may have a different setting). Files are named automatically based on
their original filenames. However, you can edit the names afterward for greater
clarity.

You don't need to worry about filling the activity stream with notifications or sending
multiple email notifications when you upload more than one file. The notifications
are bundled together into a single notification. If there are only a few, you can see
previews of the files in the stream.

Note: The Multiple File Upload feature does not work on Internet Explorer 9. You
can only upload a single file at one go. To avoid this issue, it is recommended to
use the latest version of Internet Explorer or another supported browser. For more
information, see Supported browsers on page 13.

Reserving files and documents
Marking an uploaded file or a document as Reserved indicates that someone is
currently editing it so that other users shouldn't edit it until the Reserved badge is
removed. It does not actually lock the file or document.

The Reserved badge provides important information about file status for anyone
who can't use Jive for Office to edit and merge uploaded files, for example, Mac
users. It can also be used to warn users of a published Jive native document that's
not ready to be edited by other people yet. The Reserved badge doesn't prevent
anyone else from editing, but it shows information about who is working with the
item, making it easy for other people to check in with you before adding their own
edits. Note that if you want to hide an in-progress Jive document before publishing
it, you can just save it as a draft and share it with anyone you want to.
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When an author or editor marks a file as Reserved, anyone can see who reserved
the file and contact the person if they're unsure whether it's OK to proceed with
editing. Anyone with the rights to edit a file or document also has rights to mark it
as Reserved. When someone reserves a file, the author and anyone who has already
edited the document receive an Inbox notification. You can filter content to find re-
served documents, too.

Differences in reserving Jive documents and uploaded files

Jive already provide an indicator when someone has star ted editing
a document. (However, note that the lock on the document while

Jive native
documents

someone is editing only lasts ten minutes, and after that, it's possible
to edit the document and overwrite another user's changes.) Mark
as Reserved replaces the need to put "WIP" or another indicator in
the title when a document isn't in a state where you'd like other users
to contribute. It shows an author or editor's intention to keep working
on the document undisturbed until the next time that the author
publishes it.

Mark as Reserved warns users who don't use Jive for Office that
publishing a new version could overwrite and invalidate a version

Uploaded
documents

someone is working on locally. (Windows users with Jive for Office
have live merge capability and may not need this feature as much.)
Marking a file as Reserved does not lock the document or prevent
uploading another version. But any other user who clicks Edit with
the intention of uploading a new file can see a message pointing out
that the file is currently reserved for editing.

Marking as Reserved
You can reserve a document or file to aler t other users you're working on it. This
doesn't lock the document, but it aler ts other users that you are planning to update
the item.

Reserving documents is especially useful if you're using uploaded files, but can't
use the Jive for Office. The Reserved badge doesn't prevent anyone else from
editing, but it shows information about who is working with the item, making it easy
for other people to check in with you before adding their own edits. For more infor-
mation, see Reserving files and documents on page 86.

To mark a file as Reserved and remove to remove the marking:

1. Go to the document or file you want to reserve.

2. To mark the content item, click Mark as Reserved  on the right sidebar.

The Reserved badge is added at the top of the document.

3. To free the file for editing, use any of the following:

• Click Unmark next to the Reserved label on the document or file page.
• Publish the item. When you or anyone else publishes a new version, the

Reserved badge is removed.
• Mark it as Final, Official, or Outdated. These markings override Reserved, and

the reserved badge is removed.
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Working with shared office documents
With Jive for Office, you can share your Office documents with others in your online
community.  As you make changes to a shared document on your

computer, Jive for Office synchronizes the document with the version
that's visible in the community and provides real-time notifications to
users working in the same document.The notifications tell users that

content has changed and give them the option to incorporate the changes into their
version using a merge tool. This keeps the content on the community up to date but
also synchronizes comments, tags, and collaboration settings between the community
and your document.

This feature is supported for Microsoft Office running on Windows. For more infor-
mation about supported Office versions, see the Jive for Office Guide or the Jive
for Office 365 Guide.

If you have the appropriate permissions, you can edit everything but the content of
a shared document in the community. In the community, you can edit descriptions,
tags, and categories, and you can use an Office program to edit the document
content.

What you can do

With Jive for Office, you can upload Microsoft Office documents to your community,
then keep changes to the document in sync while you work in Office.

In par ticular, with Jive for Office you can:

• Upload Office documents to your community without leaving Microsoft Office.
When you upload a document, the community displays a preview of the document.
However, the document must still be edited by using Microsoft Office.

• Use Jive in the Office toolbar ribbon to:

• Change collaboration options to indicate who can edit the document in the
community.

• Create a document for your community.

• View the currently published version of your local document in your community.

• Share your document with others.

• Check for updates to the document.

• Use the Dashboard to:

• See who else is editing the document.

• See how many people viewed the document, who created it, and who’s
contributed to it.

• View, add, delete, and reply to comments.

• View and add tags to help categorize the document in the community.

• Edit the document's description.
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• View older versions of the document.

• Rate the document and see how others rate it.

• Browse files similar to the open file.

• Take a look at more files created by the author.

Getting Jive for Office add-on
You need the Jive for Office add-on to share documents between Office
applications and your community, which requires Microsoft Windows.If

you don't have the add-in, you can get it when you're viewing an uploaded Office
document in the community.

To get the Jive for Office add-in:

1. In your community, go to an Office document.

2. To the right of your document, click the Download Jive Connects for Microsoft
Office link as shown in the following image.
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Getting connected to your community
After you first install Jive for Office, it might not be completely set up to connect to
the community you want to synchronize documents with. To connect, you need to
provide your user name and password.

To get connected to your community:

1. In the Jive menu, click Accounts.

2. Click Add to add your Jive account.

3. Enter the Community URL, which is the exact URL that you use to navigate and
login to your community.

4. Enter your Jive user name and password.

Now that you connected to your community, you can add documents to the commu-
nity. For more information, see Adding documents to community on page 90.

Adding documents to community
To have an Office document appear in the community, you can either add it using
Jive Connects for Microsoft Office or upload the document from inside the community.

Adding documents from the Microsoft Office side

To add a document using Jive Connects for Microsoft Office:

1. Connect to the community. For more information, see Getting connected to your
community on page 90.

2. Open or create a document in Microsoft Office.

3. Click Jive > Publish New  as shown in the following image.

Note:  Once the document is added to the community, clicking Publish Update
uploads your changes to the community.
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4. In the dialog box, navigate to the place in the community where you want to save
the document.

5. In the Document Name box, enter the name at the bottom of the dialog box.

You can also add tags to help other users find your document in the community;
provide an optional description; and decide who can edit your document. Also,
you can change the local file location for your document by editing the Store At
path.

Note: You don’t need to save your document or changes to your document locally
before publishing to Jive.

6. Click Save.

7.

You can synchronize the uploaded documents with the rest of the community. For
more information, see Keeping documents synchronized on page 93.

Attention: When you add an Excel spreadsheet to a community, Jive for Office
adds a hidden spreadsheet that contains a copy of the original spreadsheet with
additional metadata. This copy is used to track changes and allow collaborative
working on the spreadsheet.
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Once the document is added to the community, you can click Jive > Dashboard
to display a panel of information about the document, such as comments, ratings,
and the current version number. The following image shows the Dashboard.
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Adding documents from the community side

To add a document from inside the community:

1. From your community, click  (Create) > Document .

2. Select Upload a File.

3. Select the location for your document.

4. Click Choose File.

5. Select the file from your desktop.

6. Click Publish.

Depending on the size of your document, it might take a few seconds to upload it.

Create a new document from an existing one

To avoid a few steps, you can just upload an existing document and rename it as
a new document to star t fresh within the community. This creates a newly uploaded
document in the community, leaving the previously uploaded document in the com-
munity as it was when you last synchronized. The new document will have the content
of the previous one, but won't have its other properties, such as comments, collab-
oration settings, tags, and so on.

Note:  Making a new document in this way leaves you with an Office document that
has the same content, but without all of the community-related information. To get
the previous Office document with that information, go to that document's page in
your community and click the Download link beneath its preview.

To create a new document from an existing uploaded document:

1. In Office, open the document you want to star t from.

2. Select Jive > Publish As .

3. In the dialog box, navigate to the place in the community where you want to save
the document.

4. In the Document Name box, enter the new name at the bottom of the dialog box.

5. Click Publish.

Keeping documents synchronized
After you've connected your community to Office, Jive Connects for Microsoft Office
keeps your documents synchronized with the community.

Jive for Office does the following:

• Updates the document preview in the community when you save changes to the
document's content.

• Updates the Office document comments list with comments made in the community.
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• Lets you see updates from others in your community and review them before
using them.

• Keeps changes to community-related document properties in sync between the
Office application and the community. When a change is made in one place, it
shows up in the other. You can see the following properties in the Dashboard:

• Tags

• Categories

• The document's title

• The document's description

• Revision activity

• Document's state

To get document updates from the community:

1. When your document has been updated by someone in the community, you get
a real-time pop-up notification. Alternatively, you can also click Check for
Updates.

2. If there are no changes, a message tells you so. Otherwise, you can select how
you want to deal with the changes:

• Replace my version to accept the newer version, overwriting your own local
changes. (You can also Overwrite Local Version from the Jive toolbar at any
time if you want to discard your local work and star t over with the published
version.)

• Merge and Review to review which changes you want to use.

• Ignore to continue working without accepting or rejecting changes at this time.

3. When you're done working, save your changes so others in the community can
see your recent changes.

4. If at any time you want to overwrite the current local document with the version
on the community, click Check for Updates > Overwrite local version  in the
Jive toolbar.
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Working with document versions
As you work on a document in Office, Jive Connects for Microsoft Office
keeps track of changes, including community-related information such
as comments.It can sync your changes with what's going on in the

community with the click of a button. You can even view the changes that have been
made since previous versions of the document while in Office. You can also save
a previous version as the current one.

The version management feature does its work in par t by using the change tracking
feature built into Office. That means that if you download a document that someone
has made changes to, you might see revision marks placed there by the change
tracking feature. The document is fine, but the revision marks can make it hard to
read. You can hide the marks in the following ways:

• In Word 2007 or 2010, select the Review tab. In the Tracking group, select Final
in the Display for Review menu to hide the changes.

• In Word 2003, locate the Reviewing toolbar. In the Display for Review menu,
select Final.

Work with document revisions

Jive Connects for Microsoft Office creates a new version of a document whenever
you save changes to the document.

To view previous versions of a document:

1. Open a community document. You can see the dashboard on the right. If you
don’t, select Jive in the toolbar and click Dashboard.

2. Under Versions, if the version you want to see isn't visible, scroll down to display
it. Previous versions are listed with the date and time when they were saved. If
you hover over a version, you can see the name of the person who published that
version.

3. From the list of versions, click the one you want to view.

Note: You can't save a previous version as the current one. To recover a previous
version, open that version and publish it under a new name.

Work with document activity

Jive Connects for Microsoft Office displays a list of activity related to the document.
This activity includes versions saved and comments added. By clicking cer tain items
in the activity list, you can add information to it. For example, you can view and add
comments from the Comments tab.

To view document activity:

1. In Office, click Jive and then click Dashboard.

95AUREA CONFIDENTIAL

Using content



In the Overview panel, you can see details about the document, such as when
it was last edited and what version you're looking at.

2. Click the arrows next to tags, categories or description to add or edit this
information and have it shows up in the community.

3. In the Comments tab, click Reply to add a comment to the open document. These
comments show up in the community as comments. For more information, see
Adding comments on page 96.

4. You can also browse other documents that the author has created or documents
similar to the open document.

Adding comments
When you comment on a document in Office or the community (as
opposed to adding inline comments in the body of a document), your
comments are synchronized and appear in both places. When you add

inline comments in either location, these comments are visible where they are
created, but are not synchronized or visible from the other location.

There are two kinds of comments for shared Office documents:

• Document comments are like those people make elsewhere in the community.
People can usually comment on shared documents just as they comment on other
kinds of documents. These are added in the community or in Office. You can see
these in Office when you go to Jive > Dashboard  and then click the Comments
tab.

• Inline comments appear in the document itself. An inline comment is a way to
add a comment to a par ticular par t of the document. When you add an inline
comment in the community, it shows up in the community on the Inline Comments
tab at the bottom of the document, as well as in the document preview, but is not
visible in Office. Inline comments you create in Office can be seen in the Review
tab when you select Final Showing Markup in the Tracking group, but cannot
be seen in the Jive community.

To add a document comment:

1. In Office, go to Jive > Dashboard , and then click the Comments tab.

2. Type your comment.

3. Click Add.

4. You can also click Reply to reply to an existing comment or Delete to delete an
existing comment.
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Adding collaborators
You can add collaborators to work on your Office documents.

By default, when you use for Office to add a document to your community, the doc-
ument's collaboration options are set as follows:

• Only you can edit the document when you save to your personal container.

• Anyone can edit it when you save it to an open place.

You can change these defaults to fit the document needs.

To change collaboration options:

1. On the Jive toolbar, click the Collaboration button.

2. In the dialog box, select the option to set who can edit:

• Specific people: Only the people whose names you choose can make changes.
If you select this, begin typing the person's name in the box beneath Specific
people. When their full name appears, click it to add it to the list.

• Just you: Only you can make changes to the document's content.

• Anyone: Anyone in the community can make changes.

3. Click Update.

Using blogs
Use blog posts to express ideas or opinions and get community feedback. If you've
got something to say, you can write it in a blog.

• Use your blog to express opinions, call attention to noteworthy items you've seen
(such as an ar ticle on the Internet), or make proposals.

• Because other people can comment on your blog posts, they are a great way to
pitch ideas that could impact the team or the organization. Of course, you can
comment on other people's blog posts, too.

• Your community might include several blogs, for example, "Bill's Blog" (with posts
from Bill) or "The Human Resources Blog" (with posts from people in the HR
department). Your administrator can also create personal blogs and associates
them with par ticular people or teams.

• If you want to see some of the blogs in your community, go to Your Avatar >
Your Content , select All on the left, and then click Blog Posts.

You can see the latest blog posts from around the community.
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Adding blog posts

To star t a new blog post:

• Click  > Blog post  and write a post.

If you haven't created a blog before, you get a choice between setting up your own
personal blog and posting in a blog belonging to a par ticular place. Place blogs
typically relate to the subject matter of a group or space.

After you've written some content and decided where to publish it, you can also
decide whether to publish it r ight away by clicking Publish, or whether to schedule
it for a later date. Select Schedule when this post gets published and then select
the time and date you want.

Managing blogs
When you manage your blog or your place blog, you can create new posts, view
and post comments, import content from an external blog into your Jive blog,
subscribe to your blog's comments, and set other options.

To manage your blog:

1. Go to your avatar > View Profile.

2. Click Content and click on your blog's name to go to your blog's home page.

Note: You may not see your blog if you haven't created any blog posts.

3. Click Manage in the Actions list on the right.

If you are a place owner, you can manage your place's blog, too. From your place's
landing page, go to the Manage > Blog .

Designing blog posts
You can choose to arrest visual elements for your blog post, including images and
an enlarged initial capital.

Some blogs are more word-focused and others are more image-packed. However,
you can use the following information and best practices to help make your blog
posts look good:

• Include a banner image at the top. If you choose a wide image, you can select
which part is displayed by using the Background Position controls while you're
selecting the image. The image scales to the size of the browser or screen and
fills the banner area, so you can see some variation in how the banner is
presented. An image 1200 x 500 pixels typically works well.

• If you want to use a decorative initial capital, select Enlarge the first letter in
the blog post.

• Change the size of inline images by using drag and drop. To return an image to
its original size or change its alignment in relation to the text, click the image and
then the image icon.
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Importing content into blogs
If you have content from another blog that you want to bring into your Jive blog, you
can import it. Jive supports blogs in the Movable Type format.

If you've got a blog in Jive, you can import content from your other blogs. You need
to first export content from those blogs into the Movable Type import format. Some
blogging tools support this option.

If you export content from WordPress, you might need to do a little editing of the
exported content before you import it. When your WordPress blog posts include
HTML tags, the file exported from WordPress omits tags that are needed to tell Jive
that the HTML is there. You need to enclose the content in <body> tags before im-
porting. Here is an example:

This is my <b>BOLD</b> HTML example.Before

<body>This is my <b>BOLD</b> HTML example.</body>After

To import content into your own Jive blog:

1. Go to your avatar > View Profile  to view your profile.

2. Click Content .

3. Under Your Blog, click your blog name.

Note: You won't see your blog here until you have published at least one blog
post.

4. Under Actions, click Manage  to open the blog management page.

5. Under Manage, click Import .

6. Click Browse .

7. Find and select your file, and then click Open .

8. Click Upload File .

Creating custom blog stream
You can use these steps to quickly create a custom stream for all your favorite
community blogs.

Before you star t adding blogs to a stream, you need to create your own custom
stream, as described in Creating custom streams on page 22. It can be something
like Awesome Blogs. Save the stream, but don't add anything to it yet.

To create a blog stream:

1. Navigate to a community blog you like. Go to Content > All > Blog Posts .

2. When you find a post from a blog you like, click on it, then click the name of the
blog post.

This opens the home page of the blog.

3. Click Follow, and select the blog you want to follow.
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Every time the blog which you follow is updated or commented on, you can see a
stream update and get an email (if you enabled email notification).

If you get too many emails, you can turn off email notifications:

1. Go to your avatar > Preferences .

2. Clear Email for the blogs where you don't want to receive notifications by email.

This option may be not unavailable in your community. For more information, see
Customizing notifications on page 30.

Tweeting into Jive
You can tweet from Twitter into your Jive community by using a special hashtag.

If your community administrator has enabled Jive Twitter functionality, you can have
your tweets show up in your Jive community by using a special #hashtag in your
tweets.

For yourself, you enable this by clicking on your avatar in the upper right corner
and selecting Preferences. On the Twitter Preferences tab, select Enable.

You then should sign in at Twitter and allow it to access your Jive community. If
your community's special hashtag is not listed on your Twitter Preferences page,
you'll need to ask your community administrator for it.

Using visual media
You can make your Jive content more engaging by using images and videos. You
can also apply these forms of visual media to your Jive place.

Images in Jive
Jive places can be more engaging with sharing and saving sets of images through
collections.

You can embed an image into your content by using the content editor or upload
an image as a file. If you are a place owner, you can use images in tiles or widgets
to create place pages. For more information, see Using content editor on page 68,
Uploading files to Jive on page 85, and Designing activity and custom pages for
places on page 172.

Videos in Jive
Bring your Jive content to life by adding videos to your community that you can use
in comments, replies, or content items.

If your community has the Video Module and Video Upload enabled, you can upload,
record, or embed a video. You can do all of this within content, in comments or
replies, or from the pencil icon. Videos that are uploaded by using the pencil icon
are known as video objects or top-level videos. You can also choose a video in your
community to add to content, comments, or replies.

With only the Video Module enabled, you can only embed a video from a website.
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Publishing videos
You can insert a video in a comment, add it to content, or create one using the
pencil icon to publish a video in the community.

Requirements for recording video

• Webcam must be allowed to record video

• The Adobe Flash plugin must be enabled in your browser

• Video recording must be enabled for your community

Adding videos to comments or content
You can add a new or existing video to a content item or a comment or reply in your
community.

To add a video in comments or content:

1. In the toolbar of the content editor, click .

The Publish a Video page opens.

2. To add a new video that you upload, record, or embed yourself, select Upload,
Record, or Embed, and then do one the following:

a) To upload, select Upload a Video, click Browse, select your video, and then
click Open > Insert video .

b) To record a video with your webcam, select Record Via Webcam. You may
need to give Flash permission to access your webcam and microphone. Then
record a video and click Upload.

c) To embed a video from another site, select Embed a Video, enter the URL in
the field provided, then click Import video. When you see the video, click Insert
Video.

3. To use a video already in your community, select Browse community Videos,
then select the video and click Insert video.

4. Once you see your video, you can click Add comment, Publish, Create
Document, or Post.
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Adding top-level videos to community (with the Create menu)

Use the create menu, or , to add new top-level videos for your community.

To create a video using the pencil icon:

1. In your community, click  > Video .

The Create New Video page opens.

2. Select the video source you want to use as follows:

a) To upload, select Upload a Video, click Browse, select your video, and then
click Open > Insert video .

b) To record a video with your webcam, select Record Via Webcam. You may
need to give Flash permission to access your webcam and microphone. Then
record a video and click Upload.

c) To embed a video from another site, select Embed a Video, enter the URL in
the field provided, then click Import video. When you see the video, click Insert
Video.

3. When you see your video, add a title and description for the video.

4. Select a publish location and then add tags for the video.

5. Click Publish.

Downloading videos
You can download top-level videos that have been uploaded to the community as
long as you have permission to access them.

You can store community videos on your mobile device or computer for use when
you are not connected to the Internet. You can only download top-level videos (that

is, uploaded videos from  > Video > Upload a Video ).

To download top-level videos:

1. Go to the video content you want to download.

2. Click Actions > Download video .

3. In the Download Options dialog box, select the video quality to download the
video.

4. Close the Download Options dialog box to return the video page.

Featuring videos
If you featured a video in your place, the users see the featured video in the Featured
Content and Featured Video tiles and widgets on the place pages.

You need to be the place owner or administrator to feature the videos.

To feature a video in a place:

1. Go to the place.

2. Click Videos.
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3. Select either the video you want to feature or create a video under the Actions
menu to upload a new video.

4. Under Actions, click Feature this video.

5. If you no longer want a video to be featured, you can select Remove as featured
video.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

Supported video providers and formats
Jive supports embedded and uploaded videos in content, comments, replies, and
video objects.

Supported video providers

Uploaded video object (videos created from the pencil icon) sources:

• Perceptive Media for uploaded videos.

Embedded sources for both video object and inline in the body of other content
types:

• Any embed.ly supported source, such as YouTube or Vimeo. For their complete
list, see http://embed.ly/providers.

Custom support for the following sources:

• Brightcove - New Studio

• Kaltura Cloud

• Google Drive

Supported formats for uploaded videos

AVI, MOV, WMV, MP4, MPEG, FLV, 3GP, and 3G2Supported video container
type

All of the popular MPEG-4 variants like DivX, XviD,
H.264, 3IVX, MSMPEG4, and Windows Media 9

Supported video codecs

MP2, MP3, WAV, AAC (typically seen in QuickTime
files), Windows Media audio, and for mobile devices
AMR in both narrow-band and wide-band varieties

Supported audio codecs

Video FAQ
Use these frequently asked questions to help you better understand Jive videos.

When you insert a video into content, reply or comment by
clicking Browse Jive Videos, you can choose from all

Will I see all videos
when I browse Jive
videos? videos published to the entire community, shared with you,

or published to places you have access to, such as a private
group you belong to or a space you have permission to
view.

103AUREA CONFIDENTIAL

Using content

http://embed.ly/providers


Video permissions are consistent with content type
permissions. When you publish a video to a private place,

Can I mark videos as
private?

it is only available to members of that place. If you publish
a video to a select few users, only they are able to view
that video.

No. You only see videos here that you've uploaded

by using the create menu ( ). When you upload

Should Your avatar > Your
Content > Videos  show all of
the videos I've uploaded?

videos into content types, they do not show up in
Your Content except as part of that content type.

Yes, if your administrators allowed embedding videos
from the platform. Note that the URL of the embedded

Can I embed videos from
the Kaltura video
platform? video must include the kaltura.com par t in order to

pass validation for the Kaltura platform.

Copying content
You can copy a document as a new document, discussion, or blog post.

Restriction: You must be able to edit the document you want to copy.

Copying documents streamlines quite a few use cases, such as the following:

• Copy documents to different places if you want to push out a clean version and
empty comments. This is great for posting release communications to different
audiences, such as customers and partners.

• Use a document as a template that can then be used again and again to easily
recreate documents. This is useful for processes in a company, or templates with
agencies. For more information, see Creating templates on page 105.

• Work privately with your team and then push out a clean copy to a public place
or even as a blog post to the News stream.

• Use ghost blogging where the ghostwriter authors the initial version. The publishing
author does a copy-document on the initial version to publish it under their name.

To copy a content item:

1. Go to a document you can edit.

2. Click Actions > Create a Copy  to open the Create a Copy dialog box.

3. Select the content type for the copied item from the available types.

The available options may differ if the place where the original document is stored
does not support some of them, or you don't have permission to publish a par ticular
content type there.

4. Click Create a Copy to create a copy of the document.

5. Edit the new item.
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Note that the title, body, and tags have all been pulled in from the original
document. You can edit all of these, as well as change the place for the content
before publishing.

6. When you're finished editing, click Publish.

The new item is created based on the source item.

If you want to create a template from a document, see Creating templates on page
105.

Creating templates
You can use the Create a Copy feature to create templates for yourself or others
to use.

For example, you might want to create a baseline RFP for your salespeople to use
that they can edit and add to before publishing it as a new RFP.

Restriction: You must be able to edit the document you want to copy.

To create a template:

1. Go to a document you can edit.

2. Click Actions > Create a Copy  to open the Create a Copy dialog box.

3. Select the content type for the copied item from the available types.

The available options may differ if the place where the original document is stored
does not support some of them, or you don't have permission to publish a par ticular
content type there.

4. If you want to use the item as a template, copy the link provided under Create a
Template, and then click Cancel to close the dialog box.

You don't need to publish a copy of this document.

5. Paste the link anywhere in the community, for example, in the Helpful Links tile
in a place that you own.

When a user clicks the link, they are taken to the template (based on your original
document) that they can edit and publish. They can change the title, body text, tags,
and place of the new item; all of these are optional. If they make no changes at all,
the new content is published exactly like the original but with a number inside square
brackets in the title.
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Using Marking feature
You can turn a conversation into a real business decision or collaboration success
story.

Collaboration and discussion are free-form in your community, but decisions and
official versions should be marked clearly. The Marking feature allows you and
others to mark items for Action, as a Success, and so on. Visual badges for these
states let others know which document is Final, which comment became the Decision,
or who has Action items as a result of the discussion.

You and other users can mark the replies or comments of:

• Blog posts

• Discussions

• Documents

In addition, users with edit permissions on top-level items can mark the items as
Final, Official, Outdated, Success, or for Action.

Your community manager may limit this feature to specific users and configure which
marking options are available in your community.

How Marking adds value
Here's an example of how to effectively use the Marking feature in your community.

Let's say the VP of sales has just published a discussion called "Possible Hotels
for Sales Kickoff." In the post, she has included a list of hotels that are available,
their amenities, and the pros and cons of each. She ends her post by @mentioning
the Sales Kickoff group and inviting comments and opinions about the hotels. Over
the next few days, over fifty comments are posted to the discussion.

Here's what happens:

1. Two new hotels are suggested. Different thread participants mark those comments
for Action ( Actions > Mark for Action ) and ask the commenters to provide the
hotels' availability, amenities, and pros and cons. Those comments now have
Action Item badges on them. You can click the badge to see any notes included
with the action item.

2. The receptionist replies that she has dealt with Hotel ABC and highly recommends
it.

3. The two new hotels that were suggested are now included in the list, and those
actions have been resolved by their owners ( Action Item > Resolve ).

4. Based on the receptionist's and others' positive comments about Hotel ABC, the
VP of sales decides that it's the best hotel for the Sales Kickoff. She adds a final
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comment to the thread explaining her decision and then marks it as the Decision
( Actions > Mark as Decision ).

5. Now, the VP marks the entire discussion as Final to let future readers know that
the post has been discussed and decided on. At the top of the discussion, the
Final badge is now displayed.

Who can mark and unmark?
Different types of users have different permissions to mark and unmark items. The
following tables list who can do what for comments, replies, and top-level items, as
well as other rules of marking.

For comments and replies

Can Comm
Mgr globally

disable?

Mark depen-
dencies

Require-
ments / op-

tions

Who can un-
mark

Who can
mark

YesNoneNote is re-
quired

Original
marker, edi-
tor of top-
level item

All usersMark as Deci-
sion

YesUnmarking
moved to Re-
solved list

Note is re-
quired, share
is optional

Not availableAll usersMark for Ac-
tion

YesUnmarking
moved to Ac-
tion item

Note is re-
quired

Original
marker, ac-
tion partici-
pant

All usersMark as Re-
solve

YesNoneNote is re-
quired

Original
marker, edi-
tor of top-
level item

All usersMark as Suc-
cess

NoNoneNoneOriginal
marker, edi-
tor of top-
level item

All usersMark as
Helpful

YesNoneOnly avail-
able on dis-
cussions
with Mark
this discus-
sion as a
question se-
lected

Editor of top-
level item

Editor of top-
level item

Mark as Cor-
rect

Editors are users with permissions to edit the top-level content item. These users
can see the Edit option in the Actions menu of the right sidebar when viewing the
content item.
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For top-level items (blog posts, discussions, and documents)

Can Comm
Mgr globally

disable?

Mark depen-
dencies

Require-
ments / op-

tions

Who can un-
mark

Who can
mark

YesUnmarking
moved to Re-
solved list

Note is re-
quired, share
is optional

Not availableAll usersMark for Ac-
tion

YesUnmarking
moved to Ac-
tion item

Note is re-
quired

Original
marker, ac-
tion partici-
pant

Original
marker, ac-
tion partici-
pant

Mark as Re-
solve

YesNoneNote is op-
tional

Original
marker, edi-
tor of top-
level item

All usersMark as Suc-
cess

YesMutually ex-
clusive with
Official and
Outdated

NoneOriginal
marker, edi-
tor of top-
level item

All usersMark as Fi-
nal (discus-
sions and
documents
only)

YesMutually ex-
clusive with
Official and
Final

URL is op-
tional

Original
marker, edi-
tor of top-
level item

All usersMark as Out-
dated (dis-
cussions and
documents
only)

YesMutually ex-
clusive with
Final and
Outdated

NoneOriginal
marker, edi-
tor of top-
level item

All usersMark as Offi-
cial (discus-
sions and
documents
only)

YesNoneAvailable on
documents
only

Original
marker

All usersMark as Re-
served (docu-
ments only)

NoNoneAvailable on-
ly on discus-
sions
marked as
questions

Original
marker

All usersMark as I
have the
same ques-
tion (discus-
sions only)

NoNoneAvailable on-
ly on discus-
sions
marked as
questions

Editor of top-
level item

Editor of top-
level item

Mark as As-
sumed An-
swered (dis-
cussions on-
ly)

Editors are users with permissions to edit the top-level content item. These users
can see the Edit option in the Actions menu of the right sidebar when viewing the
content item.

108AUREA CONFIDENTIAL

Chapter 2: Using a Jive community



Searching for marked content
Marks are ranked differently in search results and have varying visibility options.
The following tables list the visibility and searching options of marks for comments,
replies, and top-level items.

For comments and replies

Can Comm
Mgr globally

disable?

Has a dedi-
cated tile?

Appears in
content,
people,
places

browse UIs?

Search
rankings in-

fluenced?

Appears in
Searched?

YesYesYesPositivelyYesMark as Deci-
sion

YesYesYesNoneYesMark for Ac-
tion

YesYesYesNoneYesMark as Re-
solve

YesNoYesPositivelyYesMark as Suc-
cess

NoNoYesNoneNoMark as
Helpful

YesYesYesNoneNoMark as Cor-
rect

For top-level items (blog posts, discussions, and documents)

Can Comm
Mgr globally

disable?

Has a dedi-
cated tile?

Appears in
content,
people,
places

browse UIs?

Search
rankings in-

fluenced?

Appears in
Searched?

YesYesYesNoneYesMark for Ac-
tion

YesYesYesNoneYesMark as Re-
solve

YesNoYesPositivelyYesMark as Suc-
cess

YesYesYesPositivelyYesMark as Fi-
nal (discus-
sions and
documents
only)
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Can Comm
Mgr globally

disable?

Has a dedi-
cated tile?

Appears in
content,
people,
places

browse UIs?

Search
rankings in-

fluenced?

Appears in
Searched?

YesNoNoNegativelyYesMark as Out-
dated (dis-
cussions and
documents
only)

YesNoYesPositivelyYesMark as Offi-
cial (discus-
sions and
documents
only)

YesNoYesNoneNoMark as Re-
served (docu-
ments only)

NoNoNoNoneNoMark as I
have the
same ques-
tion (discus-
sions only)

NoNoNoNoneNoMark as As-
sumed An-
swered (dis-
cussions on-
ly)

Marking comments and replies
You can mark the comments or replies of discussions, documents, or blog posts in
places where you have permission to comment or reply. After you mark an item,
you see a badge on it. This helps others quickly see what has been decided on or
a success, for example.

To mark a comment or reply:

1.

2. Select the mark you want.
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The options are listed in the table below. You may not see all of these depending
on how your community manager has set up the marking feature. For more infor-
mation, see Marking options for comments and replies on page 112.

DescriptionOptions

This mark shows others that this comment or reply
needs action. You can mark for action for yourself
this or, optionally, bring in other par ticipants and leave
them a note describing what you need them to do.

Actions > Mark for
Action

This mark shows others that this comment or reply is
a Decision. Note that there can be more than one
comment or reply marked as Decision.

Actions > Mark as
Decision

This mark shows others that the comment or reply
was a collaboration success story for your community.

Actions > Mark as
Success

This mark lets others know that this comment or reply
contains helpful information.

Helpful

Only system administrators, place owners, and
discussion authors can see the Correct Answer mark
option and only on discussions marked as questions.

Correct Answer

Note the new badge on the comment or reply. If you change your mind later, just
click Unmark on this same item.
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Marking options for comments and replies
You can mark a comment or reply Helpful, Correct, Decision, Success, for Action,
or Resolved. You may see all or only some of these marking options, depending on
how your community manager has configured this feature.

Note: The Marking feature is different from Tasks, which are a formal way to assign
work tasks to people. For more information, see Mark for Action or assign a task?
on page 115.

When you mark a comment or reply, a badge appears that displays its state (for
example, Helpful or Decision). These badges are visual indicators only; they do not
prevent anyone from fur ther commenting or marking any comments or replies as a
Decision, Helpful, Resolved, Success, or for Action.

To see who marked the comment or reply and when, click its badge.

You may see all or only some of the following marking options, depending on how
your community manager has configured this feature.

Choose Mark for Action to assign an action to yourself, and,
optionally, bring in others. When you bring in others to help, note

Mark for
Action

that doing so doesn't assign the Action item to them; it sends a
notification to their Inbox about the action item. From there, they
can Take Ownership of the action item.

The Action Item badge on the comment or reply lets readers know
that the item has been assigned to someone. Other users may
Mark for Action other comments or replies as well.

For more information on how to resolve your actions, see Resolving
action items on page 120.

Choose Resolve on an Action (whether you own it or not) when
you have completed the action. This lets others know that you've
taken care of the issue.

Resolve

Choose Mark as Decision to let others know that this comment or
reply is the Decision or one of the Decisions. Other users may
mark other comments or replies as the Decision as well.

Mark as
Decision

Choose Mark as Success to let others know that this was a
collaboration success story for your community.

Mark as
Success

Click Helpful to let others know that this comment or reply contains
helpful information.

Helpful

Only system administrators, place owners, and discussion authors
can see the Correct Answer mark option and only on discussions

Correct
Answer

marked as questions. There can be only one Correct Answer. In
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addition, your community manager may disable this feature
altogether.

Marking options for top-level items
You can mark a top-level item (a blog post, discussion, or document) if you have
edit permissions for it.

Note: The Marking feature is different from Tasks, which are a formal way to assign
work tasks to people. For more information, see Mark for Action or assign a task?
on page 115.

You mark a top-level item from its Actions menu. You don't see this menu if you
don't have edit permissions on the item.

After you mark a top-level item, a badge appears that displays its state (such as
Final or Outdated). These badges are visual indicators only; they do not prevent
anyone from fur ther commenting or marking any comments or replies as a Decision,
Helpful, Resolved, Success, or for Action. If you want to prevent fur ther replies on
a discussion or question, click Lock under the Actions menu.

You may see all or only some of the following marking options, depending on how
your community manager has configured this feature.

Choose Mark for Action to assign the item to yourself
or others. The Action Item badge lets others know
that the content item is being reviewed.

Mark for Action
(discussions, questions,
documents, and blog posts)

Choose Resolve on an Action when you have
completed it. This lets others know that you've taken
care of the issue.

Resolve (discussions,
questions, documents, and
blog posts)

Choose Mark as Final to let others know that the
conversation is complete and no fur ther discussion

Mark as Final (discussions,
questions, and documents)

is encouraged. If you mark something Final, you
cannot also mark it Outdated or Official.

Choose Mark as Official to let others know that this
is the official version of this item. This can be helpful

Mark as Official
(discussions, questions,
and documents) for policies and company-wide communications such

as the 2014 Holidays in an HR space or the
company's Mobile Purchasing Policy. If you mark
something Official, you cannot also mark it Final or
Outdated.

Choose Mark as Outdated to let others know that this
is old information and no longer valid. This can be

Mark as Outdated
(discussions, questions,
and documents) helpful for old procedures, policies, and processes

such as 2011 Health Plan Coverage or Engineering
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Intern Projects 2012. If you mark something Outdated,
you cannot also mark it Final or Official.

Marking an uploaded file or a document as Reserved
indicates that someone is currently editing it, so other

Mark as Reserved
(documents and uploaded
files) users don't edit it until the Reserved badge is

removed. It does not actually lock the file or
document.

Choose Mark as Success to let others know that this
was a collaboration success story for your community.

Mark as Success
(discussions, documents,
and blog posts)

Choose this to let others know you have the same
question. You see this only on questions that do not

I have the same question
(questions only)

yet have a reply marked as the Correct Answer or
Assumed Answered.

Choose this to let others know that the question is
assumed answered. You see this only on questions

Mark as Assumed
Answered (questions only)

that do not yet have a reply marked as the Correct
Answer.

Marking top-level items
You can mark a top-level item (a blog post, discussion, question, or document) if
you have edit permissions for it.

To mark a top-level item:

1. Go to the discussion, question, document, or blog post for which you have edit
permissions.

2. In the Actions menu on the right, select the Mark option you want.

You may see not all or any of these depending on how your community manager
has set up the marking feature.

Note the new badge at the top of the content item. If you change your mind later,
you can always Unmark from the right side of the badge box.
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For the list of marking options, see Marking top-level items on page 114.

Mark for Action or assign a task?
You should understand the differences between Mark for Action and creating tasks
and the best ways to use these features.

Mark for Action is par t of the Marking feature and allows you to assign
content items to yourself for action, or invite others to review them and

Actions

take ownership. Typically, you should use Mark for Action in an informal,
on-the-fly manner when you're discussing something. For more
information, see Using Marking feature on page 106.

Tasks are a formal way to assign and track tasks for yourself or others

(  > Task  or Actions > Tasks > Create a task ). You can assign

Tasks

the task a deadline and associate it with a project, such as Sales Kickoff
January 2015, or save it as a personal task for yourself. All tasks that
are associated with a project are displayed on the Tasks tab of the
project. For more information, see Using projects and tasks on page 126.

Mark as Decision or Correct Answer?
Understand the differences between Decisions and Correct Answers and the best
ways to use these features.

Mark as Decision is designed to help you take control of a conversation
in the comments section of a discussion, document, or blog post. Users

Decisions
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can easily Mark as Decision, or Mark for Action to send it to someone
else for review.

The Final and Official marks for a top-level item (discussion, question,
document, or blog post) are additional ways to let users know that a
decision has been reached and no fur ther discussion is needed.

More than one comment or reply per discussion, document, or blog post
may be marked as a Decision, Success, or for Action.

Note that you may see all, some, or none of these marking options,
depending on how your community manager has configured this feature.

When the Correct Answers feature is enabled, only system
administrators, place owners, and discussion authors can see the Correct

Correct
Answers

Answer option on questions. There can be only one Correct Answer per
question.

This feature is not limited to a cer tain type of space or group, but it is
most useful in places that are specifically designed to answer questions
quickly, such as a customer support space or a human resources group.

Community managers cannot configure the Helpful option. It is always
available.

Reserving files and documents
Marking an uploaded file or a document as Reserved indicates that someone is
currently editing it so that other users shouldn't edit it until the Reserved badge is
removed. It does not actually lock the file or document.

The Reserved badge provides important information about file status for anyone
who can't use Jive for Office to edit and merge uploaded files, for example, Mac
users. It can also be used to warn users of a published Jive native document that's
not ready to be edited by other people yet. The Reserved badge doesn't prevent
anyone else from editing, but it shows information about who is working with the
item, making it easy for other people to check in with you before adding their own
edits. Note that if you want to hide an in-progress Jive document before publishing
it, you can just save it as a draft and share it with anyone you want to.

When an author or editor marks a file as Reserved, anyone can see who reserved
the file and contact the person if they're unsure whether it's OK to proceed with
editing. Anyone with the rights to edit a file or document also has rights to mark it
as Reserved. When someone reserves a file, the author and anyone who has already
edited the document receive an Inbox notification. You can filter content to find re-
served documents, too.

Differences in reserving Jive documents and uploaded files

Jive already provide an indicator when someone has star ted editing
a document. (However, note that the lock on the document while

Jive native
documents

someone is editing only lasts ten minutes, and after that, it's possible
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to edit the document and overwrite another user's changes.) Mark
as Reserved replaces the need to put "WIP" or another indicator in
the title when a document isn't in a state where you'd like other users
to contribute. It shows an author or editor's intention to keep working
on the document undisturbed until the next time that the author
publishes it.

Mark as Reserved warns users who don't use Jive for Office that
publishing a new version could overwrite and invalidate a version

Uploaded
documents

someone is working on locally. (Windows users with Jive for Office
have live merge capability and may not need this feature as much.)
Marking a file as Reserved does not lock the document or prevent
uploading another version. But any other user who clicks Edit with
the intention of uploading a new file can see a message pointing out
that the file is currently reserved for editing.

Marking as Reserved
You can reserve a document or file to aler t other users you're working on it. This
doesn't lock the document, but it aler ts other users that you are planning to update
the item.

Reserving documents is especially useful if you're using uploaded files, but can't
use the Jive for Office. The Reserved badge doesn't prevent anyone else from
editing, but it shows information about who is working with the item, making it easy
for other people to check in with you before adding their own edits. For more infor-
mation, see Reserving files and documents on page 86.

To mark a file as Reserved and remove to remove the marking:

1. Go to the document or file you want to reserve.

2. To mark the content item, click Mark as Reserved  on the right sidebar.

The Reserved badge is added at the top of the document.

3. To free the file for editing, use any of the following:

• Click Unmark next to the Reserved label on the document or file page.
• Publish the item. When you or anyone else publishes a new version, the

Reserved badge is removed.
• Mark it as Final, Official, or Outdated. These markings override Reserved, and

the reserved badge is removed.
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Managing your action items
Understand how to resolve, add participants, and manage your Actions.
Adding participants to action items
You can add participants to items that have been Marked for Action for you. This is
a way to get help on an action item.

Bringing in other people on your Action Item notifies them that you need help and
gives them the opportunity to Resolve the issue or Take Ownership of the action.
Note that adding participants does not assign the action to them. For formal task
management, you may need to use the task functionality. For more information about
the differences, see Mark for Action or assign a task? on page 115.

• To add participants to an existing action item that you own:

a) Go to the content item that is marked for action.

You can go to the item by searching for it or looking at your list of Action Items
under the Actions tab in Inbox.

b) Click the Actions  or Action Item badge.

c) Click Add Participants or .
d) Select the users you want to add to this action item.
e) Leave a note describing what you need.
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The note shows up only in the participant's Inbox, so it should let them know
specifically what you need from them, for example, Provide remaining RFP in-
formation.

f) Click Mark.

The new participants see an aler t in their Inbox, along with your note. They can
then Resolve or Take Ownership of the item.

• To add participants while creating an action item:

a) Go to the item and click Actions > Mark for Action .
b) Add a general description of the action that anyone in the community will be

able to see when they click the Action Item badge, for example, Provide
remaining RFP information.

c) Select Bring in others to resolve this action item.
d) Select the users you want to add to this action item.
e) Leave a note describing what you need.

The note shows up only in the participant's Inbox, so it should let them know
specifically what you need from them, for example, Provide remaining RFP in-
formation.

f) Click Mark.

The new participants see an aler t in their Inbox, along with your note. They can
then Resolve or Take Ownership of the item.
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Resolving action items
You can resolve action items and leave a note explaining why you are resolving it.
The author of the top-level item and owners of an action item have permission to
resolve action items.

To resolve something that's been Marked for Action:

1. Go to the item.

2. For comments or replies, click the Action Item badge and select Resolve.

3. Add a note explaining why you are resolving the Action and click Mark.

This note is visible to others, so it's helpful to describe how you resolved the ac-
tion.

The Resolved badge appears on the content item.
Managing your action items
You can manage items that have been Marked for Action for you from the Actions
tab of Inbox.

To manage Action Items that you own:

1. Go to  > Actions .

On the Action Items > Active  tab, you can see a list of items awaiting Action
from you.
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2. You can do any of the following:

DescriptionMarking Option

Add a description of your resolution so that others
know what you did that resolved the item. When
you Resolve an item, it is moved from the Active
list to the Resolved list. If required, you can
unresolve the item from the Resolved list.

Resolve

Add other par ticipants to this Action and leave them
a note describing what you need. They can then
Resolve or Take Ownership of the item.

Add more people to the
item ( Resolve > View
Conversation > Add
participants )

Lets you review the full conversation. From there,
click the Action Item badge and Resolve the item
or Add Participants to bring in more people on
this item.

Go to the action item to
review it in context by
clicking on its title
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Using Impact Metrics
Use Impact Metrics to gain insight on how documents and blog posts are received
by the community, including their Global Reach, Impact, and Sentiment.

Additionally, if your community is connected to Cloud Analytics, you can see more
features, such as:

• Impact metrics for discussions

• Number of subscribers

• List of top departments

• List of top referrers

• Number of emails generated by your content

Understanding Impact Metrics
There are two views of Impact Metrics: summary with a metrics overview and detailed
that provides details to the summary.

The summary view highlights the calculated metrics for global reach, impact, and
sentiment. Content in private and secret groups shows viewers instead of global
reach. The detailed view provides calculated metrics shown in the summary plus
an email metric, a graph of social actions that contribute to the metrics, and details
about viewers and referrers.

The summary view of calculated metrics can be found in the sidebar of your published
content:

When you click View More, you see the detailed view of Impact Metrics. For more
information on the detailed Impact Metrics, see Using detailed view on page 123.
The following calculated metrics are available for supported content type:

Conveys how widely viewed your content is in your community. We
use a calculation based on the number of registered users and

Global Reach

include web and mobile views only. This calculation does not
include those following content via email.
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In private and secret, also known as Private (Unlisted) groups, you
see Viewers instead of Global Reach. These are the unique viewers
who have looked at your content.

Viewers

Shows how your audience reacts to your content by looking at their
social actions, such as Bookmarks, Comments, Likes, Shares, and
Views.

Impact

Indicates how well your content resonates with your audience.
Content can achieve Neutral, Good, or Excellent sentiment based
on social action and views.

Sentiment

Using detailed view
In the sidebar of your content items, where you see the calculated metrics, click
View More to open the detailed view of Impact Metrics.

The Impact Metrics detailed view shows a graph with the number of Views, Viewers,
Comments, Likes, Shares, and Bookmarks of your content by date. It also gives you
the calculated metrics, which are the global reach, impact, sentiment, and email.
Use these metrics to see how your content is being received in the community.
Content in private and secret groups shows viewers instead of global reach.

Note:  Some features described in this topic are only visible for communities which
use Cloud Analytics.
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In addition to what you see in the Summary view, you also see:

You can adjust the report dates in the upper left corner of the
detailed Impact Metrics graph. Either enter a custom date range

Report Dates

that focuses on a specific period of time, or select a
pre-configured report period that shows the first 7, 30, or 60
days of publishing the content.

Note:  Impact Metrics are real time, so expect to see new viewers
right way.

When you click daily or hourly and then hover over the graph,
you see data for more specific chunks of times.

Daily or hourly
data

If your community has the News enabled, then you can click
Subscribers to see how many of the viewers clicked through to

Show Only
Subscriber
Metrics view this content from their News stream. When News is

disabled, you will not see the Subscribers button.

If you want to look at which departments have the most Views,
Viewers, Comments, Likes, Shares, and Bookmarks, then click

Data by
Department

Top Departments in the top right of the detailed Impact Metrics
graph.

Counts how many email notifications occur when one of the
following events happen:

Email

• Use @mention in content, comments, or replies.

• Share content.

• Add collaborators to content.

• Reply to discussions, or comment on blog posts, videos, or
documents.

• Create content when someone who follows you has email
notifications enabled.

Viewers tell you who's looking at your content, and top referrers
tell you who's generating interest in it. For more information,
see Who is viewing and referring your content? on page 125.

Viewers and
referrers

For more information about Impact Metrics, see Using Impact Metrics on page 122.

Where are the Impact Metrics for this?
If you don't see impact metrics for a content type, you either don't have permission
to view them, or they're not available to that type of content.

Authors and a few others can use Impact Metrics as a way to measure how the
content is received by the community.
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The content author and everyone with admin rights can
see the Impact Metrics. When you publish the metrics

Who can see impact
metrics for documents,

to everyone, then everyone who can view the contentdiscussions, and
videos? can see the Impact Metrics for it. For more information,

see Publishing Impact Metrics to everyone on page 126.

The content author and the group or space owner can
see the Impact Metrics. When you publish the metrics

Who can see Impact
Metrics for blog posts?

to everyone, then everyone who can view your blog post
can also see the Impact Metrics for it. For more
information, see Publishing Impact Metrics to everyone
on page 126.

Blog posts, documents, discussions, and videos show
Impact Metrics. If your community has been recently

What types of content
show Impact Metrics?

upgraded to include this feature, all content created
before the upgrade cannot be tracked with Impact
Metrics.

Who is viewing and referring your content?
You can find out who's viewing and who's referring your content by looking
underneath the detailed Impact Metrics graph.

Viewers

If enabled in your community, find out who has viewed your content when you look
under the Impact metrics graph in the detailed view. Only the standard access user
can see this viewers panel, and external contributors can never see it. From the
Viewers panel, you can search for viewers based on first name, last name, and title.

Top referrers

If enabled in your community, see whose referrals gained new viewers to your con-
tent. It's under the detailed view of the Impact Metrics graph. You also see how
many viewers have been referred by that user. Only the standard access user can
see this viewers panel, and external contributors can never see it.

Improving your impact
Improve your Impact, Global Reach, and Sentiment by sharing your content with
either the entire community or just a few colleagues.

Consider your audience when posting or sharing content. If you're posting something
that only Sales need to pay attention to, then post it to the appropriate Sales group.
If you already posted your content in a place where it's not getting the attention you
need, then you can move it, or try @mentioning the appropriate group or users in
your status update to get the right people to see your content.
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When you share content with the right set of people, you can really improve your
impact. Sharing with users who interface with a lot of people can make your content
much more visible — if these users interact with it, it shows up in Top & Trending.
For example, many managers and executives are superstar users because people
who report to them pay attention to what they do.

Publishing Impact Metrics to everyone
You can expose Impact Metrics to everyone who has permission to view your content.

When you're ready to show everyone the Impact Metrics on your content:

1. Go to the sidebar and hover over the calculated metrics.

2. Click the pencil edit icon when it shows up.

3. Select Make these Impact Metrics public.

Using projects and tasks
Projects and tasks are a great way to turn collaboration into action and track your
progress.

A project is a great way to give collaborative work a context that is time-based and
outcome-based. With a project, you collect content in a way that focuses user work
along with a schedule toward a specific goal. You can then create and assign people
tasks and sub-tasks associated with the project to make sure everything gets done.

Overview of projects and tasks
Jive projects provide lightweight project management with tasks, due dates,
checkpoints, and notifications.

A project can contain various content types, including tasks. You can create tasks,
assign them to people, set due dates, and mark them as complete. Once you enter
all the tasks for a project, you can edit or delete them, add sub-tasks, set up email
notifications on tasks, and mark tasks complete. As with other content, you can
assign tags to tasks.

You can add checkpoints to a project as a way of making sure your project is pro-
ceeding on track. A checkpoint is a named place in the schedule, and it's often used
as a point at which to make a decision about what to do next.

To help you manage your project progress, Jive provides visual cues that snapshot
the project. On a project's home page, you get a checkpoint timeline that shows
where your checkpoints are between the project's star t and finish, and where the
current date falls on the timeline. A project calendar captures task due dates and
checkpoint dates in a traditional calendar style.

126AUREA CONFIDENTIAL

Chapter 2: Using a Jive community



Creating projects
You can create and configure projects for collaborative work.

If you use the checkpoint and status functionality for tracking project tasks, you can
use the old-style Overview page rather than using the Activity page in the place
template format. The widgets in the Overview page more effectively support projects
at this time.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

To create a project:

1. Click  > Project .

2. In the dialog box, select a location for the project.

Projects are associated with a place, such as a space or a group. The place you
choose determines who can see and collaborate on the project.

3. In Name, specify an identifying name for the project.

4. In Description, enter a brief description.

The description appears in the user interface.

5. In Project Start Date and Project End Date, specify the project duration.

You should use the target date for completing the project.

6. If necessary, change the project owner in Project Owner.

The default owner is the person creating the project.

7. In Tags, specify tags that can be used to find this project.

8. If available, in Categories, select the place category of the project.

The place categories are used to identify places while browsing. They are used
to classify places and differ from content categories. This option is available if
place categories are configured in your community.

9. To enable the Overview page, click Advanced Options and select the Overview
page check box.

By default, your project uses an Activity page as its main page with the option to
add more custom pages. We recommend using an Activity page because it can
be displayed on mobile devices and because it's more friendly to streaming
content. This option is available if widgets are enabled in your community.

10.Click Create Project.

The project is created.

11.If you are using the Activity page, apply a place template to this project, as
described in Applying place templates on page 174.
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Note: The default template is Team Collaboration. For more information, see
General place template reference on page 180.

The project is created and you can add tasks to it. For more information, see Creating
tasks on page 128.

Additionally, you can fur ther customize the project. For more information, see De-
signing activity and custom pages for places on page 172.

Deleting projects
When you delete a project, you remove the entire project, including its content, from
the system. You cannot undo a project deletion.

When a project and its content are deleted, the links and @mentions to the deleted
project are replaced with the "The specified item was not found" message. To avoid
this, you can archive the project instead of deleting it. For more information, see
Archiving projects on page 240.

To delete a project:

1. Go to the project and click Manage > Delete  in the upper right corner.

2. Confirm the project's deletion by clicking Delete.

The project and all its content are deleted from the application.

Creating tasks
You can create personal tasks for yourself or assign tasks for others and associate
them with projects.

Note that you can create tasks that are unassigned to a project only for yourself.
These tasks are called personal, and they are available only for you. If you want to
create tasks for other users, you must assign them to projects.

To create a task:

1. From the main navigation menu, click  > Task .

2. In Description, provide a brief overview of the task.

3. In Project, select a project for this task.

The default selection is None, which means it is a personal task for yourself and
only visible by you. You cannot create personal tasks for other people. By default,
the task is assigned to you.

4. To assign the task to someone else, click "x" next to your avatar, and then select
the user to whom the task must be assigned.

5. In Due Date, enter the date you want this task to be completed by.

The default due date is tomorrow.
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6. If you want to use the content editor to describe the task and add tags to it, click
Advanced and fill in the necessary details.

7. Click Add Task to add the task.

Tasks assigned to projects are displayed on the project Tasks page. Personal tasks
appear on the Tasks page of the user.

Managing tasks
You can edit a task, add a sub-task, delete a task, and follow it in a stream. You
can do this from either your personal task list ( Your Profile > Tasks ) or a project's
task list ( Project > Tasks ).

To manage tasks:

1. To view your tasks, including your personal tasks and project tasks, go to Your
profile > Tasks .

2. To view project tasks, go to Project > Tasks .

3. To view task details, click Show details next to the task.

This opens the task description and the task menu.

4. Select one of the available actions: edit a task, add a sub-task, delete a task, or
follow it in a stream.

Completing tasks
There are two ways to manage and complete tasks: through your personal tasks list
or the tasks list associated with a project.

1. To view your tasks, including your personal tasks and project tasks, go to Your
profile > Tasks .

2. To view project tasks, go to Project > Tasks .

3. Select the check box to the left of the task you want to complete.

You can briefly see the task with a line through its text before it disappears
completely from the list. If you want to see the completed tasks, select the Include
completed check box under View.

Importing and exporting tasks
Tasks can be transferred between Jive projects and other tasks management tools.
Jive uses comma separated values (CSV) files to import or export task data in bulk.

Importing tasks
Tasks can be imported into Jive projects from CSV files with commas used as
separators. You can map the columns in a CSV file to the Jive task fields after the
file is uploaded to Jive.

A template of a CSV file can be found here.
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To import tasks into a Jive project:

1. Export the information from your other project management tool, saving it as a
CSV file with commas used as separators.

2. Go to your project in Jive and click Import/Export Tasks in the Actions list.

3. On the Import/Export Tasks page, under Import tasks from a CSV file, click
Browse to locate the CSV file you exported, and then click Upload File.

After the file is uploaded, the page shows the column titles for Jive tasks (such
as Description Field, Assigned To Field, and Due Date Field), with dropdowns
that list column titles found in the CSV you're uploading.

4. Use the dropdowns to map a different CSV column title to each of the titles in the
Jive project.

This determines where the information goes in the Jive project. The page displays
a preview using the information found in your CSV file.

5. Click Proceed to accept the mappings.

6. Clear check boxes for those items you don't want to import.

7. If necessary, click the Edit link for a task to edit task information before you import
it.

8.

The imported tasks are linked to the project.

Exporting tasks
Tasks can be exported from Jive projects into CSV files with commas used as
separators.

To export tasks from a Jive project to a CVS file:

1. Go to your project in Jive and click Import/Export Tasks in the Actions list.

2. On the Import/Export Tasks page, under Export tasks to a CSV file, specify
exporting options:

a) Select which tasks should be exported: All or Incomplete tasks only.
b) Select if Username or First/last name should be used.
c) Select if the CSV file should be encoded for Microsoft Excel.

3. To export only some of the filtered issues, click Choose Tasks, clear the check
boxes for the tasks you don't want to export, and then click Export Selected
Tasks.

4. To export all filtered issues, click Export.

The CSV file with the exported tasks is downloaded to your computer.
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Mark for Action or assign a task?
You should understand the differences between Mark for Action and creating tasks
and the best ways to use these features.

Mark for Action is par t of the Marking feature and allows you to assign
content items to yourself for action, or invite others to review them and

Actions

take ownership. Typically, you should use Mark for Action in an informal,
on-the-fly manner when you're discussing something. For more
information, see Using Marking feature on page 106.

Tasks are a formal way to assign and track tasks for yourself or others

(  > Task  or Actions > Tasks > Create a task ). You can assign

Tasks

the task a deadline and associate it with a project, such as Sales Kickoff
January 2015, or save it as a personal task for yourself. All tasks that
are associated with a project are displayed on the Tasks tab of the
project. For more information, see Using projects and tasks on page 126.

Public and private communications
To enjoy the full power of Jive, we recommend keeping discussions and documents
public whenever possible. The following topics describe the visibility options for
content, as well as the security of the application for users.

Security of content and activities
Your organization has deployed Jive to provide a place for you to get your work
done by contributing to and collaborating in the community. Your activity in Jive is
safe and secure.

Your company owns your activity in the community, just as they own your activity
in your company email program. For more information on who can see your content
and how visibility works in Jive, see Content visibility on page 132 and Content visi-
bility options on page 134.

Related information

If you're concerned about the security of Jive and want to get a deeper understanding
of how your information is protected, see the security overview on the Security page
on the Jive Software website at http://www.jivesoftware.com/social-business/engage-
employees/technology/security/. Alternatively, you can see Jive Security in the
Community Administrator Guide.
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Content visibility
The visibility of the content depends on the place where you published it. Different
places have different visibility permissions.

In Jive, people post content in places. This means that all content (such as discus-
sions, documents, and blog posts) is published in containers. A container can be a
space, sub-space, group, project, or your own personal content. All places have
visibility permissions set by the place owners that determine who can see the content
posted in that place.

While it's best to keep things public whenever possible so that other community
users can benefit from all of the content pieces (such as discussions or documents),
there are times you may want to publish things only for yourself or a handful of
other people. In addition, you may want to keep entire categories of content private,
for example, accounting or human resources information. In that case, you can
create a space or group with the content visibility options that you need. For more
information about permissions, see Managing Permissions in the Community Admin-
istrator Guide.

For more information about the security of the community, see Security of content
and activities on page 131.

Content containers
Here you can find the types of containers in which you can publish content in the
community.

Your personal content

Your personal container is where you can store your documents and other content
types that are hidden or limited to specific people. Your personal tasks are also
stored here.

To see your content that is limited to only you or specific people:

1. Go to Your Avatar > Your Content > Authored > <Document type> .

This opens your personal container where you can find the content items of dif-
ferent types and filter them.

2. Select Filter by personal content to see content pieces available only to you.

A dark lock icon next to the item indicates it is limited to you; a light lock icon next
to the item indicates it is limited to you and the other designated people.

You can find your personal tasks on your profile page or in the project. For more
information, see Managing tasks on page 129.

Groups

Different types of groups have different content visibility permissions. For more in-
formation about the various options, see Types of groups on page 57.
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To view the content of a group:

• Go to the group and open the Content tab.

You can filter the content by type to view, for example, discussions or documents.

Spaces

Spaces have complex content visibility options that are set up by the owners of the
space. Also, spaces can be configured to contain some content types. For example,
you may not be able to create a discussion in Space A, but you can in Space B.
You can see the allowed content types on the Content tab of the space.

• Go to the space and click the Content tab.

You can filter the content by type to view, for example, discussions or documents.

Sub-spaces

By default, sub-spaces inherit all of the content visibility permissions of their con-
taining parent space.

• Go to the sub-space and click the Content tab.

You can filter the content by type to view, for example, discussions or documents.

Projects

Projects inherit all of the content visibility permissions of their containing parent
space or sub-space.

• Go to the project and click the Content tab.

You can filter the content by type to view, for example, discussions or documents.
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Content visibility options
You can limit to selected people the visibility of content that you create, or hide it
completely from other people. Here is a reference of the visibility options of all
content types.

Content visibility reference
Here you can find details on who can see content items in various places in the
community and which content types cannot be hidden.

Your personal content

Documents
and uploaded
documents

• Description: When you publish a document as Hidden, it is stored
in your personal container and is private to you.

• Are streams updated?: You can see a stream update when you
publish, but other users cannot.

• To set the item as Personal: Before you publish the document,
set its visibility to Hidden. For more information, see Creating
documents for yourself on page 78

• To find the item later: Go to Content > Authored > Documents
, and then select Filter by personal content. The dark lock icon
next to the document indicates it is limited to you.

External
bookmarks • Description: Your private bookmarks are stored in your personal

container and are private to you.

• Are streams updated?: You can see a stream update when you
save the bookmark, but other users cannot.

• To set the item as Personal: Go to  > Bookmark  and paste
in the external URL. Then, select Make this bookmark private
and save it.

• To find the item later: Click the Spotlight search and select
Bookmarked > Show all bookmarks . In the main navigation
menu, filter by External URL. The dark lock icon next to the
bookmark indicates it is limited to you.

Personal
tasks • Description: You can assign yourself personal tasks so that no

one else can see them.

• Are streams updated?: You can see a stream update when you
publish, but other users cannot.

• To set the item as Personal: Go to  > Task  and select
Project > None (personal task) .

• To find the item later: Go to Actions > Tasks . In the Project
menu, select Personal.
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Content limited to specific people

Documents
and • Description: When you publish a document limited to Specific

People, it is stored in your personal container and is private to you
and the other people you designated.

uploaded
documents

• Are streams updated?: You and the other specified people see
a stream update when you publish, but other users cannot.

• To set the item as Personal: Before you publish the document,
set its visibility option to Specific People.

• To find the item later: Go to Content > Authored > Documents
and then select Filter by personal content. The light lock icon
next to the document indicates it is limited to you and the other
people you designated.

Discussions
• Description: When you publish a discussion limited to Specific

People, it is stored in your personal container and is private to you
and the other people you designated.

• Are streams updated?: You and the other specified people see
a stream update when you publish, but other users cannot.

• To set the item as Personal: Before you post the discussion, set
its visibility option to Specific People.

• To find the item later: Go to Content > Authored > Discussions
and then select Filter by personal content. The light lock icon
next to the item indicates it is limited to you and the other people
you designated.

Messages
• Description: You can send one or more other users a private

message.

• Are streams updated?: Messages are listed in the Inbox. They
do not appear in streams.

• To set the item as Personal: Go to  > Message  and select
the persons to whom you want to send the message.

• To find the item later: Go to Inbox. In the Filter drop-down menu,
select Messages.

Content that you cannot hide

• Blog posts.

• Discussions.

• Polls.

• Status Updates. However, you can limit your status update to a group if you want
to limit its audience. For more information, see Posting status update in groups
on page 59

• Projects.
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Setting up content visibility options
If you're concerned about privacy, you can limit who sees different par ts of your
profile by editing your privacy settings.

To limit profile visibility:

1. Go to Your avatar > Edit Profile .

2. Go to the Privacy tab.

3. For each profile field, select who can view it.

If you select everyone, then all users can see the contents of that field. Your
community administrator may control who sees cer tain fields, such as those
without a Visible to option.

4. Take a look at how others can see your profile by using the Preview your profile
tool in the upper right corner of the page.

5. Click Save to save the changes.

Creating direct messages and private discussions
By using messages and private discussions, you can limit your audience to only the
people you want.

Messages and private discussions show up in the Inbox of only the people you send
them to. These are useful features, but the power of Jive is that nearly all topics in
the community can be helpful to others, so try to keep things public whenever pos-
sible.

To send a message to someone, do one of the following:

• In your Inbox, click Send Message.

• Select  > Message .

• Click Message from the top of any of your attention streams.

• Hover over the person's name in any of your attention streams and click Message.

After your message is sent, the receiver can see it in their Inbox. From there, the
receiver can respond directly.

To create a private discussion:

1. Click  > Discussion  to create a discussion, then enter the title and details
of the discussion.

2. Select Specific People under Publish Location.

3. Select the participants you want to include in the discussion.

4. When you're finished drafting the discussion, click Post.

136AUREA CONFIDENTIAL

Chapter 2: Using a Jive community



Only the participants you selected can see a discussion notification in their Inbox.
From there, they can respond to the discussion.

Saving drafts
You can use the Save As Draft feature to quickly jot down and save your thoughts
in documents or blog posts. Then, you can come back later to edit and publish your
content. You can also collaborate with others on saved drafts before publishing
them.

You can save blog posts and documents as drafts. This can be useful if you need
time to finalize your thoughts before publishing something. Additionally, drafts are
not visible in any streams.

Creating and editing drafts

To save a blog post or a document as a draft:

1. Create and fill in a document or blog post.

2. Click Save Draft.

The document is saved as a draft and is not visible to anyone. You can find it on
the Drafts tab of Your Content.

To edit a draft:

1. Go to Your Avatar > Your Content  in the main navigation menu, and then click
Drafts in the left sidebar to see your drafts.

2. If required, filter your Drafts results by documents or blog posts.

3. Click on the draft to edit the content.

4. Click Publish to save and publish the draft.

You can edit the content and save it again as a draft, or publish it.

Collaborating on drafts

You can collaborate on drafts of blog posts or documents before you publish them
or share an existing draft with other users.

To get people to collaborate on an existing draft:

1. Open the draft.

2. Click Share in the upper right corner of the page.

3. In the Share dialog box, select the people you want to share the post with and
include a message for them.

4. Click Share.

The recipients are able to edit the draft and either save it as a draft or publish it.
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Using Jive Apps
Jive Apps are available in your community to help you get your work
done faster and more effectively. For example, an app could help you

and your team to arrange travel and schedules. An app could remind you to get up
and stretch as you are working. An app could send a notification when your expenses
have been approved.  Apps work within your community and can use

its features directly as well as pull in third-party systems to bring
additional functionality.

Overview of Jive Apps and app actions
You can use Jive Apps to accomplish focused tasks, integrate with other systems,
or provide new functionality to your Jive experience.

Jive Apps are lightweight applications that are hosted by Jive or a third-party, which
means you don't have to download anything to your computer and you are always
looking at the latest version. When you install an app in Jive, you connect to it and
enable it to access information that helps you work more effectively.

You can find Jive Apps when you click Apps at the top of your screen, where they
always are when you're logged into the community. Some apps can bring in informa-
tion from outside of your community, while others manage information within the
community itself. You can also access some Jive Apps through extension points
throughout the UI known as app actions. For instance, some apps are accessible
from the menu in the right sidebar when viewing content and some apps are acces-
sible from the create menu.

Contact your Community Manager for acquiring additional Jive Apps.

App actions

Apps can be used in other places beyond the Apps menu at the top of the screen.
These additional app extension points are called app actions. An app action can
appear in one of many different locations within the Jive UI: as a menu item in the
Create menu (within the Apps section), in the sidebar when viewing a document
(within the App Actions section), as a new tab in a group or project, when typing
"!" while editing content. It is up to the Jive App developer exactly which of these
extensions are accessible and exactly what action occurs when you select this action.

Using apps in content
By using !App, you can bring links and images from a Jive App into your community
so you can share them with others.

Similar to @mentions aler t people and places, there's also a symbol you can use
to invoke a Jive App from any discussion, blog post, document, or comment in Jive.
Just type "!" and you see a list of installed apps.
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When you create or comment on content in your community, you have the ability to
!Apps. This is a way to share app ar tifacts with others. This enables you to generate
a conversation about the app ar tifact or share it with people. If they don't have the
app, they are invited to download it when they click the image or link.

To get content from a Jive App:

1. In the content editor, type the "!" symbol (or click the "!" icon if it is available).

A search dialog opens and suggests possible matches.

2. Select the Jive App from the list and navigate to the image or content in the Jive
App to produce a link.

Troubleshooting and FAQs for Jive Apps
Here are answers to some specific questions about Jive Apps and how they work.

I have a problem with my app: what should I do?

Jive Apps are supported by the developers who created them, just like apps you
may have used on your smartphone or another mobile device. To get support for
an app, select the App Settings button and select About. You'll be presented with
a link to either the developer's support web site or a support email address.

I can no longer use my app: what happened?

Sometimes apps become disabled when their data stream is interrupted, or when
the app can't connect to the Internet. Your community administrator can also disable
an app if she decides it's not appropriate for your community. Finally, for paid apps,
billing issues like an expired credit card can result in the app getting temporarily
disabled. If a paid app is disabled, we will no longer charge your credit card for app
usage. In general, we try to give you detailed instructions on how to get your app
star ted again. However, if you need some help troubleshooting, you should reach
out to your community administrator.

I'm leaving my community: what happens to my information?

If you leave your community, your credit card will automatically be disabled when
your administrator turns off your access to the community. If you still see charges
on your card please contact Jive directly at app-billing@jivesoftware.com.

Using external groups
You can use external groups to collaborate with users from outside your community.

When you create an external group, you can invite users from outside the community
to work with community users. These groups usually serve a specific purpose, such
as working on a project with a vendor. External contributors can see content only
in groups they belong to.
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The external contributor brings a fresh perspective and their expertise to an internal
or employee community where you would usually suffer the pains of long email
threads or time-consuming conference calls to get information from people outside
your community. These users can provide quick answers, share files, and collaborate
on documents.

External groups overview
External groups provide an area where standard community users can work with
people from outside the community, external contributors. Only secret or private
groups can have external access.

You can use external groups to invite people from outside your community to collab-
orate with standard community users. For example, a user in a music label company's
community could create a private group for a collaboration project they're working
on. They could then enable external access to the group, invite the external ar tists
who will be participating, and use the group to post schedules and communicate
ideas. The external ar tists are limited to viewing and participating in this group only.
They can't see anything else going on in the community.

Groups with external access are designated with visual cues such as either orange

Externally Accessible text or  the orange eye symbol that means people from
outside your company are welcome in that group. You can find the following bright
orange sign post at a group's home page.

Creating external groups
When creating a group, you can select Enable external access to turn a community
group into a place where standard users can invite external contributors to extend
their communication and collaboration to the outside world.

For the details on group creation, see Creating groups on page 51.

To create a group with external access:

1. Click  > Group .

2. On the Create group page, enter the group name and details.

3. Select Private or Secret for the group type.

External groups are limited to private and secret groups to help protect community
information.

4. Select Externally Accessible to allow external contributors to be invited to and
join the group. Externally Accessible groups must be private or secret. You may
not see this option if it's not enabled for your community.
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5. Click Advanced options for more options.

6. Click Create Group .

7. If you see the Invite People to Join dialog box, then add a few users who you
want to invite to the group, and click Send Invitation.

8. To manage group features and select the storage provider, select Manage >
Settings .

9. Click the gear icon in the Enabled Features and Content Types tile.

10.Select or clear features for the group.

People will be able to create content items of the types you select.

11.If available, you can select a storage provider for storing your uploaded files.

12.Click Apply.

13.Click Save.

The group is created and the user you invited can star t using the group.

Who are external contributors?
An external contributor can join a secret or private group when invited into the group
by a group member. External contributors can view and participate only in that group.
They cannot see any other community content or activity, and they can only join a
maximum of 20 groups.

You can securely invite someone from outside your community to par ticipate in an
externally accessible group. The standard community user can only see external
contributors when they belong to the same group.

Public groupPublic: Re-
stricted group

Private groupPrivate: Unlist-
ed group (Se-

cret)

  v*v*Can group
members invite
external contrib-
utors?

NoneNoneNoneNoneWhat is visible
to an external
contributor who
is not a group
member?

  Only a group
member

Only a group
member

Can external
contributors see
content?

  Only a group
member

Only a group
member

Can external
contributors
participate?

141AUREA CONFIDENTIAL

Using external groups



Public groupPublic: Re-
stricted group

Private groupPrivate: Unlist-
ed group (Se-

cret)

  v*v*Can external
contributors in-
vite new group
members?

n/an/aGroup adminis-
trator

Group adminis-
trator

Who approve
secret and pri-
vate group
members?

* Group administrators must approve invitations to private or secret groups. Inviting
an external contributor doesn't automatically grant access to a group. The external
contributor has then to accept the invitation.

Differentiating between external contributors and
standard users
You can always tell the difference between standard community users and external
contributors because external contributors have either an orange icon or orange
text near their name.

Whether you are searching for users, browsing through community activity or looking
at someone's profile card, you can spot the external access symbol that helps you
identify external contributors.

An email notification also clearly indicates when you're replying to an external con-
tributor.
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Inviting external contributors
When you belong to a group with external access, use the email addresses of users
you want to invite from outside your community to par ticipate.

To invite external contributors to join an external group:

1. Go to the group's main page.

2. Select Actions > Invite .

3. Enter the email addresses of people you want to invite. To invite several people
from your email address book, you can export a comma-, space-, or
semicolon-separated list of addresses from the email application and paste them
in.

4. Edit the message you want potential group members to see with their invitation.

5. Click Send Invitation .

What can external contributors see?
External contributors can't see everything in the community because they are limited
to the content in their groups and a few other restrictions.

External contributors can see:

• Groups they have joined

• Content and projects within those groups

• Other users who are also members of those groups

External contributors cannot see:

• Spaces or projects besides those in their groups

• Community Overview page found when you click Home

• Global or public content, such as status updates, public bookmarks, or public
documents and discussions

• Apps, but they can see images embedded by apps within their groups
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What is unavailable to external contributors?

External contributors can use the community similarly to a standard user with the
following exceptions:

• Update their status.

• Create public discussions and documents.

• See and work with private messages; only unauthorized messages are seen.

• See or use Jive Apps. External contributors cannot see or launch Apps or App
Actions.

• Use Connects Services. External contributors also cannot see Connects Services
in their user's Preferences page.

• See or use the Tools page, so they can't download modules like Outlook, Office,
and Jive Anywhere.

• Access public external URL bookmarks or social bookmarking. External contributors
can create and view internal bookmarks of Jive content.

• Become group owners.

Contributing to community as external user
A company may invite you to join one of their groups and become part of their online
community so they can work closely with you, making you an external contributor.

Becoming an external contributor is a way to collaborate in a community
on a limited basis. As an external user, you can view content and
participate only in the group you belong to.

Once you accept an invitation to join a community's external group, you can begin
contributing to that group. For more information, see How to begin contributing to
community on page 144.

How to begin contributing to community
When you first join a community's external group as an external contributor, you
can begin par ticipating by accepting invitations, setting up your profile, and
addressing your actions.

Accepting group invitations

The first thing that you should do when you sign into the community is to accept
any group invitations. You'll be doing all of your work in groups, so accepting invita-
tions is how you can see group content and activity.

• Go to Home > Actions  and then accept group invitations that you see under
Pending.

Note: You can only belong to a maximum of 20 groups, so choose wisely!
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Setting up your profile

Your user profile provides community members with an easy way to learn about
your skills and interests. Your profile shows up in search results when community
members search for keywords contained in your profile. You can update your infor-
mation at any time.

Checking out your actions

When you are assigned something to do, such as a task or something that's been
Marked for Action for you, you can see an aler t next to Actions in the left sidebar.
For more information, see Using Marking feature on page 106.

Use the following quick tips to use Actions effectively:

• Click Action Items to see a list of your Action Items. From here, you can Resolve
them, or bring in other par ticipants. To see the Action Items you have already
resolved, click Resolved.

• Click Tasks to see a list of tasks assigned to you, which you can sor t by project.
To see the tasks you've completed, select View: Include completed. For more
information, see Using projects and tasks on page 126.

Customizing email notifications

You can take advantage of custom email notifications if you feel like you might miss
something important when you're not signed in. For more information, see Customiz-
ing notifications on page 30.

Setting up your profile
Setting up your profile is the first step to par ticipating in the community.

Your user profile provides community members with an easy way to learn about
your skills and interests. Your profile shows up in search results when community
members search for keywords contained in your profile. You can update your infor-
mation at any time.

To set up your profile:

1. Go to Your Avatar > Edit profile  in the upper right corner.

2. On the Profile Details tab, fill in as much profile information as you like.

Note that your profile can found when people search, so if you have professional
roles or interests that would be useful for others to know about, you should include
them. You may not be able to edit cer tain fields, such as username. Usually, the
community manager sets up these fields for you.

3. Click Save to save the settings.

4. On the Privacy tab, edit your privacy settings.

These control how different types of users see your profile. For more information
on privacy settings, see Setting up content visibility options on page 80.

5. Click Save to save the settings.

6. On the Avatar & Photos tab, change your avatar and manage your photos.
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Your avatar and other photos let people see and recognize you in person. Your
avatar lets community members quickly associate your comments and status
updates with a simple visual cue.

7. Click Finished to return to viewing your details.

What else can external contributors do?
Jive is a place where you can build your network, come together as a team, share
files, collaborate on documents, and get answers fast.

The group you belong to looks forward to hearing your ideas, and they need your
expertise to get work done. Think of the group as a 24-hour hotline where you can
communicate your concerns and give your opinion. You can write documents and
get input from all the experts without taking notes or sifting through long email
chains.

Using your Inbox

Your Inbox shows the activity that's most you-centric – the information that's sent
directly to you and has your name on it. This automatically includes @mentions,
replies to discussions you're par ticipating in, content people share with you, your
latest acclaim, new follower notifications, and direct messages.

Use the following tips and tricks to get the most out of the Inbox:

• You can use the Filter menu in Inbox to sor t the view to @mentions, messages,
notifications, or shares.

• You can filter Inbox by participant by entering a user name in the box. You can
see only the items that include this person as a par ticipant.

• Manage your unread communications and follow-ups by using the blue dot next
to messages you haven't read yet and clicking Unread Only to see only the
messages marked with the blue dot.

• When you click the Split View icon in the top right of the Inbox stream and then
select a message, you can see the content of the message in the lower pane and
the list of messages in the upper pane.

• Get rid of activity on any item that no longer interests you by clicking Hide new
activity in the lower pane of the split-pane view. The current activity stays in your
Inbox, but you'll see no more update aler ts for that item. For more information
about notifications, see Customizing notifications on page 30.

Discovering documents and discussions (and other content), commenting and
collaborating

Exchange ideas when you participate in discussions, questions, and documents:

• To comment on a content item, you should click Add a Comment or Reply at the
bottom of a document, blog post, question, or discussion. You can reply to an
individual message in a thread or the original post. Everyone reading the thread
sees your response.

• Documents have owners who control whether you can change the content of the
document, comment on it, or view it. You may be able to see documents that you
don't have permission to comment on or par ticipate in. If you think you should be
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able to comment on a document and you can't, contact the author and ask for
permission.

• If you can edit a document, you can see Edit near the Actions menu.

• A comment or a reply may have a badge showing Decision, Action Item, or
Success. These badges help you avoid endless discussion and quickly determine
the state or outcome of the conversation. For more information about marking,
see Using Marking feature on page 106.

• Comments and replies may also be liked or marked as helpful. These are tallied
for reporting activity in places or the entire community.

• A badge shows others how helpful someone has been to you. To give someone
a badge, go to their profile page and click Actions > Give Badge .

Using attention streams

You can see streams on the News page and the Activity page of any place. Streams
are updated when someone creates a document, replies to a blog post, posts a
status update, and so on.

Objectives of external contributors
As an external contributor, you are a crucial par t of a community that needs your
input. You may not be a community member, but someone in the community invited
you because they knew you'd add value. The benefit of being an external

contributor is that you only see the parts of the community that affect
you. You don't have to worry about seeing anything you shouldn't.

Your role is to help the community reach outside of its circle and to share knowledge,
so that you and other group members can work together successfully and efficiently.
You can feel free to ask questions in your groups and to post and comment on
documents and discussions. When you become part of the conversation, you improve
how work gets done.
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3
Reference and advanced topics
Here you find techniques for advanced users and administrators.

For details, see the following topics:

• Advanced content management

• Remote access

• Advanced group management

• Customizing News page

• Designing activity and custom pages for places

• Using tiles

• Designing Overview pages for places

• Advanced project management

• Using email

• Accessibility

• Keyboard shortcuts for content editor

• Passwords

• Unpairing a two-factor authentication device

• Time zone and locale preferences

• Changing non-editable profile fields

Advanced content management
Managing your documents and discussions through permissions and archiving can
help ensure effective collaboration.

Document approval
You can designate an approver for any document before you publish it, or a
community administrator may designate an approver for a space, so that all
documents must be approved before they are published.

Note:  A space approver approves only documents. If you want to set approval on
more than documents, use the Moderation feature if your community supports it.
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Assigning document approvers for spaces

Community administrators can designate a document approver for a space so that
all documents created in the space must be approved before they are published.
For more information on setting up space approvers, see Setting up document ap-
prover in space in the Community Manager Guide.

Adding document approver to single document

You can designate an approver for a document when you are creating it or after you
have saved it, but not published it. To add an approver to a single document:

1. While you're editing the document, click Advanced Options.

2. Under Require approval before publication, enter the name of the person you
want to approve the document.

You can also click Select People to browse for the person's name.

Note:  If the place that contains your document has moderation enabled (if your
community supports it), then the approvers must approve the content before it is
sent to the moderator's queue.

Note:  Older versions of documents are not accessible when the latest version is
pending moderation.

What happens when I submit a document for approval?

1. While awaiting approval, you can see the document in your Drafts by going to
Content > Drafts .

2. When someone has been assigned a space approver role, documents created in
the space are submitted for approval before they are published in the community.
If moderation is also enabled for documents in the containing space, then new
documents must be approved before they're sent to the moderation queue.

3. If the approver rejects the document, they're prompted to include a message to
go with their rejection. That message is added to the document's Author Discussion
area, where comments go under the document's content. A rejected document
must be resubmitted (by anyone who can edit the document) for approval before
it can be published.

4. If there are multiple approvers, all of them must approve a document before it
can be published. After the last person approves the document, it is automatically
published (or submitted for moderation if moderation is enabled in the containing
space).
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Converting discussion threads to documents
Sometimes an important discussion needs to become a document.

There may be times when you want to convert a discussion into a document. When
you do this, you create a new document that contains the original post and all replies.
Then, you can edit the new document and save it. The discussion itself is not re-
moved.

• To convert a discussion to a document, go to it, and then click Convert to
document.

Moving content items to other places
You can move content items, such as discussions and documents, from one place
to another.

• To move a content item from one Jive place to another, go to the item and click
Move in the Actions menu. Select the new place and then confirm the move.

Note:  Depending on how your community is set up, you may or may not see the
Move option in the Actions menu. If you want to move something but don't see the
Move option, ask the content's author or the owner of the place where the content
is posted to move the item for you.

Locking discussions and questions
You can lock discussion and question threads so that no more replies are allowed.

If you're an administrator, place owner, or moderator, you can ensure that no one
will be able to add more replies to a discussion or question (that is, discussion
marked as question) thread.

• To lock a discussion or question, go to the thread and click Lock in the right
sidebar.

Note:  Depending on how your community is set up, you may or may not see the
Lock option in the Actions menu. If you want to lock something but don't see the
Lock option, ask the owner of the place where the content is posted to lock the item
for you.
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What are feeds?
Feeds are a way for you to keep track of Jive content updates without having to
visit the application.

By subscribing to the content feed, you're asking to have easy access to information
about content changes or additions. A feed, or an aggregator, brings you a list of
updates that you can view in a feed reader. RSS and Atom are popular feed types.

Subscribing to feeds is an alternative to receiving email notifications, in which an
email is sent each time content is changed or added (although you can also do
both). You might prefer email notifications if you want to receive updates in a more
passive but immediate way. You can set email notifications on individual items, or
customize your email notification settings to get emails about par ticular kinds of
activity; for more information, see Customizing notifications on page 30.

You can subscribe to feeds for content lists (such as a list of blogs, discussions,
documents, or status updates you'd view), spaces, or discussion threads. For more
information, see Using feeds on page 157.
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Content visibility options
You can limit to selected people the visibility of content that you create, or hide it
completely from other people. Here is a reference of the visibility options of all
content types.

Content visibility reference
Here you can find details on who can see content items in various places in the
community and which content types cannot be hidden.

Your personal content

Documents
and uploaded
documents

• Description: When you publish a document as Hidden, it is stored
in your personal container and is private to you.

• Are streams updated?: You can see a stream update when you
publish, but other users cannot.

• To set the item as Personal: Before you publish the document,
set its visibility to Hidden. For more information, see Creating
documents for yourself on page 78

• To find the item later: Go to Content > Authored > Documents
, and then select Filter by personal content. The dark lock icon
next to the document indicates it is limited to you.

External
bookmarks • Description: Your private bookmarks are stored in your personal

container and are private to you.

• Are streams updated?: You can see a stream update when you
save the bookmark, but other users cannot.

• To set the item as Personal: Go to  > Bookmark  and paste
in the external URL. Then, select Make this bookmark private
and save it.

• To find the item later: Click the Spotlight search and select
Bookmarked > Show all bookmarks . In the main navigation
menu, filter by External URL. The dark lock icon next to the
bookmark indicates it is limited to you.

Personal
tasks • Description: You can assign yourself personal tasks so that no

one else can see them.

• Are streams updated?: You can see a stream update when you
publish, but other users cannot.

• To set the item as Personal: Go to  > Task  and select
Project > None (personal task) .

• To find the item later: Go to Actions > Tasks . In the Project
menu, select Personal.
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Content limited to specific people

Documents
and • Description: When you publish a document limited to Specific

People, it is stored in your personal container and is private to you
and the other people you designated.

uploaded
documents

• Are streams updated?: You and the other specified people see
a stream update when you publish, but other users cannot.

• To set the item as Personal: Before you publish the document,
set its visibility option to Specific People.

• To find the item later: Go to Content > Authored > Documents
and then select Filter by personal content. The light lock icon
next to the document indicates it is limited to you and the other
people you designated.

Discussions
• Description: When you publish a discussion limited to Specific

People, it is stored in your personal container and is private to you
and the other people you designated.

• Are streams updated?: You and the other specified people see
a stream update when you publish, but other users cannot.

• To set the item as Personal: Before you post the discussion, set
its visibility option to Specific People.

• To find the item later: Go to Content > Authored > Discussions
and then select Filter by personal content. The light lock icon
next to the item indicates it is limited to you and the other people
you designated.

Messages
• Description: You can send one or more other users a private

message.

• Are streams updated?: Messages are listed in the Inbox. They
do not appear in streams.

• To set the item as Personal: Go to  > Message  and select
the persons to whom you want to send the message.

• To find the item later: Go to Inbox. In the Filter drop-down menu,
select Messages.

Content that you cannot hide

• Blog posts.

• Discussions.

• Polls.

• Status Updates. However, you can limit your status update to a group if you want
to limit its audience. For more information, see Posting status update in groups
on page 59

• Projects.
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Setting up content visibility options
If you're concerned about privacy, you can limit who sees different par ts of your
profile by editing your privacy settings.

To limit profile visibility:

1. Go to Your avatar > Edit Profile .

2. Go to the Privacy tab.

3. For each profile field, select who can view it.

If you select everyone, then all users can see the contents of that field. Your
community administrator may control who sees cer tain fields, such as those
without a Visible to option.

4. Take a look at how others can see your profile by using the Preview your profile
tool in the upper right corner of the page.

5. Click Save to save the changes.

Creating direct messages and private discussions
By using messages and private discussions, you can limit your audience to only the
people you want.

Messages and private discussions show up in the Inbox of only the people you send
them to. These are useful features, but the power of Jive is that nearly all topics in
the community can be helpful to others, so try to keep things public whenever pos-
sible.

To send a message to someone, do one of the following:

• In your Inbox, click Send Message.

• Select  > Message .

• Click Message from the top of any of your attention streams.

• Hover over the person's name in any of your attention streams and click Message.

After your message is sent, the receiver can see it in their Inbox. From there, the
receiver can respond directly.

To create a private discussion:

1. Click  > Discussion  to create a discussion, then enter the title and details
of the discussion.

2. Select Specific People under Publish Location.

3. Select the participants you want to include in the discussion.

4. When you're finished drafting the discussion, click Post.
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Only the participants you selected can see a discussion notification in their Inbox.
From there, they can respond to the discussion.

Saving drafts
You can use the Save As Draft feature to quickly jot down and save your thoughts
in documents or blog posts. Then, you can come back later to edit and publish your
content. You can also collaborate with others on saved drafts before publishing
them.

You can save blog posts and documents as drafts. This can be useful if you need
time to finalize your thoughts before publishing something. Additionally, drafts are
not visible in any streams.

Creating and editing drafts

To save a blog post or a document as a draft:

1. Create and fill in a document or blog post.

2. Click Save Draft.

The document is saved as a draft and is not visible to anyone. You can find it on
the Drafts tab of Your Content.

To edit a draft:

1. Go to Your Avatar > Your Content  in the main navigation menu, and then click
Drafts in the left sidebar to see your drafts.

2. If required, filter your Drafts results by documents or blog posts.

3. Click on the draft to edit the content.

4. Click Publish to save and publish the draft.

You can edit the content and save it again as a draft, or publish it.

Collaborating on drafts

You can collaborate on drafts of blog posts or documents before you publish them
or share an existing draft with other users.

To get people to collaborate on an existing draft:

1. Open the draft.

2. Click Share in the upper right corner of the page.

3. In the Share dialog box, select the people you want to share the post with and
include a message for them.

4. Click Share.

The recipients are able to edit the draft and either save it as a draft or publish it.
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Remote access
You can access and interact with a community from a mobile device.

Accessing community from mobile devices
Jive is accessible from mobile devices using the mobile Safari browser or by installing
the Jive Daily Hosted app on your mobile device.

For more information about accessing community from a mobile browser, see Using
community from mobile browsers on page 15.

For more information about using apps, see the Jive Daily Help.

Posting replies without logging in
When you reply to a community email from your email program, your reply is posted
directly into your community.

If your community manager has turned on this feature, you can post a reply to
something by replying to a notification email. You first need to set your user Prefer-
ences to receive email notifications on a particular stream, so that when someone
updates something you follow in that stream, you get an email about it. For more
information on how email notifications work, see Customizing notifications on page
30.

• To reply by email, click Reply in your email program, then type your discussion
reply just as you'd type a reply to an email and send the email.

If the community is set up to receive replies via email, your reply is posted as if
you'd logged in to your community and posted it from there.

Creating new content without logging in
If your community supports it, you can post new content by sending an email to the
community.

This feature can be especially useful for posting when you can't reach the commu-
nity using a browser. For example, you can email content from a cell phone that
sends email.

Each place in your community provides email addresses for the content you can
post via email. For example, you can send an email to the address corresponding
to documents in a place, and a new document will be created there. Use the email
addresses for the specific content you want to post.

The subject line of your email becomes the document's title, while the email body
becomes its content body. For status updates, you can include a subject line or
content in the email body. If you include both, the subject line and the email body
content are separated by a line break in your posted status update; if you include
only a subject line or only email body content, then that is the only content you see
in your status update.

156AUREA CONFIDENTIAL

Chapter 3: Reference and advanced topics



To create community content with email:

1. Go to a place if you want to create content in the place or your profile if you want
to create your private content.

2. Click Actions > Create via email .

You won't see this option if your administrator has not activated the ability to
create content by email.

3. Select the types of content you want to create.

4. Click Actions > Email vCards .

You should receive an email from your community that includes this vCard.

5. In your email or address book program, save the vCard as one of your Contacts.

For example, in Microsoft Outlook you can drag the vCard to your Contacts folder.
On a Macintosh, you can double-click the vCard to add it to your address book.

6. In your email application, create a new message and select the address you just
added from the vCard.

7. In the email subject, type the title you want your content to have in Jive.

8. In the body of the email, type the main part of the content. If you want to include
tags, in the last line of your email type Tags: tag1here tag2here tag3here.

This tags your content so that people can find it more easily later.

9. Send the email to create the content in the Jive place.

Using feeds
Use RSS feeds to get content updates without visiting the community.

By subscribing to a feed and using a feed reader (also known as an aggregator),
you can discover what has changed in the application without having to visit it. For
more information, see What are feeds? on page 151.

Note:  RSS subscriptions are not supported if you have SSO enabled in your
community because the RSS reader cannot follow HTTP redirects for authentication.

To subscribe to a feed:

1. To subscribe to an RSS feed:

DescriptionOptions

Go to the landing page, click , and then click
Feeds.

For places

Go to the blog landing page and click View Feeds.For blogs
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DescriptionOptions

Go to the discussion and click on the feed icon .For discussions

You can see a list of available feeds for that place.

2. To subscribe to a feed, click on the link that corresponds to the content type you
want.

You can subscribe to specific content types, such as only discussions posted in
a group or only the comments of a blog.

3. Select the application you want to use as your feed reader and click Subscribe
Now.

When you subscribe, you may need to enter your user name and password so
that Jive knows it's not giving feed information to just anyone.

Attention:  In order to subscribe to RSS feeds with Outlook 2007, you need to use
the limited workaround if you use Internet Explorer. For more information, see
http://support.microsoft.com/kb/917125.

Advanced group management
Group owners have a number of permissions that can help them effectively manage
groups and group membership.

Group owner and administrator permissions
A group administrator has almost the same abilities to manage a group as the group
owner (the one who creates the group), except a group administrator cannot delete
the group unless they are also the community administrator.

Besides deleting the group, group owners and administrators can also customize
the group landing page and manage group members, including disabling them,
deleting them, or sending them messages. For more information, see Customizing
the group landing page on page 55 and Managing group members on page 160.

Changing group settings
You can edit group details to customize your group, for example, to change the
name, description, image, and type of the group.

If you're a group owner or administrator, you can edit details such as the group's
name, description, type — the same things you entered when you created the group.
These details help people find your group and know what your group is up to. You
should think of the group details as a book cover that potential members can glance
at to decide whether the group is something they need follow to get the latest news.
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To change the group details:

1. Go to your group, and then click Manage > Settings .

2. Change to update your group information like you did when you created the group.
For more information, see Creating groups on page 51.

Making and managing announcements
Announcements can be an effective way to get people's attention.

You can post an announcement when you are the owner of a place (space, project,
or group). Announcements appear in the Inbox of users following the place and on
the banner on the home page of the place.

Caution:  If available in the community, users may also get an email when a new
announcement is posted if they selected Email for Inbox: Activity on their
Preferences page. For more about that, be sure to read Customizing Email Notifi-
cations. If you do not want Inbox and email notifications sent when you create an
announcement, be sure to uncheck the Send Inbox notifications box (checked by
default).

To create an announcement:

1. Go to the landing page where you want the announcement to appear. This can
be the landing page of a space, project, or group that you own.

2. Click the Manage > Announcements .

3. Click Add a new announcement.

4. Enter the details of your announcement and specify the beginning and expiration
dates. Decide how long the announcement should be displayed by selecting a
star t and end date.

Announcements star t at 12:00 (AM) on the star t date and expire at 23:59 on the
end date, in the announcement creator time zone.

5. If you do not want Jive Inbox and email notifications sent when you create an
announcement, clear the Send Inbox notifications box.

6. Click Save.

To share, edit, expire, or delete an announcement:

• Click Show Details on the announcement or navigate to the home page of the
space, project, or group where the announcement appears and click gear icon
> Announcements .

Note that when you expire an announcement, you are saving and hiding it, but not
deleting it. This is useful if you want to repost the announcement at a later date.
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Managing group members
By managing group members, you can make changes like disabling them, deleting
them, or sending them messages.

When managing group members, you can, among other actions, ban or disable
members, delete members from the group, and send messages to members. You
can also export member information as a contact list which can be imported into
another application, such as an email address book.

This is also the place to change a selected member's role from administrator to
member, or back the other way. An administrator role lets the member make the
same kinds of changes you can make as the group's owner.

But if you need to see a quick count of members and followers, click About on your
group's landing page. From here, you can click on the Followers and Members
links to be directed to your group's People page.

To manage group members:

1. Go to the group and click the Manage > Members .

2. To manage multiple members at once, select all members you want to modify and
then use the Modify selected list to select the action you want to apply to all
selected members.

3. Click Change > Change Role, Disable or Delete  next to the members you want
to manage.

4. Click OK .

Making bulk changes to content in places
You can make bulk changes to content items stored in a place, including applying
tags, categories, and outcomes. Also, you can move or delete a list of items. This
can be a quick and easy way to organize the content in a place better so that you
and others can find it faster later.

You need to be the place owner or have the Manage Community permissions to
make bulk changes in the place.

To make changes to content in bulk:

1. Go to the place you own and click the Manage > Bulk manage content .

2. On the Bulk manage content, select the content items to which you want to apply
the changes.

3. Click an action icon in the menu above the item list. You can do one of the
following:

DescriptionOptions

Applies the same tags to all of the selected items.Add tags
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DescriptionOptions

Applies the same categories to all of the selected
items. You won't be able to select this if categories
are not set up in your community.

Add categories

Applies the same outcomes, such as Outdated or
Final, to all of the selected items.

Set outcomes

Moves all of the selected items to the new place you
choose.

Move

Deletes all of the selected items.Delete

4. In the dialog box, review the list of items. If necessary, click Remove next to an
item to remove the item from the list.

5. Click Continue. You may need to click another Continue depending on the option
you selected.

6. Depending on the selected action, specify the settings or once again review the
issue list.

7. Click Continue.

The selected action is performed, and the results are displayed in the dialog box.

8. Click Close to close the dialog box.

Customizing News page
The News page features a variety of streams (News streams) designed to direct
users to content, people, and places of their interests.

For example, it includes an All Activity stream, which shows the recent activity from
all over the community depending on user permissions. Additionally, it also displays
the latest updates in specific streams that a par ticular user may be following or any
custom streams that the user may have created.

Attention: You must have Manage News Streams or Manage Community permissions
to create, modify, or delete News streams.

For more information on using the News page and News streams, see Using News
in the User Guide.

Overview of News
The News page is the central place for you to see what's happening in
the community. The News page features a variety of streams designed

to direct you to content, people, and places that per tain directly to you. You can
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also see your Following stream, any custom streams you have created, and the All
Activity streams, which show recent activity from all over the community that you
have permission to see.

You can see these streams individually by clicking the link to a stream in the stream
menu at the top of the page and scrolling down the page, or you can use the main
News page to overview the latest items in each stream in a combined block view.
Each block has a header that shows what stream the item came from.

Note: The News page responds to browser width by adjusting to fit all your streams
so your main navigation menu may differ slightly from browser to browser or from
screenshots in this Help. For example, you may see your News subscription streams
listed individually or collapsed into a drop-down menu.

You can pin any of the streams listed on your News page to either the News or
Home button in the main menu, depending on how your community manager has
set up the main navigation menu in your community. Just click the pin icon from the
desired stream's page, and when you click Home or News from anywhere in the
application, you are taken to the page you pinned. For more information, see Pinning
pages for quick access.

The News page also features a variety of tiles to help you find important people,
places, and content quickly. The Trending Content and Trending People tiles are
included by default but may be removed by your community manager.

Here's an overview of what you can see on the News page. For a quick visual tour
of the News interface, see News page interface on page 18.

The News view aggregates and displays content posted in your
News and Following streams. However, unlike your streams, the

News
(top-level
view) News page does not show content updates and comments in a

stream view. Content that gets updated or interacted with is not
moved to the top of the News view: this view shows only new
things.

Content is pulled in and displayed in the News view in the order
in which your streams are displayed to the right of News in the
stream menu. Duplicated content is removed if it's already being
pulled in from a higher-order stream. The content you've read (by
clicking through to it either from your desktop or a mobile version
of Jive) stays in News for two days before going away. The content
you haven't yet read stays for ten days. Because the News streams
are designed just for you, you won't see the same content pulled
into the News view that other users see.

These are the streams you see listed when you expand the menu
under News. These streams are created and managed by your

News streams

community manager or people with Manage News Streams
permissions. Because these streams are designed just for you,
you may not see the same News streams or the same content in
them that others see. For more information, see Overview of News
streams on page 19

This stream shows you the trending content in your community to
get you a feel for what's happening right now.

All Activity:
Top &
Trending
stream

162AUREA CONFIDENTIAL

Chapter 3: Reference and advanced topics



This stream shows you all community updates that you have
permission to see as they are posted in real time. Scrolling through

All Activity:
Most Recent
stream this stream can be useful for adding new people and content to

your Following or custom streams.

When you star t following people, places, and content items, they
are automatically added to this stream. Use this stream if you want

Following

to check in throughout the day but not create a lot of custom
streams. This stream is included for you by default, and you can
add to or delete content, people, and places from it.

If you've created any custom streams, you can see those listed to
the right of Following. Custom streams can be a great way to keep

Your custom
streams

up with the content, people, and places that matter most to you in
your community. For some examples of custom streams which you
might want to create for yourself, see Examples of custom streams
on page 22.

Overview of News streams
News streams that are displayed on the News page are configured for you by your
community manager and are designed to bring you the latest news from your
organization, department, team, or product. Additionally, you can create your own
custom streams to tailor the news.

Click News to find your News streams if they've been set up.

Because they are designed just for you, you may not see the same News streams
or the same content in them that others see. For example, everyone in your commu-
nity may see the CEO's Blog stream that shows the latest blog posts from your or-
ganization's CEO. However, only people in the Marketing department may have a
stream called Marketing News that shows activity from the Marketing space.

Also, you might have a News stream based on your role in the community. For ex-
ample, let's say everyone has a stream called What’s New, but what is displayed
there differs depending on the user's role. Or customers might see content pulled
from the Special Promotions blog in their What's New stream, but vendors might
see content pulled from the New Solutions group.

For more information about streams and how they work, see Overview of streams
on page 20.

Tips for creating News streams
Before you create a News stream, consider the following questions.

News streams created for everyone display information
on the News page for all registered community users. If

Does absolutely
everyone need this
information? you work in a large organization, this could include all

people across a wide variety of job roles, divisions, and
locations.
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The place you select for a News stream should not be
too noisy for the intended audience. For example, if your

How much traffic is
generated by the place

Sales group sometimes contains social chatter, consideror blog I want to share
content from? creating a more controlled group or blog that contains

only key communications, and use that one for the News
stream.

You can define audiences by selecting individual people,
by filtering on profile fields, or by selecting a user

Who needs this News
stream?

permissions group that is defined in Jive. The last two
choices may require some preparation on your par t: to
make sure you're using profile fields consistently or to
create any permissions groups you need for targeting
an audience. You may need to work with your community
manager to define user groups.

For a detailed example of how you might create News
streams for your community, see All About the News
Feature on Worx.

What are some
examples of News
streams I might create?

News page tile reference
Here is a complete list of the tiles available on the News page of your community.

Tiles are split by category, similar to tiles arrangement in the UI. Some tiles can be
available in more than one category.
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Collaboration tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Shows a full
preview of a
document you
choose to dis-
play

Docu-
ment
Viewer

  Content added
manually

Builds a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs

Helpful
Links

 Content added
manually

Shows select-
ed dates for
your team

Key
Dates

Graphic Elements tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Adds a series
of linked im-
ages with text
to promote im-
portant con-
tent

Banner

   Content added
manually

Links a rotat-
ing image
carousel to
crucial destina-
tions

Carousel

*   Content added
manually

Adds HTMLCreate
an HTML
Tile
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Creates a
slideshow with
images and
captions

Image
Gallery

  Content added
manually

Shows a manu-
ally selected
video from an
external, non-
community
source

Video
(Exter-
nal)

* The configuration of each Custom HTML tile defines if it is available on Jive Daily
for Cloud. For more information, see Using Custom HTML tiles on page 194.

Custom List tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Shows links to
community
content under
collapsible
headings

Expand-
able Sec-
tions

  Content added
manually

Builds a list of
important peo-
ple for your
place

Featured
People
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Builds a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs

Helpful
Links

  Content added
manually

Displays a list
of content and
places that
you can edit
and manage
yourself

Key Con-
tent and
Places

Dynamic List tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

 Relies on a
quest being
selected

Shows the us-
er's progress
as they com-
plete a quest

Featured
Quest

   Content added
manually.
Blogs must be
enabled

Shows the
newest blog
posts in your
community

Latest
Blog
Posts

  Relies on con-
tent being
tagged

Shows places
with the same
tags

Similar
Places
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

   Relies on a
query: click
Use this view
in a tile at the
bottom of any
People,
Places, or
Content
browsing re-
sult

Shows an up-
dated, filtered
view of con-
tent, people,
or places

Super
List

  Relies on con-
tent being
tagged

Displays con-
tent that
matches specif-
ic tags

Tagged
Content

 Relies on con-
tent from the
News streams

Displays news
headlines from
the community
that are pulled
in from each of
the News
streams

Top
News

   Relies on con-
tent getting
viewed or
liked, or both

Displays con-
tent that is
getting an in-
crease in
views and
likes

Trending
Content

  Relies on con-
tent getting
viewed or
liked, or both

Displays peo-
ple whose ac-
tivity is getting
an increase in
views and
likes

Trending
People
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Support tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

   Relies on con-
tent query.
Configure to
select content
types and
places to
query

Finds a previ-
ously asked or
answered
question, or
gives the abili-
ty to ask a
new one

Ask a
Question

  Content added
manually

Builds a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs.

Helpful
Links

   Relies on a
query: click
Use this view
in a tile at the
bottom of any
People,
Places, or
Content
browsing re-
sult

Shows an up-
dated, filtered
view of con-
tent, people,
or places.

Super
List
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External Add-Ons tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

*   Content added
manually

Creates a cus-
tom user expe-
rience by in-
ser ting HTML
content into a
tile for your
place

Create
an HTML
Tile

 Relies on a
quest being
enabled

Displays
quests for
community
members to
complete

Quests

 Content added
manually

Provides a key
image with a
link and call to
action as a
header for
your News
page

Hero Im-
age

* The configuration of each Custom HTML tile defines if it is available on Jive Daily
for Cloud. For more information, see Using Custom HTML tiles on page 194.
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Custom tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

 Content added
manually

Displays a list
of content and
places that
you can edit
and manage
yourself. This
tile and its
content can be
shared and
used by other
people in the
community

Create a
Content
or Place
Tile

 Content added
manually. This
tile and its
content can be
shared and
used by other
people in the
community

Build a list of
important peo-
ple for your
place

Create a
People
Tile

Configuring News FAQ
Here are some frequently asked questions and answers about setting up the News
page and news streams.

People with Manage News Streams permissions have
the rights to modify the News page and create, modify,

Who can create and
modify the News page

or delete news streams for this page for the entireand news streams on the
page? community, including those set up by other people with

Manage News Streams permissions. People with
Manage Community permissions already have these
rights.

Yes, if you are an owner or member of the secret place.
Be aware when you add a secret place to a news stream

Can I add a secret place
to the News stream?

to be displayed on the News page that other users with
Manage News Streams or Manage Community
permissions are able to see this stream. However, they
are not able to modify or delete a News stream that has
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a secret place of which they are not an owner or
member.

There can be up to 10 news streams on the News page
configured in your community. This does not include

Is there a limit to the
number of News streams
the community can have? each user's ability to create up to 10 custom streams

of their own; so a user can see up to 10 News streams
and 10 of their own custom streams listed in the left
sidebar.

You can have up to 100 rules in a News stream. Within
each rule, audiences and places are essentially
unlimited.

How many rules can I
have per News stream?

Yes. Just use the Single Custom Links feature in the
theming interface.

Can I change the name of
the News link on the
navigation bar?

You can turn off Top & Trending in through a system
property. You can submit a ticket to support asking for
the following system property change: recommender.en-
abled = false.

How do I turn off Top &
Trending?

This removes the Top & Trending stream from being
introduced into the News aggregation.

Designing activity and custom pages for places
To customize a space, group, or project with a preconfigured set of content options
designed for specific collaboration goals, you can use your Activity page as the
landing page, and then apply and configure a place template.

An Activity page shows a real-time activity stream of updates happening in the place,
such as status updates and replies to content.

Place templates are the star ting point for setting up an Activity page: each template
contains an activity stream, plus a configurable group of tiles that reflect common
collaboration goals. When you edit an existing place, create a group, star t a project,
or (if you have permission) create a new space, you can choose a temple from a
list of pre-designed place templates. You need to quickly set up a few essential tiles
to star t collaborating in reality-tested environments such as:

• An Event Planning place for organizing the material for an upcoming event

• A Vendor Collaboration place for par tnering with external talent

• A private Pre-Hire Collaboration place for discussing potential job candidates
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When you use a place template, you can add or remove any tiles and move them
around within the layout. Tiles are visual building blocks of information. They may
dynamically pull data either from around your Jive installation or a third-party service,
or they may be configured with the information you've hand-selected.

Adding custom pages to places
If you are a place owner, you can add your own custom pages to a place to allow
more flexibility in designing places for specific needs. For example, you might add
a Product Schedule page that shows your upcoming shipping dates and product
owners.

For communities with widgets enabled, you need to set the place to Activity + Pages
to see this option. For more information, see Adding Overview page on page 56.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

You can add a new page to your place to spotlight and organize content in that
place. Once you add a page, you populate it with tiles tailored for that place. For
example, you may want to dedicate a page to one important document by using a
Document Viewer tile, or you may want to add a creative flair to your place by using
an HTML tile.

You need to be able to edit a place to add tiles to Activity and custom pages.

Note: Your community manager determines the number of custom pages you can
add to a place. The default number is five.

To add a new custom page to your place:

1. In your group, click Manage > New page .

2. In the Create a page dialog box, enter a name for your page.

3. Select the column layout you want for the new page.

4. Click OK.

The page opens for editing.

5. Add and configure the tiles you want to appear on the new page.

You must add at least one tile.

6. Click Save.

New pages appear first in the place navigation menu.

• To make changes to your page, go to the page and click the Gear icon > Edit
page .

Attention:  If you enable widgets and reset the place pages to Overview or Activity
+ Overview and save that change, you'll no longer see the new page you just created.
However, if you then reset the navigation to Activity + Pages and save that change,
you'll see your custom page again. You don't actually lose any new pages you have
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created if you change the place pages. You just don't see them when the place
pages are set to Overview or Activity + Overview.

Applying place templates
When you apply a place template to an existing project, space, or group, you get a
preconfigured Activity page that contains the tiles and layout included in the template.

Applying a place template to a place only affects the Activity page in that place. It
changes the selection of tiles on the Activity page and the order in which they're
displayed.

: When you apply a new place template to a place whose tiles have been configured,
you lose all configuration in the tiles. For example, if you created a People list, it
will be wiped out and replaced with empty, unconfigured tiles, even if the place
template includes a People tile. The exception is that Salesforce authentication
persists if you apply a different place template that uses a Salesforce connection.

To apply a new Place Template to an existing place:

1. In your place, click the Manage > Settings  to open the Activity page for editing.

2. Click Browse Templates in the upper left corner of the page.

3. Choose a place template for this place.

Place templates determine what tiles and streams provide the layout and data for
your group's Activity page. You should choose the one that's right for the kind of
collaboration that is planned to happen in your place. For more information, see
Place template reference on page 179.

4. Click Apply Template, and then confirm your decision.

5. To configure the existing tiles, do the following:

a) Click  on the tile and configure it.
b) Click Apply in the tile dialog box.

6. To add a new tile, click Add a tile, then select the tile and configure it.

7. Click Save to update the place with your changes.

The Activity page that is based on the applied template is configured for your place.

Adding tiles to Activity page
You can use tiles to display specific information that you want the visitors to see in
a place. Here you can find how to add tiles to the Activity page of a place.

You need to be able to edit a place to add tiles to Activity and custom pages.

Tiles display useful information on Activity and custom pages of a place. For more
information about tiles, see Using tiles on page 191 and Tile reference on page 201.
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To add tiles to the place Activity page:

1. In your place, click the Manage > Settings  to open the Activity page for editing.

2. Click Add a tile.

3. In the dialog box, select a category on the left, and select the tile that you want
to add on the right.

Note:  Note that the list of tiles that appears for selection is different for wide and
narrow columns respectively. Once added, these tiles can be moved ver tically
within the same column or removed within the layout as required.

4. If required, configure the tile by clicking the gear icon at the upper right corner
of the tile and adjusting the tile parameters, and then click Apply.

The tile is added to the page.

5. If required, adjust the tile position in the layout column by using the arrows in the
upper right corner of the tile.

6. Click Save to save the page changes.
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The Activity page opens with the tiles you set up for the page.

Adding tiles with external stream integrations to
Activity page
External stream integrations are available along with tiles on your place Activity
page. You can configure the Activity page to display information from the external
streams.

External stream integrations display information from external systems, such as a
Facebook stream. Note that a relevant add-on must be installed and configured in
the community. For example, to receive information from a Facebook stream the
Facebook add-on must be installed in the community.

You need to be able to edit a place to integrate external streams into the Activity
page.

To integrate external streams to tiles on the place Activity page:

1. In your place, click the Manage > Settings  to open the Activity page for editing.

2. Click External File Storage.

3. Select external stream integration that you want to add.

4. If necessary, configure the tile. The settings depend on the external stream you
want to add.

5. Click Save to save the page.

The tile displays information from the external stream.

Adding tiles to custom pages
You can use tiles to display specific information that you want the visitors to see in
a place. Here you can find how to add tiles to the custom pages of a place.

You need to be able to edit a place to add tiles to Activity and custom pages.

Tiles display useful information on Activity and custom pages of a place. For more
information about tiles, see Using tiles on page 191 and Tile reference on page 201.

To add tiles to a custom page:

1. In your place, click the gear icon > Edit <page title> page .

The custom page you selected opens for editing.

2. Click Add a tile.
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3. In the dialog box, select a category on the left, and select the tile that you want
to add on the right.

Note:  Note that the list of tiles that appears for selection is different for wide and
narrow columns respectively. Once added, these tiles can be moved ver tically
within the same column or removed within the layout as required.

4. If required, configure the tile by clicking the gear icon at the upper right corner
of the tile and adjusting the tile parameters, and then click Apply.

The tile is added to the page.

5. If required, adjust the tile position in the layout column by using the arrows in the
upper right corner of the tile.

6. Click Save to save the page changes.

The custom page opens with the tiles you set up for the page.

Managing page navigation in places
You can rearrange the custom pages if they are enabled. But you can't change the
order of the predefined pages.

You need to be able to edit a place to manage place navigation.
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To reorder links to custom pages in the place navigation menu:

1. In the place, open a custom page and then click Edit page.

2. To reorder custom pages, drag and drop the page lines to where you want to see
them on the place navigation menu.

3. Click Save to save the changes.

Creating a new place template
You can create a new place template based on a currently configured place. Custom
pages are not saved within the new template.

You need to have rights to edit a place to save it as a template.

Fastpath: Place > Manage > Save as new template

If you want to create a new place template, you can base one on the tiles included
in an existing place you've configured and saved. For example, if you create a group
by using the General Collaboration template, but add and delete some tiles to include
different information in that group, you can use Save as new template to save the
layout of the tiles as a Place Template. Then you can apply that template to other
places you create.

Note:  If you have Community Manager rights, you can save place templates as
community templates so that other people in the community can use them.
Alternatively, only you can see your saved templates in Your Templates.

A template saves the type, order, and layout of tiles for a place. It does not save
the configuration of those tiles. If you've created lists of links using the Helpful Links
tile, for example, and saved a template based on that place, places with that template
applied will have the Helpful Links tile in the same position. But they will not include
the link list you created. This is true even if you later reapply that template to the
same group.

To create a template based on an existing place:

1. In your place, click the Manage > Settings  to open the Activity page for editing.

2. Change the tiles until the layout looks the way you want.

For more information, see Adding tiles with external stream integrations to Activ-
ity page on page 176.

3. Click Save to save them to the current template.

Note:  Custom pages you add are not saved within the template.

4. Click Gear icon > Save as new template  and specify a name and description
for the new template.

This option becomes available only if you have customized the current template.
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5. Provide a name and tags for the new template.

Tags are used to populate the Similar Places tile.

6. Click Save.

The new template is saved, and you can see it under Your Templates when browsing
place templates.

Place template reference
Each place template contains a selection of tiles customized for a specific
collaborative activity, such as Sales or IT. Here you can find references for the
templates to help you understand which templates you can access.

Templates are organized according to the kind of workgroup that typically uses
them, but you can rename and customize any template. The right template contains
more or less the tiles that you need. For example, if you want to set up a place to
track items identified for quick follow-up, you could pick the Sales Answer Desk
template when creating the place, even if Sales isn't your main goal. This template
includes a Featured People tile to identify people you can direct questions to, tracks
items marked for Action and recent decisions, and surfaces popular content.

For more information about creating place templates, see Creating a new place
template on page 178. For more information about data tiles and the information
they're based on, see Place tile reference on page 212.

It's possible to develop custom tiles that aren't included in the product, including
tiles for third-party integrations. For the latest developer information and programming
tutorials, see the Jive Developer por tal at https://developers.jivesoftware.com/.

Restriction:  If your community does not have additional modules enabled, you
may not see some of the feature options that are listed and your options may be
different.
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General place template reference
General place templates are useful for general collaboration cases not focused on
a specific business function, and can easily be used as the base for custom
templates.

Default tagsDefault typeFeaturesTilesPlace template

—Public
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Top Partici-
pants

Key Content
and Places

Featured Con-
tent

Recent Deci-
sions

Finalized Con-
tent

Team Collabora-
tion

best practicePublic
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Featured Con-
tent

Popular Con-
tent

Image Gallery

Top Partici-
pants

Key Dates

Best Practices
Sharing
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Default tagsDefault typeFeaturesTilesPlace template

—Public
Documents

Discussions

Status Updates
(in groups only)

Projects

Gauge

Finalized Con-
tent

Action Items

Top Partici-
pants

Featured Con-
tent

War Room

—Public
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Gauge

Featured Con-
tent

Helpful Links

Featured Peo-
ple

Key Dates

Customer 360
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Corporate Communications place template reference
Corporate Communications place templates include selections of tiles focused on
sharing videos, live events, communications planning, and blogging.

Default tagsDefault typeFeaturesTilesPlace template

blogsPublic
Blogs

Status Updates
(in groups only)

Top Partici-
pants

Featured Con-
tent

Popular Con-
tent

Blog Central

corp commsPrivate
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Key Dates

Featured Con-
tent

Action Items

Recent Deci-
sions

Finalized Con-
tent

Image Gallery

Communica-
tions Planning

event, streamPublic
Documents

Status Updates
(in groups only)

Top Partici-
pants

Key Dates

Live Event Activ-
ity Streaming
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Human Resources place template reference
Human Resources place templates include selections of tiles focused on HR team
communications and pre-hire communication with future employees.

Default tagsDefault typeFeaturesTilesPlace template

—Public
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Featured Con-
tent

Popular Con-
tent

Image Gallery

Top Partici-
pants

Key Dates

Best Practices
Sharing

IT place template reference
Information Technology (IT) place templates include selections of tiles focused on
technology rollouts, helpdesk support, and upgrade planning.

Default tagsDefault typeFeaturesTilesPlace template

best practicePublic
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Featured Con-
tent

Popular Con-
tent

Image Gallery

Top Partici-
pants

Key Dates

Best Practices
Sharing
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Default tagsDefault typeFeaturesTilesPlace template

Technology
Rollout and
Support

technologyPublic
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Video (Exter-
nal)

Featured Con-
tent

Finalized Con-
tent

Key Dates

Helpful Links

helpdeskPublic
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Featured Con-
tent

Popular Con-
tent

Helpful Links

Action Items

Recent Deci-
sions

IT Helpdesk
Collaboration
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Default tagsDefault typeFeaturesTilesPlace template

it, upgradePublic
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Key Dates

Action Items

Featured Peo-
ple

Helpful Links

Image Gallery

IT Upgrade
Planning

request_for_pro-
posal, rfp

Private
Documents

Discussions

Status Updates
(in groups only)

Projects

Key Dates

Popular Con-
tent

Finalized Con-
tent

Leaderboard or
Top Partici-
pants

Key Content
and Places

Gauge

RFP Workgroup
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Marketing place template reference
Marketing place templates include selections of tiles focused on assembling
marketing campaigns and collateral.

Default tagsDefault typeFeaturesTilesPlace template

eventPrivate
Documents

Discussions

Ideas

Status Updates
(in groups only)

Projects

Key Dates

Featured Con-
tent

Gauge

Popular Con-
tent

Recent Deci-
sions

Event Planning

agency, cus-
tomer, par tner,
vendor

Private

Externally-ac-
cessible

Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Key Dates

Top Partici-
pants

Helpful Links

Finalized Con-
tent

Action Items

Customer, Part-
ner, or Vendor
Collaboration
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Default tagsDefault typeFeaturesTilesPlace template

assets, cam-
paign

Private
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Top Partici-
pants

Finalized Con-
tent

Action Items

Key Content
and Places

Key Dates

Campaign Plan-
ning

success_sto-
ries, win

Public
Blogs

Documents

Status Updates
(in groups only)

Top Partici-
pants

Featured Con-
tent

Popular Con-
tent

Customer Suc-
cess Stories
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Research and Development place template reference
Research and Development (R&D) place templates contain selections of tiles focused
on innovation and collaboration R&D organizations, including FAQ and vendor
collaboration.

Default tagsDefault typeFeaturesTilesPlace template

best practicePublic
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Featured Con-
tent

Popular Con-
tent

Image Gallery

Top Partici-
pants

Key Dates

Best Practices
Sharing

development,
research

Public
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Action Items

Popular Con-
tent

Top Partici-
pants

Recent Deci-
sions

R&D Planning
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Sales place template reference
Sales place templates include tiles for information used to plan and close deals,
including integrations with Salesforce.

Default tagsDefault typeFeaturesTilesPlace template

salesPublic
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Popular Con-
tent

Key Content
and Places

Video (Exter-
nal)

Featured Con-
tent

Featured Peo-
ple

Sales Home

questions,
sales

Public
Videos

Discussions

Blogs

Documents

Projects

Popular Con-
tent

Helpful Links

Featured Peo-
ple

Action Items

Recent Deci-
sions

Sales Answer
Desk

189AUREA CONFIDENTIAL

Designing activity and custom pages for places



Default tagsDefault typeFeaturesTilesPlace template

request_for_pro-
posal, rfp

Private
Documents

Discussions

Status Updates
(in groups only)

Projects

Key Dates

Popular Con-
tent

Finalized Con-
tent

Top Partici-
pants

Key Content
and Places

Gauge

RFP Workgroup
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Default tagsDefault typeFeaturesTilesPlace template

competitionPrivate (unlist-
ed)Documents

Discussions

Blogs

Status Updates
(in groups only)

Projects

Featured Peo-
ple

Top Partici-
pants

Featured Con-
tent

Popular Con-
tent

Key Content
and Places

Competition

—Public
Discussions

Polls

Blogs

Documents

Ideas

Projects

Videos

Events

Status Updates
(in groups only)

Gauge

Featured Con-
tent

Helpful Links

Featured Peo-
ple

Key Dates

Customer 360

Using tiles
Tiles display useful information in Activity and custom pages for places, News page,
and Your View pages.

• You have plenty of options to choose from when adding a tile to a place. Look
through the categories to see all of your options. For more information, see Tile
reference on page 201.
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Two useful tiles that you can choose are the Top Participants and Upcoming
Events tiles:

Figure 1: Example of tiles

• Different tiles are available in different places. Activity and custom pages, News,
and Your View all have different tile options.

Note:  If you own the place, you can choose whether or not to show these default
tiles, and you can also add different tiles.

• You can use a tile as is or customize it to display specific information. For more
information, see Designing activity and custom pages for places on page 172.

Creating Custom tiles
Custom tiles can include links to helpful content, people, and places in your
community, and links external your community.

If you are a place owner, you can create custom tiles that include a list of links to
helpful content, people, and places in your community, and to links outside your
community. Your custom tiles are available to all of the places that you own. Com-
munity managers can create custom tiles and make them available to all places in
the community.
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A custom tile provides links to content, people, or places. For example, a custom
tile might be helpful for an HR group to list all of this month's new hires and include
a link to the community's Onboarding group. An Engineering space might find it
useful to have a list of the team's power users with a link to an external documenta-
tion site, like this:
Figure 2: An example of a custom tile

To create a custom tile, first you add a tile, and then configure it to include the links
you want to feature:

1. Go to your place.

2. To open the Activity page for editing, select Manage > Settings .

3. To open a Custom page for editing, open the page and click Edit page.

4. In a narrow column, click Add a tile.

5. Under Categories, select Custom Tiles.

6. Choose the kind of tile you want:

DescriptionOptions

Use this tile if you want to create links to specific
content items and/or places in your community.

Create a Content or
Place tile

Use this tile if you want to create links to specific
people in your community.

Create a People tile

The added tile opens the configuration dialog box. Alternatively, you can click

the gear icon  to configure the tile.

7. In Title, enter the tile a name.

The tile name should describe the tile's content, such as Accounting Superstars
or Engineering Docs.

8. Click Add Content or Place to add the links to the content, people, or places
that you want this tile to display.

9. Optionally, you can add a link to the bottom of the tile to an internal community
page or an external URL by clicking Add an action link to the tile footer.
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10.Select the security type for this tile. The available options may differ depending
on your permissions:

DescriptionOptions

Locking the tile makes you the only person who can
edit it. Other owners of the place can remove the tile
from the place, but they cannot edit it. If you edit the
tile, note that all instances of the tile (in other places
that you own) are updated.

If you do not lock the tile, any changes that you or
other place owners make to the tile affect all instances
of the tile.

Lock tile contents

Only users with Manage Community permissions see
this option. All place owners in the community are
able to use this tile.

If the tile is locked, all place owners are able to use
the tile but not edit it.

Save as global tile for
others in the community
to use If the tile is not locked, all place owners are able to

edit the contents of the tile but not its title. If other
place owners edit the content of the tile, all instances
of the tile in the community are updated.

11.Click Apply.

Using Custom HTML tiles
If you are a place owner, you can create an HTML tile containing custom HTML
code.

Overview of Custom HTML tiles
You should be aware of some aspects of Custom HTML tiles before you star t
designing them.

The HTML tile lets you provide customized HTML in a mobile-friendly tile on a place
page. It replaces the HTML widget that was available in previous versions. For more
information about using HTML tiles, see Adding an HTML Tile to a Page on Worx.
For information about the capability of this tile versus a developer-created tile and
the HTML widget, see Custom HTML in Your Jive Community on Worx.
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HTML tiles on mobile devices

You can control visibility of each HTML tile. Depending on the complexity of your
HTML, you may have concerns about whether your presentation can be displayed
effectively on a mobile device. Setting the tile to be mobile-unfriendly means that
it won't be displayed when the page is viewed on a mobile device or in narrow
browser width. If you've designed your HTML to be responsive, you can safely enable
Mobile Friendly. For more information, see Creating custom HTML tiles on page
195.

Link types in HTML tiles

The HTML Tile add-on differentiates between 3 types of links:

• Absolute, for example <a href='http://localhost/groups/mygroup1/content'>Ab-
solute</a>

• RootRelative, for example <a href='/groups/mygroup1/content'>RootRelative</a>

• Relative, for example <a href='content'>Relative</a>

In the examples above, the HTML tile is placed within a group named mygroup1
and that the instance URL is localhost. After being resolved, all three links redirect
to the same URL address: http://localhost/groups/mygroup1/content.

Creating custom HTML tiles
You add a tile and then add your custom code to it to create your custom tile.

Note that for HTML tiles to be available on mobile devices, your community must
be appropriately configured. For more information, see Overview of Custom HTML
tiles on page 194.

To create a Custom HTML tiles:

1. Go to your place.

2. To open the Activity page for editing, select Manage > Settings .

3. To open a Custom page for editing, open the page and click Edit page.

4. Click Add a tile.

5. Under Categories, select Graphic Elements.

6. Under Tiles, select Create an HTML tile.

7. In the Your HTML dialog box, provide your HTML code.

8. To upload files for the tile, click Manage Files and upload the necessary files.

9. In Height (px), specify the height of the tile, in pixels.

You can specify the height of the tile as you want to. By default, it is set to 250
pixels for narrow tiles and 520 pixels for wide tiles. Note that with long tiles users
may be required to scroll down to view all tile information.

10.If the tile responsive and the HTML code is mobile-friendly, under Mobile Friendly
select Yes.

11.If the tile is not responsive, under Mobile Friendly select No.

12.Click Preview to see how the tile looks like.
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13.Click Submit to enter the tile to the page.

14.Click Save to save the page changes.

The HTML tile is added to the page.

Creating Super List tile
The Super List tile displays a filtered list of content, people, or places. You create
the filter link, and then paste it into your Super List tile to get the results.

To create a filter link and add it into your tile:

1. Decide if you want information from the entire community or only information from
a place to show up in your tile.

a) If you want to see place content only in your super list then browse to the place,
and select Content.

b) If you want to see people, places, or content across the entire community, then
append your community name with /people, /places, or /content.
https://community.aurea.com/content

2. Filter and sor t results that you want to see in the super list.

3. Copy the URL from the browser or click Use this view in a tile > Copy to
clipboard .

4. Go to your place.

5. To open the Activity page for editing, select Manage > Settings .

6. To open a Custom page for editing, open the page and click Edit page.

7. In either a wide or narrow tile, click Add a tile.

8. Select Lists - Dynamic > Super List .

9. Paste the link into the Paste filter link here box.

10.If you pasted a link to filtered content, choose one of the following options:
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DescriptionOptions

Use this view to show title, author, and post dateBasic list

Use this view to show title, snippet of content, and,
if available, number of comments, replies, likes, and
views.

Detailed list

Use this view to show original content author avatar
and name, post date, content icon and title, a
thumbnail of an image (if available), a snippet of
content

Rich Preview

11.You can change the title and the number of items to display.

12.Click Apply to save the tile settings.

13.Click Save to save the page changes.

A Super List tile is added to your place.

Creating Ask a Question tile
An Ask a Question tile provides a field where users can type their question. As they
type, search results are shown in the tile, and if no answers are found, they can
create a new question from the tile.

When you add an Ask a Question tile to a place, the tile searches for all content
types within the place. If a user does not find an answer, this place is also used as
the default place for creating a question.

To add an Ask a Question tile:

1. Go to your place.

2. To open the Activity page for editing, select Manage > Settings .

3. To open a Custom page for editing, open the page and click Edit page.

4. In either a wide or narrow column, click Add a tile.

5. Select Support > Ask a Question .

The tile is added to the page.

6. Click Save to save the page settings.

An Ask a Question tile to your place.
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Creating Answered and Unanswered Questions Tiles
The Answered Question and Unanswered Questions tiles can be beneficial in places
where people ask questions and look for answers. These tiles help place visitors
see at a glance what's been asked and answered.

The Answered Questions tile lists the place's recently answered questions, for ex-
ample, questions that include a reply marked as Correct Answer. This tile can be
helpful in places where people go to find answers, such as a Customer Support
group or IT space. The Answered Questions tile also helps users understand that
the place is active and effective — questions are being asked and answered.

The Unanswered Questions tile helps encourage users to answer questions they
see listed in the tile. You might also use the Unanswered Questions tile to determine
upcoming work projects. For example, the manager of an accounting space might
use the unanswered questions tile for project planning.

1. Go to your place.

2. To open the Activity page for editing, select Manage > Settings .

3. To open a Custom page for editing, open the page and click Edit page.

4. Click Add a tile.

5. Under Lists - Dynamic, select either the Answered Questions or Unanswered
Questions tile.

6. In Title, specify the title for the tile.

The default title is Answered Questions or Unanswered Questions depending on
selected the tile. For example, in your place, it might be more appropriate to call
the tile as Correct Answers.

7. In Sort by, select whether you want the newest or oldest questions to display
first in the list.

8. In Number of items to display, specify the maximum number of questions to be
displayed in the tile.

By default, the limit is set to 10 questions. The number cannot exceed
25 questions.

9. When you're finished configuring the tile, click Save.

10.Click Save to save the page settings.

The tile is added to the page. If the place has questions, they are listed in the
appropriate tile.
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Using Content sets and Content Sets tiles
The Content Sets tile creates a browse sequence for key content on a custom page
in a place. It can connect any combination of content, as long as it's inside the
place.

By using the Content Sets tile, you can create a named set of content inside a place.
This content is displayed in a linked browse sequence that indicates the order of
reading. Content sets can include any kind of content that resides in the place where
you're creating the set. Content sets are a powerful way to link and organize content
within a place. For example, if you want to create a short guide that steps someone
through a conceptual background, procedure, or other subjects that requires a
specific order, you can bring together documents, discussions, and status updates
in a single presentation.

Content sets are available only from custom pages in a place. If you navigate to the
same piece of content in a different way, for example, if you find a document in a
set by searching, you won't see it in the context of the set.

Building a content set

To begin creating a content set, you need to first make sure the content you want
to include exists in the place where you're creating the set. If you're an administrator
of the place, you can then add the Content Sets tile while adding or editing a custom
page.

Removing content in a content set

You can remove an item from a set by editing the content set, but deleting the
content or moving it into a different place also removes the content page from the
set. If you delete all the content items in a section of a content set, the section is
also removed.

Comparing Content Sets and Expandable Sections tiles

When you configure them, a Content Sets tile looks very similar to an Expandable
Sections tile: the Content Set tile shows an ordered list of content (which also shows
a collapsible view of content links with) and the Expandable Sections tile descriptions
and section headings. However, the Content Sets tile is designed as a por tal for
reading a group of linked items in sequence, while Expanded Sections presents an
organized set of quick links from around the community. The two tiles have the fol-
lowing important differences:
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Expandable SectionsContent Sets

Anywhere in the community, in-
cluding personal or private con-
tent

Only content posted in the Place
where the tile is

Content Source

One-way click-through from the
tile page to each page in the set

Move from page to page in the
set without leaving the content
group or returning to the tile
page

Navigation

Your View, custom pages, and
Activity pages

Custom pages and Activity pagesLocation

Using Expandable Sections tiles
The Expandable Sections tile lets you create a collapsible list of content links inside
a tile on a place page, an Activity page, or your Your View page.

By using the Expandable Sections tile, you can organize content from around the
community in an annotated list with headings. Your presentation of the linked content
is displayed inside the tile. Website developers sometimes call this presentation an
Accordion.

Expandable Sections can include any content you can see so that you can include
content in private or secret (also known as private unlisted) groups. This makes the
tile useful in Your View. Note that people who don't have access to the linked content
won't see the links. They also won't see any sections that only contain links to
content they can't see.

Removing content

You can remove an item by editing the tile, but deleting the content also removes
the content page from the tile. If you delete all the content items in a section of a
content set, the section is also removed.

Comparing Content Sets and Expandable Sections tiles

When you configure them, a Content Sets tile looks very similar to an Expandable
Sections tile: the Content Set tile shows an ordered list of content (which also shows
a collapsible view of content links with) and the Expandable Sections tile descriptions
and section headings. However, the Content Sets tile is designed as a por tal for
reading a group of linked items in sequence, while Expanded Sections presents an
organized set of quick links from around the community. The two tiles have the fol-
lowing important differences:

200AUREA CONFIDENTIAL

Chapter 3: Reference and advanced topics



Expandable SectionsContent Sets

Anywhere in the community, in-
cluding personal or private con-
tent

Only content posted in the Place
where the tile is

Content Source

One-way click-through from the
tile page to each page in the set

Move from page to page in the
set without leaving the content
group or returning to the tile
page

Navigation

Your View, custom pages, and
Activity pages

Custom pages and Activity pagesLocation

Troubleshooting tiles
You can diagnose and fix common problems with tiles by looking at our
troubleshooting tips.

Relative URLs in HTML tiles are resolved incorrectly

The relative links in the existing HTML tiles sometimes may be resolved incorrectly,
and the resulting URL in the tile is malformed. With Jive 2019.1 we provide a fix to
this issue that affects all newly created tiles and a workaround for fixing up existing
tiles.

To fix an existing HTML tile, do the following:

1. Create a new HTML tile.

2. Copy-paste the HTML code from an original HTML tile to the new tile.

3. Delete the original HTML tile.

Tile reference
Your View, Activity, and News pages all contain tiles. Here you can find references
for these tiles to help you understand which tiles you can access and from where.

For more information about tiles, see Using tiles on page 191.

Tiles support in Jive Daily Hosted

The tiles you add to pages are displayed in the Jive Daily Hosted app in one column
regardless of the tile layout selected for the page. You should also note that the
app supports not all tiles; you can find the details in this section.

Your View tile reference
Here's a list of the tiles available on a Your View page.

Tiles are split by category, similar to tiles arrangement in the UI. Some tiles can be
available in more than one category.

Note: This page is not supported by Jive Daily Hosted.
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Collaboration tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Content added
manually

Shows a full pre-
view of a document
you choose to dis-
play

Document
Viewer

 Content added
manually

Builds a list of key
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs

Helpful Links

 Content added
manually

Shows selected
dates for your team

Key Dates

Graphic Elements tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

 Set manuallyShows status on a
gauge

Gauge

  Content added
manually

Shows a manually
selected video from
an external, non-
community source

Video (Exter-
nal)
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Custom List tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Content added
manually

Shows links to com-
munity content un-
der collapsible
headings

Expandable
Sections

 Content added
manually

Builds a list of im-
portant people for
your place

Featured
People

 Content added
manually

Builds a list of key
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs

Helpful Links

 Content added
manually

Displays a list of
content and places
that you can edit
and manage your-
self

Key Content
and Places

Dynamic List tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Relies on an algo-
rithm

Shows the people,
places, and content
you visit most

Frequently
Viewed

  Content added
manually. Blogs
must be enabled

Shows the newest
blog posts in your
community

Latest Blog
Posts
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Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Relies on an algo-
rithm

Shows the people,
places, and content
you viewed recently

Recently
Viewed

 Relies on content
being tagged

Shows places with
the same tags

Similar
Places

  Relies on a query:
click Use this view
in a tile at the bot-
tom of any People,
Places, or Content
browsing result

Shows an updated,
filtered view of con-
tent, people, or
places

Super List

 Relies on content
being tagged

Displays content
that matches specif-
ic tags

Tagged Con-
tent

  Relies on an algo-
rithm

Shows content
that's attracting
views and interac-
tions

Trending
Content
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Support tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

 Content added
manually

Build a list of useful
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs.

Helpful Links

  Relies on a query:
click Use this view
in a tile at the bot-
tom of any People,
Places, or Content
browsing result

Shows an updated,
filtered view of con-
tent, people, or
places

Super List

News page tile reference
Here is a complete list of the tiles available on the News page of your community.

Tiles are split by category, similar to tiles arrangement in the UI. Some tiles can be
available in more than one category.
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Collaboration tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Shows a full
preview of a
document you
choose to dis-
play

Docu-
ment
Viewer

  Content added
manually

Builds a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs

Helpful
Links

 Content added
manually

Shows select-
ed dates for
your team

Key
Dates

Graphic Elements tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Adds a series
of linked im-
ages with text
to promote im-
portant con-
tent

Banner

   Content added
manually

Links a rotat-
ing image
carousel to
crucial destina-
tions

Carousel

*   Content added
manually

Adds HTMLCreate
an HTML
Tile
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Creates a
slideshow with
images and
captions

Image
Gallery

  Content added
manually

Shows a manu-
ally selected
video from an
external, non-
community
source

Video
(Exter-
nal)

* The configuration of each Custom HTML tile defines if it is available on Jive Daily
for Cloud. For more information, see Using Custom HTML tiles on page 194.

Custom List tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Shows links to
community
content under
collapsible
headings

Expand-
able Sec-
tions

  Content added
manually

Builds a list of
important peo-
ple for your
place

Featured
People
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Builds a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs

Helpful
Links

  Content added
manually

Displays a list
of content and
places that
you can edit
and manage
yourself

Key Con-
tent and
Places

Dynamic List tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

 Relies on a
quest being
selected

Shows the us-
er's progress
as they com-
plete a quest

Featured
Quest

   Content added
manually.
Blogs must be
enabled

Shows the
newest blog
posts in your
community

Latest
Blog
Posts

  Relies on con-
tent being
tagged

Shows places
with the same
tags

Similar
Places
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

   Relies on a
query: click
Use this view
in a tile at the
bottom of any
People,
Places, or
Content
browsing re-
sult

Shows an up-
dated, filtered
view of con-
tent, people,
or places

Super
List

  Relies on con-
tent being
tagged

Displays con-
tent that
matches specif-
ic tags

Tagged
Content

 Relies on con-
tent from the
News streams

Displays news
headlines from
the community
that are pulled
in from each of
the News
streams

Top
News

   Relies on con-
tent getting
viewed or
liked, or both

Displays con-
tent that is
getting an in-
crease in
views and
likes

Trending
Content

  Relies on con-
tent getting
viewed or
liked, or both

Displays peo-
ple whose ac-
tivity is getting
an increase in
views and
likes

Trending
People
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Support tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

   Relies on con-
tent query.
Configure to
select content
types and
places to
query

Finds a previ-
ously asked or
answered
question, or
gives the abili-
ty to ask a
new one

Ask a
Question

  Content added
manually

Builds a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs.

Helpful
Links

   Relies on a
query: click
Use this view
in a tile at the
bottom of any
People,
Places, or
Content
browsing re-
sult

Shows an up-
dated, filtered
view of con-
tent, people,
or places.

Super
List
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External Add-Ons tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

*   Content added
manually

Creates a cus-
tom user expe-
rience by in-
ser ting HTML
content into a
tile for your
place

Create
an HTML
Tile

 Relies on a
quest being
enabled

Displays
quests for
community
members to
complete

Quests

 Content added
manually

Provides a key
image with a
link and call to
action as a
header for
your News
page

Hero Im-
age

* The configuration of each Custom HTML tile defines if it is available on Jive Daily
for Cloud. For more information, see Using Custom HTML tiles on page 194.
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Custom tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

 Content added
manually

Displays a list
of content and
places that
you can edit
and manage
yourself. This
tile and its
content can be
shared and
used by other
people in the
community

Create a
Content
or Place
Tile

 Content added
manually. This
tile and its
content can be
shared and
used by other
people in the
community

Build a list of
important peo-
ple for your
place

Create a
People
Tile

Place tile reference
Here's a complete list of the tiles available on the Activity and custom pages of a
place. You may also see other custom tiles in Your View that are not listed here
which have been created by your community manager.

Tiles are split by category, similar to tiles arrangement in the UI. Some tiles can be
available in more than one category.

Note: You can see different options depending on which features are enabled in
your community.
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Your tiles

DependenciesDescriptionTile

You must first create a New Con-
tent, People, or Places tile to see
the Your Tiles option under Cate-
gories.

Any custom tiles you have created
are listed here

Your Custom
Tile Name

These tiles are not supported by Jive Daily Hosted.

Collaboration tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Relies on con-
tent being
marked as
Needs Action

Tracks the
content that
needs follow-
up actions

Action
Items

  

Custom
page on-

ly

  Relies on cate-
gories config-
ured in the
current place

Displays con-
tent in select-
ed categories

Cate-
gories

  

Custom
page on-

ly

  Content added
manually

Shows a full
preview of a
document you
choose to dis-
play

Docu-
ment
Viewer

  

Custom
page on-

ly

  Relies on con-
tent being
marked as
Featured

Shows content
marked as
Featured

Featured
Content

  Relies on con-
tent being
marked as Fi-
nal

Shows content
that has been
marked Final

Finalized
Content
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Builds a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs

Helpful
Links

 Content added
manually

Show selected
dates for your
team.

Key
Dates

  

Custom
page on-

ly

  Relies on con-
tent getting
viewed and
liked

Shows content
that's getting
views and
likes

Popular
Content

  Relies on con-
tent being
marked as De-
cision

Shows the
most recent
items that
were marked
as Decision

Recent
Deci-
sions

 Relies on con-
tent from the
Events plugin

Shows events
created in your
place

Upcom-
ing
Events
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Graphic Elements tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

   Content added
manually

Adds a series
of linked im-
ages (up to 5)
with text to
promote impor-
tant content

Banner

    Content added
manually

Link a rotating
image
carousel to
crucial destina-
tions

Carousel

 

Custom
page on-

ly

  Content added
manually

Creates a cus-
tom user expe-
rience by in-
ser ting HTML
content into a
tile for your
place

Create
an HTML
Tile

 Set manuallyShows status
on a gauge

Gauge

   Content added
manually

Creates a
slideshow with
images and
captions

Image
Gallery

   Content added
manually

Shows a manu-
ally selected
video from an
external, non-
community
source

Video
(Exter-
nal)

 

Custom
page on-

ly

  Content added
manually

Display a
video from
anywhere on
the Internet

Video
(Fea-
tured)
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Custom List tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
columnDepen-

denciesDescriptionTile

  

Custom
page on-

ly

  Relies on
cate-
gories
config-
ured in
the cur-
rent
place

Display content in
selected categories

Cate-
gories

 

Custom
page on-

ly

  Content
added
manually

Shows community
content inside a tile,
in a browse se-
quence you design.

Content
Sets

   Content
added
manually

Shows links to com-
munity content un-
der collapsible
headings

Expand-
able Sec-
tions

  Content
added
manually

Builds a list of im-
portant people for
your place

Featured
People

  Content
added
manually

Builds a list of key
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs.

Helpful
Links

  Content
added
manually

Displays a list of
content and places
that you can edit
and manage your-
self

Key Con-
tent and
Places
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Dynamic List tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Relies on con-
tent being
marked as
Needs Action

Tracks the
content that
needs follow-
up action

Action
Items

  

Custom
page on-

ly

  Relies on dis-
cussions
marked as
questions that
include a reply
marked as
Correct An-
swer or As-
sumed An-
swered

Displays a list
of questions
that have been
answered in
the place

An-
swered
Ques-
tions

  

Custom
page on-

ly

  Relies on con-
tent being
marked as Add
as Featured
Content

Shows content
that's been
marked as
Featured

Featured
Content

 Relies on a
quest being
designated

Shows your
progress in
completing the
featured quest

Featured
Quest

  Relies on con-
tent being
marked as Fi-
nal

Shows content
that has been
marked as Fi-
nal

Finalized
Content

    Content added
manually.
Blogs must be
enabled

Shows the
newest blog
posts in your
community

Latest
Blog
Posts

  

Custom
page on-

ly

  Relies on con-
tent getting
viewed and
liked

Shows content
that is getting
views and
likes

Popular
Content
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Relies on con-
tent being
marked as De-
cision

Shows the
most recent
items that
were marked
as Decision

Recent
Deci-
sions

  Relies on con-
tent being
tagged

Shows places
with the same
tags

Similar
Places

    Relies on a
query: click
Use this view
in a tile at the
bottom of any
People,
Places, or
Content
browsing re-
sult

Shows an up-
dated, filtered
view of con-
tent, people,
or places

Super
List

  Relies on con-
tent being
tagged

Displays con-
tent that
matches specif-
ic tags

Tagged
Content
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Populated
when activity
happens in the
place. Note
that this tile
uses the same
information as
the status lev-
els in your
community

Shows fre-
quent contribu-
tors to the
place

Top Par-
ticipants

  

Custom
page on-

ly

  Relies on dis-
cussions
marked as
questions that
do not yet
have a reply
marked as
Correct An-
swer or As-
sumed An-
swered

Displays a list
of questions
that have not
yet been an-
swered in the
place

Unan-
swered
Ques-
tions
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Support tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  

Custom
page on-

ly

  Relies on dis-
cussions
marked as
questions that
include a reply
marked as
Correct An-
swer or As-
sumed An-
swered

Displays a list
of questions
that have been
answered in
the place

An-
swered
Ques-
tions

   Relies on con-
tent query.
Configure to
select content
types and
places to
query

Finds a previ-
ously asked or
answered
question, or
asks a new
one

Ask a
Question

  Content added
manually

Build a list of
key links for
quick refer-
ence. Links
can be internal
to your commu-
nity or external
URLs

Helpful
Links
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Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

    Relies on a
query: click
Use this view
in a tile at the
bottom of any
People,
Places, or
Content
browsing re-
sult

Shows an up-
dated, filtered
view of con-
tent, people,
or places

Super
List

  

Custom
page on-

ly

  Relies on dis-
cussions
marked as
questions that
do not yet
have a reply
marked as
Correct An-
swer or As-
sumed An-
swered

Displays a list
of questions
that have not
yet been an-
swered in the
place

Unan-
swered
Ques-
tions
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External Add-Ons tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

 Relies on the
account de-
tails from
Salesforce.
Requires a
Salesforce ac-
count

Pulls in the
details of an
account from
Salesforce

Account
Info

 Relies on the
account de-
tails from
Salesforce.
Requires a
Salesforce ac-
count

Pulls in the
details of an
opportunity
from Sales-
force

Opportu-
nity Info

 Relies on the
account de-
tails from
Salesforce.
Requires a
Salesforce ac-
count

Shows the
probability de-
tails of a
Salesforce op-
portunity in
gauge format

Opportu-
nity
Gauge

    Content added
manually

Creates a cus-
tom user expe-
rience by in-
ser ting HTML
content into a
tile for your
place

Create
an HTML
Tile
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Custom tiles

Jive Dai-
ly sup-

port

Jumbo
column

Wide col-
umn

Narrow
column

DependenciesDescriptionTile

  Content added
manually

Displays a list
of content and
places that
you can edit
and manage
yourself. This
tile and its
content can be
shared and
used by other
people in the
community

Create a
Content
or Place
Tile

  Content added
manually

Build a list of
important peo-
ple for your
place. This tile
and its content
can be shared
and used by
other people in
the community

Create a
People
Tile

Designing Overview pages for places
Overview pages with image-based navigation can quickly direct your users to useful
pages. You can define the content and layout of Overview pages for places that you
have administrator rights.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.
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Places (social groups, projects, and spaces) become more inviting when you cus-
tomize their overview pages to display the items members care about most. Depend-
ing on your overview page customization rights, you can get these pages to look
the way you want by using widgets that help you choose and arrange content. For
more information about permissions, see Customization permissions for Overview
pages on page 233.

Each widget displays content of a par ticular kind — for example, HTML, recent
content, or feed subscription results — in a box that you can drag into position on
a page. After you publish the page, you can always come back and update its content
or design. A complete reference to available widgets can be found in Widget refer-
ence on page 233. For the steps for customizing overview pages, see Setting up
Overview page on page 225.

Attention: Widgets are not responsive in design and are not recommended to use
in communities which rely on being available from mobile devices. We recommend
that you use Activity or custom pages with tiles instead of Overview pages. For more
information, see Designing activity and custom pages for places on page 172.

Overview page best practices

Here are a few key guidelines for designing pages with widgets.

• Make sure the widgets you choose help users to identify the purpose of the place
and quickly find the information they need.

• Note that with widgets, less is more. Highly complex pages can lead to
performance challenges as well as user confusion. You should use only as many
widgets as you need to provide essential information for the place without
overloading it.

• Make sure you limit the number of images on the page. Loading many images on
every page load can make your page slower and create visual clutter.

• Limit group and space ownership to one or a very few users to safeguard your
design and protect security.

Adding Overview page
When widgets are enabled in your community, you can add an Overview page to a
place.

Overview pages are based on widgets while other pages, such as Activity and custom
pages are based on tiles. Please note that tiles provide a better user experience
and perform better, especially on mobile devices.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

If you want a place to have an Overview page, you can add either an Overview page
or both Activity and Overview pages. You can't enable Overview and Custom Tile
pages for a place at the same time.
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Tip:  If you use the checkpoint and status functionality for tracking project tasks,
you may want to stick with the old-style Overview page rather than updating to the
Place Template format. The widgets in the Overview page more effectively support
Projects at this time.

For more information about Overview pages, see Designing Overview pages for
places on page 223.

Adding an Overview Page to a place

To use an Overview page in your place:

1. Go to the landing page for your place and click the Manage > Settings > About
. The Edit Group page opens.

2. Click Advanced Options .

3. Select Overview or Activity + Overview.

4. If prompted, select the landing page, that is, determine which page must open
when a user opens the place.

5. Click OK.

6. Click Save at the bottom of the page.

The Overview page is added to your place and becomes visible to other users.

Setting up Overview page
You can customize the layout of your place Overview page to organize it better and
display your group's information.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

The Overview page must be added to your place. For more information, see Adding
Overview page on page 56.

When you customize the Overview page for a place, you decide on a column view,
then drag widgets into the layout.

To customize the Overview page of a place:

1. In your place, click the Manage > Overview page .

2. Under Layout, select the layout for the page.
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Note that the available widgets depend on the layout you selected.

3. Under Widgets, select a widget you want to add and drag it into one of the layout
columns below.

4. To configure the widget, click  > Edit this widget  in the upper right corner of
the widget, and specify its properties in the dialog box.
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For example, the configuration dialog box of a Recent content tile looks like this:

5. Click Save Properties to save the widget settings.

6. For every widget you want to add, repeat Steps Step 3 on page 226-Step 5 on
page 227.

7. To remove a widget, click  > Remove this widget  in the upper right corner of
the widget.

8. To save all your changes, click Publish Layout.

The changes are saved, and the updated page becomes visible to other users.

Setting up Search widget
The Search widget allows your users to quickly search a specific space or group in
your community, or community as a whole.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

You must be able to edit the place where you want to add the widget. For more in-
formation, see Customization permissions for Overview pages on page 233.

To add a Search widget to the Overview page of your place:

1. In your place, click the Manage > Overview page .

2. From the widgets list, select Content > Search Widget .

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small tr iangle in the upper right corner of the widget and select Edit
this widget.

5. In Custom title, enter the title for the widget.

You can use the default title (Search) or create your own, for example, Search
Here.
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6. In Number of Results, enter the number of results to return in the search.

7. In Place to Search, select the place to perform the search. Do one of the following:

• Leave the box blank to search the current place.
• Type a place name to search the selected place. This can be any place in the

community, or the entire community (which would be your root space).

8. Click Save Properties.

9. When you're finished making changes to your place's layout, click Publish Layout.

The changes are saved, and the updated page becomes visible to other users.

Setting up Image Navigation widget
With this widget, you can provide your users with image-based navigation to quickly
direct your users to useful pages. First, you add the Image Navigation widget to
your place layout, then add images and links to the widget.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

You must be able to edit the place where you want to add the widget. For more in-
formation, see Customization permissions for Overview pages on page 233.

First, you add the Image Navigation widget to your place's layout, then add images
and links to the widget.

Adding Image Navigation widget
To add an Image Navigation widget to your place layout:

1. In your place, click the Manage > Overview page .

2. From the widgets list, select Other > Image Navigation Widget .

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small tr iangle in the upper right corner of the widget and select Edit
this widget.

5. In Custom title, enter the title for the widget.

You can use the default title (Image Navigation Widget), create your own, or leave
the box blank if you do not want any title.

6. In Hide Header and Border, select whether you want the header and border to
be displayed.

7. Click Save Properties.

The Add a new link button appears in the widget.

Adding images to the widget
After you've added the Image Navigation widget to your place layout, you can images
and links to the widget, then publish the updated layout of the place.

228AUREA CONFIDENTIAL

Chapter 3: Reference and advanced topics



To add images to the widget:

1. In the widget, click Add a new image link.

2. In Provide a Target Link, type in the URL to which you want the image to link.

3. Provide a caption for the image.

You can use the caption Jive provides automatically, or overwrite it with your
own.

4. Select the image you want to use for this link.

5. Click Save.

6. Repeat these steps until you have all the images you want to display in the widget.
The limit is 8. You can move them around to change the order in which they are
displayed by dragging and dropping them.

7. When you are finished, click Publish Layout on the editing page.

Setting up Ask widget
The Ask (place) widget allows users to quickly ask a question in a specific space
or group in your community, or the entire community. After the user types a question
into the Ask widget, the search function displays possible answers based on matching
keywords. If the user doesn't see the correct answer in the results list, they can
create a discussion right from the widget. This can be especially helpful in places
designed to support customers or employees.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

You must be able to edit the place where you want to add the widget. For more in-
formation, see Customization permissions for Overview pages on page 233.

To add an Ask (place) widget to the Overview page of your place:

1. In your place, click the Manage > Overview page .

2. From the widgets list, select Content > Ask (place) .

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small tr iangle in the upper right corner of the widget and select Edit
this widget.

5. In Custom title, enter the title for the widget.

You can use the default title (Ask (place)) or create your own, for example, Ask
Us a Question.

6. In Submit button text, enter the text to be displayed on the Ask button.

You can use the default text or create your own, for example, Submit Your
Question.

7. In Search From, select a place you want to perform the initial search.
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You can search in the current place, a single place that you specify, or all public
places in the community (the root space).

8. In Number of Results, enter the number of results to return in the search.

9. In Display Results, select which search results must be displayed. You can select
one, some, or all of these options:

DescriptionOptions

Displays in search results all questions that have been
asked, whether or not they have been answered.

All Questions

Displays only discussions in search results.All Discussions

Displays only Answered Questions in search results.Answered Questions

Displays only documents in search results.Documents

10.In Post Questions to, select the place to which you want questions posted.

The place can be different from the place where the Ask widget is located. For
example, you could put the Ask widget in an Employee Questions group, but post
the questions to the Employee Q&A group.

11.Click Save Properties.

12.When you're finished making changes to your place's layout, click Publish Layout.

The changes are saved, and the updated page is available to other users.

Setting up Answered Questions widget
The Answered Questions widget allows your users to quickly see a list of questions
that have been answered in a specific space or group in your community, or the
entire community. Answered questions displayed in this widget are those that include
a reply marked as a Correct Answer.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

To add an Answered Questions to the Overview page of your place:

1. In your place, click the Manage > Overview page .

2. From the widgets list, select Content > Answered Questions .

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small tr iangle in the upper right corner of the widget and select Edit
this widget.

5. In Custom title, enter the title for the widget.

You can use the default title (Answered Questions) or create your own, for
example, Recently Answered.
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6. In Number of Results, enter the number of answered questions to display in the
widget.

7. In Show Oldest Questions First, select the order in which you want the answered
questions to be displayed.

8. In Place, specify the place from which you want to pull the answered questions.
Typically, this the current place is used, but it could be any other place in the
community as well, or the entire community (this would be your "root" space).

9. Click Save Properties.

10.When you're finished making changes to your place's layout, click Publish Layout.

The changes are saved, and the updated page is available to other users.

HTML and Formatted Text widgets
The HTML and Formatted Text widgets are designed to display customized
information on Overview places, including the community Home page. They are
flexible but should be used carefully to ensure effective, performant pages.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

You can use HTML and Formatted Text widgets to embed all kinds of assets, includ-
ing images. These widgets are often used to provide visual orientation or branding
to the site or the place. The HTML widget also allows you to add JavaScript and
CSS elements, with cer tain security limitations, which are described later in this
topic.

Uploading resources to a widget

You can use the Formatted Text and HTML widgets to upload up to 10 file resources
per place. Spaces can include any kind of files: groups and projects are limited to
GIF, JPEG, PNG and BMP files. Files you upload are stored as part of your commu-
nity so you don't have to retrieve them from an external location, which can improve
performance and saves you the trouble of hosting them elsewhere. You can then
refer to these resources in any Formatted Text or HTML widget you have access to
edit. For detailed instructions, see Uploading files to widgets on page 232.

: The resources you upload this way are posted on the Internet and can be viewed
by anyone with access to the network. By design, they don't inherit the authentication
requirements of your site or the permissions to the place where you upload them.

Managing performance

Uploading resources is a good way to limit the performance impact of resource
loading from your widgets: uploaded resources don't need to be authenticated on
page load. However, you should consider user page loads when determining the
number and content of widgets.
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Managing HTML widget security

To ensure security and prevent problems that can corrupt your pages and keep them
from loading, any HTML widget code that calls a <script> tag is contained in an
isolated iFrame. This is known as the Safe mode. If you want to include CSS or any
other styling in the widget, you can include it in the same location as your HTML
code. Isolation of the HTML widget also means that the widget can't borrow
JavaScript from the Overview page, and that visual components cannot extend be-
yond the perimeter of the iFrame. Simple HTML, JavaScript, and CSS continue to
be supported.

In the Safe mode, you can still call the assets associated with the core Jive instal-
lation as follows:
<script src="/resources/scripts/jquery/jquery.js"/>
<link rel="stylesheet" href="/styles/jive.css" media="all"/>

It's possible for your site administrator to use a system property to override the
default Safe mode behavior (iFrame isolation) and allow external JavaScript access
from the HTML widget. However, this approach requires caution and is not recom-
mended. In previous versions, before the Safe mode was implemented for widgets,
it was possible for corrupted widget code to cause serious problems that affected
the database.

Widget upload access should be limited to users you trust. Because any social group
owner can upload resources to these widgets, it's possible for users to make incorrect
judgments about appropriateness and security, so make sure group owners are
carefully chosen.

Uploading files to widgets
You can use the Formatted Text and HTML widgets to upload file resources into
Jive so that you can link to them directly by using their URL.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

You can upload any kind of static file from a menu inside the Formatted Text and
HTML widgets. You can also see the available uploaded resources and copy their
URLs so you can use them in your widget code. You can upload up to 300 files per
place.

: The resources you upload this way are posted on the Internet and can be viewed
by anyone with access to the network. By design, they don't inherit the authentication
requirements of your site or the permissions to the place where you upload them.

To upload or delete a static resource:

1. In your place, click the Manage > Overview page .

2. Under Layout, click Widgets > Other > HTML  or Widgets > Other > Formatted
Text .

3. Click Manage Files.

This opens the Manage Files dialog box.
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4. Click Upload a File.

Note that in groups and projects you can upload only image files.

Your file is added to the Your uploaded files list.

5. To copy the URL so you can use it to refer to the file in this or another widget,
click Copy to Clipboard.

6. To delete a file, return to the Manage Files dialog box, and then click the x next
to a file name.

Deleting a file breaks links and references to the file. Make sure you're not using
the file in any widgets before deleting the file.

7. When you're finished making changes to your place layout, click Publish Layout.

Customization permissions for Overview pages
The Overview pages of places are customizable. Here you can find who can change
what on place Overview pages.

Who can customizeDescriptionPage

A space administratorIs displayed on the
Overview tab of space

Space-
Overview

The project's creator. Space and group
owners can edit projects that belong in
the space or group

Is displayed on the
Overview tab of a
project

Project
Overview

All group ownersIs displayed on the
Overview tab of a group

Group Overview

Community managerIs displayed the landing
page of your community
(if configured)

Community
Overview
(Home)

Widget reference
Different widgets are available in different types of pages. Here you can find
references for these widgets to help you understand which tiles you can access and
from where.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

Restriction:  If your community does not have additional modules enabled, you
may not see some of the feature options that are listed and your options may be
different.
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The following tables show the types of widgets that can be used to customize place
overview pages, as described in Designing Overview pages for places on page 223.

Content widgets

Used InDescriptionName

AllShows questions that have had a reply
marked as the Correct Answer

Answered Ques-
tions

AllAllows a user to ask a question while type-
ahead search tries to answer it with a link to
content in the place. If search does not find
a match, it prompts the user to ask the ques-
tion by creating a new discussion in the place

Ask [place name]

Group Overview,
Space Overview

Displays upcoming events for the space or
group in a calendar format

Note that you must have the Events plugin
installed to see and use this widget.

Event Calendar

AllDisplays a specific event from any place. The
event ID is located in the URL for the event,
for example, http://yourcommunity/ver-
sion/events/1000. In this case, the ID is 1000

Note that you must have the Events plugin
installed to see and use this widget.

Event View

AllShows the featured content (place owners
can designate content items to feature).

Featured Content

Group Overview,
Project Overview,
Space Overview

Shows a featured video

Note that you must have the Video plugin in-
stalled to see and use this widget.

Featured Video

AllShows the most recent poll created in the
current place

Latest Poll

AllShows the most liked content. Can be cus-
tomized to show any combination of recent
discussions, documents, polls, and blog posts
from the current place

Popular Content

AllShows the most commonly used tags in the
current place

Popular Tags

AllShows the most liked videos

Note that you must have the Video plugin in-
stalled to see and use this widget.

Popular Videos

AllDisplays a list of the most recent activity to
show what people are doing

Recent Activity

AllShows the first 200 characters of a specific
user's blog posts, plus images from the blog

Recent Blog
Posts
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Used InDescriptionName

AllCan be customized to show any combination
of recent discussions, documents, polls, blog
posts, and bookmarks from the current place

Recent Content

AllDisplays the recent ideas of the place.

Note that you must have the Ideation plugin
installed to see and use this widget.

Recent Ideas

AllDisplays the recent videos of the place.

Note that you must have the Video plugin in-
stalled to see and use this widget.

Recent Videos

AllAllows users to search a place. Note that you
can point this widget to any other place in the
community, not just its containing space. For
example, your Human Resources space could
search the Wellness group from this widget

Search

AllDisplays the most recent event that uses a
specific tag that you define.

Note that you must have the Events plugin
installed to see and use this widget.

Tagged Event

Project OverviewDisplays the upcoming tasks in this projectTasks

AllShows the top ideas in the communityTop Ideas

AllShows the content with the most likes in the
current place

Top Liked Con-
tent

AllShows the content with the highest rating in
the current place

Top Rated Con-
tent

AllShows discussions in the current place that
have been marked as a question, but have
not yet been marked as Answered

Unanswered
Questions

AllOn the Home page, displays all visible upcom-
ing events in the system. For all other places,
displays the upcoming events for the place.

Note that you must have the Events plugin
installed to see and use this widget.

Upcoming Events

AllShows blog post titles, a 200-character ex-
cerpt, or the full content of blog posts in a
specified place

View Blogs

AllDisplays a document you selectedView Document

AllShows community content that is tagged with
one or more tags that you specify when set-
ting up this widget. This widget is keyed to
the official Tags of content and does not show
content with inline #hashtags or @mention
text in the body of the content

Watch a Tag
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Place widgets

Used InDescriptionName

AllShows a list of community places that
you designate

Featured Places

AllShows similar groups to the current groupGroups

Home PageShows the places around the community
in a list view sor ted by place type

Places

Group Overview,
Space Overview

Shows the associated projects of the
place

Projects

Group OverviewShows a list of groups similar to the cur-
rent group

Related Groups

Project OverviewShows a list of projects similar to the
current project

Related Projects

Home Page, Space
Overview

Shows the sub-spaces of the current
space in a grid view

Space Grid

Home Page, Space
Overview

Shows the sub-spaces of the current
space in a tree view.

Space Tree

Home Page, Space
Overview

Shows the sub-spaces of the current
space in a list view

Spaces

People widgets

Used InDescriptionName

AllDisplays the selected user profile image
and basic information with an optional
description

Featured User

Project OverviewShows the people who have joined the
project

Members

Home pageShows the people who most recently
joined the community

Newest Members

AllDisplays a list of the most recent activity
to show what people are doing

Recent Activity

Group OverviewShows the people who most recently
joined the group

Recently Joined

AllShow the people who created or replied
to the most activity. Note that user status
points displayed in this widget refer to
points earned in the given place only

Top Participants
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Other widgets

Used InDescriptionName

AllDisplays the Action links through which
people can create content for a place

Actions

Group Overview,
Project Overview,
Space Overview

Displays the administrator-defined cate-
gories for a place

Categories

Project OverviewShows project milestonesCheckpoints

AllDisplays your text with formatting, links,
and images

Formatted Text

Group OverviewDisplays an image and description for the
group

Group Overview

AllRenders your HTML with JavaScript or
even CSS. You can add custom buttons
to this widget using the <button> class

HTML

AllDisplays a clickable menu of images and
captions linked to locations you select

Image Navigation

Group overview,
Space overview,
Home page

Shows a list of community members who
have earned the most Rewards, as con-
figured by the place owner

Individual Leaders

Project OverviewShows checkpoints and tasks due in
coming weeks

Project Calendar

Project OverviewShows the project's graphic, owner, and
creation date

Project Overview

Project OverviewShows an owner-determined status for a
project

Project Status

Home pageDisplays a random quick tip about using
the community

Quick Tips

AllDisplays results of a feed from another
part of the community or from another
web site

RSS Subscription

AllEmbeds rich images and news content
into a carousel widget

Slideshow Carousel

Space OverviewShows space graphics, description, tags,
and creation date

Space Overview

Home page, Group
Overview, Project
Overview, Space
Overview

Adds actions for quick sharing of the
page outside of the community. The wid-
get must be enabled in the community

Social Media
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Sharing Exchange calendars in an HTML Text widget
If you are using an Exchange 2010 SP1 or later email server, you can set up a
community widget to show user Exchange calendars, with customizable levels of
visible calendar details.

Important: We do not recommend that you use widgets and widgetized Overview
pages in your community. For more information, see Understanding pages in places.

Caution:  Calendar sharing uses Exchange Web Services to make HTML and iCal
versions of users calendars available. Depending on your Exchange topology, this
can (and will) publish calendar URLs to the Internet, where they could be viewed
by anyone. If you want to prevent this, make sure you have a secure firewall in
place.

To share an Exchange calendar, first, you set up sharing profiles on the Exchange
side, then publish shared calendars in your community.

To set up your Exchange server for sharing:

1. Create a calendar sharing profile.

2. Enable the calendar sharing profile for each user for whom you want to have a
visible calendar in the community.

Note: You cannot share calendars contained in public folders. A shared calendar
must be a user mailbox.
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To publish shared calendars in your community:

1. Ensure that calendar publishing is enabled on your Exchange server. To do this,
you can use the following Exchange PowerShell commandlet:
Get-OwaVirtualDirectory | ft server, Name, CalendarPublishingEnabled

2. Enable calendar publishing with the following command:
Set-OWAVirtualDirectory "SERVER\owa (Default Web Site)"
–CalendarPublishingEnabled:$true

3. From the Exchange Management Shell, create a new calendar sharing profile and
enable anonymous shares:
New-SharingPolicy -Name "Calendar Sharing Policy"

4. Set the sharing policy on user mailboxes who wish to share their calendars:
Set-Mailbox -Identity User.Mailbox -SharingPolicy "Calendar Sharing Policy"

5. Notify the target users to share their calendars either via Outlook 2010 or via
Outlook Web Access.

6. When the user publishes a shared calendar, copy the full text of the Link for
viewing calendar in a web browser. This link usually looks like this:
https://YOUR.MAIL.SERVER/owa/calendar/GUID@YOURDOMAIN.PUBLIC/DIFFERENT_GUID/calendar.html

7. In the community place where you want to share calendars, add an HTML widget.

8. In the widget, include the link you copied in Step 6 in an iframe tag as follows:
<iframe
src="https://YOUR.MAIL.SERVER/owa/calendar/GUID@YOURDOMAIN.PUBLIC/DIFFERENT_GUID/calendar.html"
width="1200" height="800"></iframe>

9. Save the HTML tile.

10.Save and publish your changes to the place.

A page with a shared calendar may look like this:
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Advanced project management
If you administer projects in Jive, you can move, archive, or transfer ownership of
projects and the tasks they contain.

Moving projects between places
Jive provides the ability to move a project from one place to another.

You need to own the project in order to move it, and you must have the appropriate
permissions for the place you are moving it into.

To move your project:

1. Go to the project by finding it on the Projects tab of the place where it was
created, or searching for it in Places > Projects .

2. From the project home page, select Manage > Move Project  in the upper right
corner of the page.

3. Select to the new project location.

4. Confirm the move by clicking Yes - move it here.

The project and all its content is moved to the selected place.

Archiving projects
You can archive a project, which removes it from the active projects list
of its parent space and prevents new content from being added to the
project, such as tasks, discussions, and documents. You need to own

the project to archive it, and you must have the appropriate permissions for its
parent place as well.

To archive your project:

1. Go to the project by finding it on the Projects tab of the place where it was
created, or searching for it in Places > Projects .

2. When the project opens, select Manage > Archive Project  in the upper right
corner of the page.

3. Confirm by clicking Archive.

You can see archived projects by going to Places > Projects  and then selecting
Show archived projects.
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Restoring archived projects
Restoring an archived project adds it back to the active projects list and allows new
content to be added to it, such as tasks, discussions, and documents.

You need to own the project in order to restore it.

To restore an archived project:

1. Go to the project by finding it on the Projects tab of the place where it was
created, or searching for it in Places > Projects .

2. When the project opens, select Manage > Unarchive Project  in the upper right
corner of the page.

3. Confirm archiving the project by clicking Restore from archive.

Transferring project ownership
If you own a project, you can pass that responsibility along to someone else. If the
container for the project is restricted to members, the new owner must have access
to that space or group.

Note:  In addition to the project owner, the space or group admin of the place where
the project resides can also edit the project details.

To transfer project ownership to someone else:

1. Go to the project by finding it on the Projects tab of the place where it was
created, or searching for it in Places > Projects .

2. When the project opens, select Manage > Settings , and then click About.

3. Click x on the user name in the Project Owner section.

4. Select the new owner by either typing the new project owner's name or clicking
Select Person to browse a list of all users.

5. Click OK.
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Accessing projects
In some cases, you may not be able to access some projects. Here you can find the
most common reasons.

The following actions may prevent you from accessing your project:

• The project ownership has been transferred to someone else. For more information,
see Transferring project ownership on page 241.

• The project has been moved to a place you can no longer access. For more
information, see Moving projects between places on page 240.

• The project has been archived. You should be able to see an archived project by
going to Your Places > All > Projects , and then selecting Show archived
projects. For more information, see Archiving projects on page 240.

Using email
You can use email to receive a regular digest of the interesting activities in the
community, create content and reply to content by using email.

You can find more information about using Jive for Outlook in Jive for Outlook Help.

Choosing between email and stream notifications
You can receive notifications in Inbox and on email. Here you can find details about
choosing when and how you want to be notified about new activity in your streams
and when you don't.

Stream and Inbox notifications

You can keep track of activity in your community without ever leaving the community
page through notifications in your Inbox and through streams.

When you collaborate on content in your community, you're
automatically notified in your Inbox when updates are made to
that content.

Inbox
notifications

If there is content that you want to watch but have not directly
collaborated on, you can follow it in a stream. When there is new

Stream
notifications

activity in your streams, such as likes, comments, edits or new
content, you can see an indicator dot next to the stream name on
your News or Home page. If you hover over the indicator, you can
see a count of new activity for that stream since you last viewed
it.
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Tip:  Relying on these notifications can save you time and cut down on your emails.

Email notifications

If you want to receive email notifications, do so prudently. You may find that you
rapidly accumulate hundreds of email messages in a busy community, since you
may get an email every time that stream is updated.

To receive emails in addition to Inbox and stream notifications,

1. Go to your avatar > Preferences .

2. Select Yes for Receive email or mobile notifications when there is activity in
the community?.

3. Select Email next to your Inbox or streams.

Note: The option to change your email notification preferences may be unavailable
in your community.

Examples of email notification strategies

Here are some email notification strategies:

Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.

• Not receive any email notifications: You won't receive notifications on email. All
update notifications you will receive in the community.

• On your Preferences page, select No in Receive email or mobile notifications
when there is activity in the community?.

• Receive emails for the News Digest only. You can change the frequency that you
receive this digest from the drop-down list. For more information, see News Digest
on page 244.

• On your Preferences page, select Yes in Receive notifications?, and select
Email for News Digest.

• Create an Email Watches stream and follow only critical items. This stream can
be helpful when you're away from the community for a few days or if you want to
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watch something that you haven't directly collaborated on. For more information,
see Creating custom streams on page 22.

• On your Preferences page, select Yes in Receive email or mobile
notifications when there is activity in the community? and select Email for
that stream.

• Change the frequency of your email notifications. Instead of receiving an email
for every update, you can receive a digest of updates.

• On your Preferences page, select Yes in Receive email or mobile
notifications when there is activity in the community? and select one of
the summary options from the list next to your Inbox and streams.

News Digest
The News Digest is a summary of community news that you can choose to receive
by email.

• To receive the News Digest, click Your avatar > Preferences  answer Yes to
Receive notifications?, and select Email next to News Digest.

Additionally, you can select a frequency with which the digest is sent to you.

The digest includes:

• Your status. If you've entered a status message, it is in the email.

• A list of activity around your content. If you've created or commented on content,
for example, it is listed here. This list also includes notes about content of yours
that was viewed or commented on by others.

• A list of activity by people connected to you.

• A list of popular content in the community.

The links in the digest open content right in the community.

Note:  If the community contains no activity, the digest is not sent.

• To cancel the News Digest, click your avatar > Preferences  and clear Email
next to News Digest.

Customizing notifications
You can set notifications for your Inbox and any of your streams so that you receive
an email or mobile app notification each time a person, place, or item posts an
update or you have Inbox activity.

There are a few ways to set your notifications.

Remember: You can choose the frequency of these notifications from the drop-down
list next to each Inbox or stream.

244AUREA CONFIDENTIAL

Chapter 3: Reference and advanced topics



When you're viewing or editing a stream

1. On the News (or Home) page, select the stream and click .

2. Select Mobile, or Email, or both from Updates at the top of the page.

3. Click Done.

Note:  Mobile notifications appear in the Jive Daily Hosted app if you have it installed
on your Android or iOS device. If you don't have one of these apps, mobile
notifications don't have any effect.

From the unsubscribe link in the email

You can click the unsubscribe link in an email so you will no longer receive notifi-
cations. It switches the Receive notifications? option to No on your Preferences
page.

From your Preferences page

1. Go to Your avatar > Preferences .

2. Select Yes in Receive email or mobile notifications when there is activity in
the community?.

3. Select Email or Mobile notifications for each stream and your Inbox, and select
the frequency of notifications for each from the list.

4. Click Save when you're done.

Caution: When you select All Activity, you get an email every time that stream or
Inbox is updated. We recommend leaving Email cleared or choosing one of the
summary options; otherwise, your email notifications could get overwhelming.

For more information about notification settings, see Notification Preferences refer-
ence on page 31.

Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.

Creating new content without logging in
If your community supports it, you can post new content by sending an email to the
community.

This feature can be especially useful for posting when you can't reach the commu-
nity using a browser. For example, you can email content from a cell phone that
sends email.

Each place in your community provides email addresses for the content you can
post via email. For example, you can send an email to the address corresponding
to documents in a place, and a new document will be created there. Use the email
addresses for the specific content you want to post.
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The subject line of your email becomes the document's title, while the email body
becomes its content body. For status updates, you can include a subject line or
content in the email body. If you include both, the subject line and the email body
content are separated by a line break in your posted status update; if you include
only a subject line or only email body content, then that is the only content you see
in your status update.

To create community content with email:

1. Go to a place if you want to create content in the place or your profile if you want
to create your private content.

2. Click Actions > Create via email .

You won't see this option if your administrator has not activated the ability to
create content by email.

3. Select the types of content you want to create.

4. Click Actions > Email vCards .

You should receive an email from your community that includes this vCard.

5. In your email or address book program, save the vCard as one of your Contacts.

For example, in Microsoft Outlook you can drag the vCard to your Contacts folder.
On a Macintosh, you can double-click the vCard to add it to your address book.

6. In your email application, create a new message and select the address you just
added from the vCard.

7. In the email subject, type the title you want your content to have in Jive.

8. In the body of the email, type the main part of the content. If you want to include
tags, in the last line of your email type Tags: tag1here tag2here tag3here.

This tags your content so that people can find it more easily later.

9. Send the email to create the content in the Jive place.

Posting replies without logging in
When you reply to a community email from your email program, your reply is posted
directly into your community.

If your community manager has turned on this feature, you can post a reply to
something by replying to a notification email. You first need to set your user Prefer-
ences to receive email notifications on a particular stream, so that when someone
updates something you follow in that stream, you get an email about it. For more
information on how email notifications work, see Customizing notifications on page
30.

• To reply by email, click Reply in your email program, then type your discussion
reply just as you'd type a reply to an email and send the email.

If the community is set up to receive replies via email, your reply is posted as if
you'd logged in to your community and posted it from there.
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Creating content by using email
There are several different kinds of supported email clients that your community
administrator can tie into Jive, such as Microsoft Windows Outlook, Mac Mail, and
Gmail. You may notice inconsistent results when creating Jive content

by email because every email client creates emails in its own unique
way. For this reason, do not use styles or images in email content that

you post to Jive.

In general, the incoming and outgoing email features of Jive were designed to
handle simple replies to content and creation of content in Jive.

Jive only creates content from the plain text version of an email, which may look
significantly different than the rich text version of the email you created or can view
in your email application.

In addition, Jive adds email attachments as content attachments if the created
content item supports attachments. For example, a new discussion supports attach-
ments, but a comment on a document does not.

Therefore, keep the text clean and do not use styles or embed images while using
emails to post content on Jive.

Accessibility
Turning on High Contrast Mode is required to enable several accessibility options.

To switch to the high-contrast theme:

• Go to Your avatar > Preferences  and select On under High-contrast color
scheme. Then click Save to save the settings.

For more information the changes on interface, see High-contrast theme on page
248.

If you are using a Mac OSX environment, you also should do the following:

• Turn on all All controls for full keyboard access by navigating to System Pref-
erences > Keyboard > Shortcuts  and selecting All options at the bottom of
the dialog.

• Enable voiceover capability by navigating to System Preferences > Shortcuts
> Accessibility  and select Turn VoiceOver on or off.
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High-contrast theme
Jive includes a high-contrast theme that users may choose to enable. This theme
uses contrasting colors that make the interface more comfortable to see.

To switch to the high-contrast theme:

• Go to Your avatar > Preferences  and select On under High-contrast color
scheme. Then click Save to save the settings.

The theme color palette has a high contrast ratio between colors to make elements
more visible and easier to read and identify.

This theme overrides the default and Theming tool colors. The UI elements that get
changed are:

• The main navigation menu bar, including the Inbox notifications

• Texts

• Hyperlinks

• Meta-texts

• Meta-links

• Buttons

Keyboard shortcuts for content editor
You can use your keyboard to navigate when you are using the content editor.

Note:  Formatting characteristics are not retained when you copy and paste content
from Microsoft Office applications into Jive.

Table 1: Content editing shortcuts

ActionKey Combo
Mac

Key Combo
Windows

Move focus to the toolbar in the content editorfn+option+f10Alt+F10

CopyCommand+CCtrl+C

CutCommand+XCtrl+X

PasteCommand+VCtrl+V

UndoCommand+ZCtrl+Z

RedoCommand+YCtrl+Y or

Ctrl+Shift+Z

BoldCommand+BCtrl+B

ItalicCommand+ICtrl+I
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ActionKey Combo
Mac

Key Combo
Windows

UnderlineCommand+UCtrl+U

Heading levels 1-6. For example, to format as
Heading 1, press Ctrl+1

Command+<1-6>Ctrl+<1-6>

Format as paragraphCommand+7Ctrl+7

Format as divCtrl+8

AddressCtrl+9

Indent 5 spaces or indent a list item 1 levelTabTab

Outdent 5 spaces or outdent a list item 1 levelShift+Tab

Move the focus to the first visible submit buttonEsc

Publishes your content.

Caution:  In previous versions, this key combina-
tion saved a draft, rather than publishing, for blog
posts only. This is no longer the case.

Ctrl+SCtrl+S

Passwords
Use a strong password containing mixed cases, numbers, and special characters
to protect your content and your community identity.

By making a password that is strong enough to stump the guessers, you're not only
protecting your own content (including any private content you have), but also the
content and activity of others in the community. Here are a few guidelines for making
a password that only you know.

• Make sure at least three characters are upper-case, lower-case, numerals, or
punctuation.

• Try using words instead of numbers — "six" instead of "6", for example.

• Use numerals instead of letters here and there — "0" instead of "o" would work.

• Mix uppercase and lowercase letters — as in "feLiX".

• Add punctuation or other special characters. For example, you could use a "!" or
"$" or "@".

• Use at least eight characters, although you're better off with twelve or more.

If you forget your password, you can ask your community administrator to reset it,
or if your community allows you to change your password, you can change it.
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Note:  Some communities provide a Forgot Password link at the login screen, which
enables you to reset your password right there.

To change the password:

1. Change your password by going to the top right and selecting Your Avatar >
Change Password .

If you don't see Change password, then your community has user password
changing disabled and you need to contact a community administrator to change
or reset your password.

2. Change your password using the strength meter to measure how strong you've
got it so far, and what you can do to improve it.

3. Click Save .

Unpairing a two-factor authentication device
If you need to change the device you use for two-factor authentication (2FA), you
need to unpair the device you use and then set up a new device.

Fastpath: Your avatar > Preferences , then the Two-factor Authentication tab

Note: This tab may not be available depending on the community configuration.

You will have to enter a verification code from your current device before paring a
new one. If you cannot unpair your device yourself, you can refer to your community
managers to unpair the device for you. This may be required, for example, if you
don't have access to the device.
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To change the device for two-factor authentication:

1. Go to Your avatar > Preferences , then click the Two-factor Authentication
tab.

Figure 3: The Two-factor Authentication tab on the Preferences page

2. Click Unpair Device.

This opens the Unpair Device dialog box.

Figure 4: The Unpair Device dialog box
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3. Enter your password and the verification code from the authenticator app.

4. Click Revoke token.

The device is disassociated from your account and you are signed out from your
account. When signing back in, you will be able to set up a new device. For more
information, see Signing in to community with two-factor authentication enabled.

Time zone and locale preferences
Your time zone and locale settings determine how time and locale are displayed on
your content.

This can be important if you use Jive from a web browser set to another locale, such
as when you're working in another country. Your preference takes precedence. If
you want to use the locale set by your administrator for the entire community, make
sure that your web browser is not set to a specific locale (or the browser locale
overrides the administrator's locale setting unless the browser locale is not supported
by Jive).

Decimal and thousand separators for files sizes are displayed according to the locale.
When you set the locale on the Preferences page, Jive uses this locale. If your locale
is set to default, Jive uses browser locale.

Your time zone setting is used in the timestamp when you publish a blog post,
document, or discussion. Your administrator sets the time zone that affects the star t
and end times for all announcements, polls, projects, tasks, and checkpoints.

To set your time zone and locale preferences:

1. Go to Your Avatar > Preferences  to open the Preferences page.

2. Select your Language and Locale.

3. Select your Time Zone.

4. Click Save.

Changing non-editable profile fields
Sometimes profile fields can't be edited because an administrator has locked them
down, or because they come from a directory server controlled by your organization.

If you can't edit a field such as your name or title in your profile, it's typically because
an administrator has set up your community this way. Often, fields like name, title,
email address, and department aren't entered by a Jive administrator but come from
a directory server such as Active Directory. In this case, the community administrator
can't directly edit them in the profile, either.
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Every organization is different, so who you should ask for help depends on who is
responsible for this par t of your site data. If you need to change a non-editable field
in your profile, you can try the following paths for getting it changed:

• If you know who your community manager is, ask them who controls these fields.
Often, they can make the change, request a change for you, or tell you who can
handle the change.

• If you don't know who your community manager is, try contacting your human
resources department or your IT support department. These departments often
administer your company directory server or know who does.
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